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1 Introduction

1.1 EASE 5 Third Edition

Welcome to “EASE 5 Third Edition” or short, “EASE 5-TE”. After the First and Second Edition of EASE 5,
this is the third landmark release of EASE that is based on the new platform employing 64-bit, DirectX,
and the .NET framework. EASE 5 has been developed from scratch over the course of several years
with the purpose of establishing a new platform that focuses on both usability and simulation accuracy.
By bringing EASE to this new platform, modeling sound reinforcement systems and room acoustics is
made much easier. With the new version it is faster to achieve precise, reliable results and to
understand the acoustic performance of a venue or space. At the same time, EASE will keep growing
continuously; new features will be added and new technologies incorporated.

EASE on the new platform is replacing the predecessor platform of EASE 4 step by step:

1. With respect to functionality: The Third Edition of EASE 5 offers all the functionality of the
predecessor EASE 4.4 except for a few features, and it goes beyond. It provides a
comprehensive, consistent set of functions and tools for designing sound systems in rooms in
a structured and intuitive way. It allows dealing with everyday projects as well as with large
and complex projects in a time-efficient way and with a modern user interface. Subsequent
releases will further expand on that in every relevant aspect.

2. With respect to program structure: EASE 5 consists of a main program that is implemented on
the new platform. It provides the functionality to manage and view the project, to enter and
modify the room geometry, and to configure and tune the loudspeaker system and the
acoustics of the venue. Based on the new Acousteer engine, various types of calculations can
be performed in the main program as well, in real time and very precisely. The separate Room
Mapping and Ray Tracing calculation modules have been upgraded, expanded, and integrated
in EASE 5 as well as the Probe and EARS post-processing modules. The functionality of these
modules will be incorporated in the main program as part of the work on the next editions.

Ultimately, our goal is not only to transfer existing functionality to a modern platform. Our primary
goal is to use this new platform to create innovations that combine acoustic questions with
technological solutions, such as new and creative ways of displaying and interacting with simulation
results in order to optimize the sound of a venue, to employ cloud-computing services in order to share
data and support calculations, or to provide high-end auralizations for use in AR/VR environments.

For more details about our approach, about the new platform, and about our vision for the new
software, please refer to the EASE Development website.
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Program Structure

Main Program
Room Entry & Import, Sound System Design, Room Acoustic Characteristics

Loudspeaker and Material Database, Rendering & Presentation

Acousteer Real-Time Simulations

L l L

Room Mapping Ray Tracing Material Editor
Mapping Calculation Reflection Analysis User-Defined Materials
Response Calculation Response Calculation

Probe EARS

Response Data Post-Processing > Auralisation

Figure 1.1 Overview over the primary modules of the software and their functionalities.

The structure of the program is depicted in Figure 1.1. The main program acts as the entry point and
core of the software. It provides access to the integrated Acousteer real-time simulation engine as well
as to the separate Room Mapping and Ray Tracing calculation modules. These modules can be used to
perform various investigations, generate mappings, and calculate response information. Analysis and
auralization of these response data is conducted in the Probe and EARS modules, respectively. The
Material Editor allows entering and modifying user-defined acoustic materials.

Feature Levels and Licenses

EASE 5 is available for three different types of licenses, or so-called feature access levels:

e EASE Junior provides extensive functionality for entry-level users as well as for advanced users
who are mainly concerned with direct field and coverage investigations as well as statistical
room acoustics in moderately complex venues.

e EASE Standard includes additional tools for investigating the sound field using ray tracing
methods, conducting reflection analysis, and calculating mappings in acoustically more
challenging rooms and environments, where, for example, strong early reflections play an
important role.

e EASE Pro offers the entire set of available features for modeling and investigating rooms. It
uses advanced ray-tracing methods including scattering calculations to generate mappings,
reflectograms, and impulse responses. On this basis it also provides the ability to create
binaural and B-format auralization results.

More details about the different feature levels of EASE 5 can be found on the EASE website.

1.2 About this Manual

This document aims to serve as an introduction and as a compact reference for all users. It provides a
systematic overview of all functions and features of EASE 5 as well as some of its background. However,
if you wish to learn more about practical workflows, usage details, and related references please visit
the AFMG website. Learning content, a knowledge base, training videos as well as other information
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are available online. In particular, we would like to point you at our video tutorials as well as the Learn
EASE website.

Structure of the User’s Guide

This user’s guide is structured as follows. The first chapters cover general aspects of the program, such
as installation, licensing, the software environment, and managing projects. The next chapters deal
with how projects and room models can be viewed and of which parts they consist. After that, the
room entry, import functions, as well as the definition of sound system and the room acoustic
characteristics are described. At the end of the manual, the calculation modules are introduced. The
appendices include a complete list of short cuts as well as references to important publications and
articles.

Notice that the calculation modules provide also a separate help function. It can be accessed by
pressing F1 or opening the HELP > TorPIcs menu. This will display help texts about individual windows
and functions in these modules.

Conventions and Terminology

The following conventions and terminology are used in this document:

o A left-click means pressing the left mouse button and releasing it. LMB is the acronym for left
mouse button. Similarly, a right-click means pressing the right mouse button (RMB). The
middle mouse button is abbreviated by MMB. Many mouse devices combine the MMB with a
mouse wheel that can be pressed.

e Many elements of the graphical user interface (GUI or Ul) show some reaction when the mouse
is moved over them. This activity is also called hovering. Most often, helpful information is
displayed such as tool tip texts. Often, the item under the mouse as well as related items in
the software are highlighted.

e In this document, the user interface will often be referenced. Labels displayed in the user
interface will be indicated in this document by a special font, such as in FILE menu.

e The menu of the main window of the software is implemented as a so-called ribbon menu
similar to many Microsoft applications.

o  Withrespect to the room model, elementary parts of the model will be referred to as elements,
items, or also objects. These parts can be surface elements, called faces, sound sources, called
loudspeakers, measurement locations or mapping planes called listener seats and audience
areas as well as section plans or bitmaps called drawings. For more details, please refer to
section 5 about project elements.

e A room element can be selected by left-clicking on it. When selected, the properties of the
element can be accessed as well as some other functions depending on the type of element.
It is also possible to select multiple items for further actions, such as for changing their
location. This is called multi-select. An item can be deselected, for example, by selecting
another item.

e Short cuts refer to key combinations of the keyboard that activate certain functions from the
menu or in the context of an activity.
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Further commonly used abbreviations are listed below.

ETC
IR
IND
MIV
RT
SPL
STI

Energy-time-curve
Impulse response

Just noticeable difference
Maximum input voltage
Reverberation time

Sound pressure level
Speech transmission index
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2 Installation and Activation of the Software

2.1 System Requirements

For EASE 5 to install and run properly, the hardware and software requirements must be fulfilled. These
are listed on AFMG's website.

2.2 Installing the Software

EASE 5 can be installed on a computer in just a few steps. See the Installation Instructions on AFMG’s
website for more details.

2.3 Activating the Software

When running EASE for the first time, you will be prompted to activate the software. To do that please
make sure that you have internet access and that you have your log-in credentials for the AFMG
Download Portal at hand.

Enter your e-mail address and password and click on Loc IN to proceed. The next window will show
you one or multiple licenses that are registered for your account. Select one of them in order to
activate the software.

There are several additional options on this page:

e Pressing the + button will show you more details about the particular license.

e Itis recommended to provide the computer name or some other identifier so that it is easier
at a later point of time to determine on which computer the license was activated.

e If you wish to disallow other users of the computer to deactivate the software select the
REQUIRE LoG-IN radio button.

Click ACTIVATE SOFTWARE to activate the selected license. Deactivating and switching licenses are
discussed in section 3.3.
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Software Activation

Select License

EASE 5 Second Edition : Pro (AURA 4, EARS)
Expiration Date : 04.10.2024 - 388 days left

Available User Keys : 1/ 1

Computer Name

A custom identifier for this computer can be stored on the AFMG license server so that
it is easy to locate the associated User Key later.

DESKTOP-6D4URVM

Permission for Software Deactivation

The installed User Key can be protected from users of this computer who are not
authorized to administrate licenses.

@ Allow Everybody (O Require Log-In

If you need assistance, please visit the AEMG Support website or use the
AFMG contact form.

| Activate Software | | Exit

Figure 2.1 Selecting a license to activate the software.

2.4 Allowing Data Collection for Software Improvements

After the first installation of EASE 5, you will also be asked to provide consent for data to be collected
during the run time of the software. If allowed, the software will send errors that occurred during the
use of the software to AFMG in a completely anonymous way. Also, the duration of the software
session can be provided to AFMG in an anonymous way.
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Data Collection for Software Improvements

€ We would like to ask for your help!

We want to improve EASE continucusly and make it better for
everyone. Please support our effort by providing some bits of data in a
completely anonymous way:

Anonymized error information

Anonymized usage data, e.g. session duration

The infarmation will be sent to our server when an error accurs or
when the application is closed. The data will be collected, used and
stored as detailed in section 2.2, of our data protection policy.

You can change your preferences and reveke consent at any time via

the application settings.
Confirm Selected -

Figure 2.2 AFMG requesting consent for collecting error information.

These data will be used solely to improve the software for all users. The collection is optional. It is
detailed in the Data Protection Policy (DPP) of EASE 5. Select ALLow BOTH to support AFMG’s efforts of
improving the software.

2.5 Software Updates

New features as well as bug fixes are provided for EASE on a regular basis. When a new software
version is available, a notification is shown in the title bar of the main program window.

Update available — >

W

4|

Figure 2.3 Update notification in the title bar of the main window.

Click on the UPDATE AVAILABLE button to open the EASE Upgrade History website. It provides more
information about the available upgrades as well as a link to the AFMG Download Portal where the
latest software versions can be downloaded. See the Installation Instructions on AFMG’s website for
more details.

It is highly recommended to always keep the software up to date.

15


https://www.afmg.eu/node/758
https://www.afmg.eu/en/ease-5-fe-upgrade-history
https://downloads.afmg.eu/
https://www.afmg.eu/en/installation-and-licensing-ease-5-fe

EASE 5 Third Edition — User’s Guide Installation and Activation of the Software

2.6 Technical Support

If you need assistance with the software, we provide numerous options on the AFMG Support website.
You may also send your request directly to the AFMG support team via our contact form.

2.7 Error Messages

Although EASE is being developed according to very high quality standards, sometimes, under specific
circumstances, the software may fail. If this happens, a dialog window is shown that allows you to send
the error details as well as the currently loaded project directly to the technical support team at AFMG.

Sending the error information to AFMG will not only allow us to assist you in a timely fashion but it will
also allow us to fix the problem in future program versions. To take advantage of bug fixes and new
features always make sure that you are using the latest version of the software (see section 2.5).

2.8 First Use

When you use EASE for the first time it can be helpful to adjust the most important program settings.
General application settings can be found in the OPTIONS area of EASE. To go there, click on the [ ¥ |
menu button and then on OPTIONS.

At this point, there is only one setting to be verified. By default, EASE will be using metric units for the
unit system. If you wish to work in US units select US CUSTOMARY instead of METRIC on the page. This
will switch, e.g., the length unit from meters to feet and inches. Other units will be switched as well.

Unit System

® Metric () US Customary

Figure 2.4 Selection of unit system in Options area.

Additionally on this page, you may view and change the choices you made about allowing AFMG to
collect usage data for software improvements.
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3 Program Overview

3.1 Main Window

When EASE is started for the first time its main window will look similar to the picture shown in Figure
3.1. There are five distinct areas:

1. The title bar of the window displays the name of the current project. It also provides quick
access buttons for several functions.

2. Directly below, the ribbon menu gives access to most of the program’s functions.
3. The area on the left is where the properties window is shown.
4. The area on the right side usually holds various view windows.
5. The status bar is located at the very bottom.
]| New Project - EASE5 Third | 1. 3D View - O X
File Surfaces Loudspeakers Receivers Toee— Calculations Windows Presentation v
h
e E
New  Open Add Save Save Load 2
As
Properties - Project T B X |[3D View X |Acoust|'c Parameters v

Name: |New Project
Author:

Notes:

Figure 3.1 Main program window and important parts of it.

3.1.1 Short Cuts

Many functions can be accessed not just using the buttons of the graphical user interface but also using
shortcuts. There are two types of shortcuts:

o Ribbon-based shortcuts are linked directly to menu buttons in the ribbon. Press Alt to view
and to use them. For example, pressing Alt, then F, then N, in a sequence will start a new
project just like clicking on FILE > NEW does.
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e Many functions also have dedicated shortcuts. For example, a new project can be started also
by pressing Ctrl and N simultaneously. These specific shortcuts are typically displayed in the
corresponding tool tip of the button or control (see Figure 3.2).

=~ ¥

w Open Add Save

Mew (Ctrl + M)
Creates a new project.

| Properties - Project

Figure 3.2 Tool tip for New Project menu command showing the shortcut Ctrl+N.

3.1.2 Window Layout

All major windows can be accessed through the Windows ribbon menu (see Figure 3.3). Click on WINDOW

LAavouT > DEfrAULT if you would like to reset the window layout to its original state after the first
installation.

= E?EI E& = 1A % JQ b= .lIII =,

Properties ~ Acoustic  Drawings Faces Materials Loudspeakers Processing Configurator Filter  Areas on New 3D Distribution Frequency  Default Sound
Parameters Table Table in Use Table Blocks Stage Table Table Sets View Graph Response System

Window avout

Figure 3.3 The Windows ribbon menu of EASE 5.

Windows can be resized and moved independently from the main window if desired. To move a
window, left-click on its title bar and drag it to the new position.
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=
=

Mew Project - EASE 5 Third Edition

File Surfaces Loudspeakers Receivers Tools Calculations Windows hd

= _ = ceme] = ; = A = = ;
E =5 5§ = B A& E & L
Properties  Acoustic Faces Materials Loudspeakers Processing Configurator Filter  Areas  Seats Selection MNew3D  Default Sound
Parameters  Table in Use Table Blocks Stage  Table Table Sets View System
3D View X | Acoustic Parameters v
operties - Project b=

Name: |New Project
Author:

Notes:

sed |

]

Figure 3.4 Floating properties window. Possible docking locations are indicated in gray.

A window can be docked back into the main window by dragging and dropping it onto one of the
docking icons.

For docked windows the * pin button can be used to unpin the window and temporarily hide it. Click
again on the & pin button to permanently show the window.

3.2 Application Settings

The settings area of EASE 5 can be accessed by clicking on the B e button.

3.2.1 Options Page
On the OPTIONS page, adjustments can be made concerning the general usage of the software.

e In the UNIT SYSTEM section, the unit setting can be switched between SI metric units, e.g.,
meters, and US customary/architectural units, e.g., feet and inches.

e In the CusToM MATERIALS section, a user-defined folder can be selected from which material
files are loaded and shown as part of the custom materials database (see section 8.1). This
folder can be on the local hard disk or on a network drive in order to make it easier to share
acoustic materials across a company or project team. All MAT files in any subfolder are
automatically loaded and search tags are assigned to each material corresponding to its folder
location.
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o Usethel= open button to select the additional database folder.
o Usethe X clear button to not use the additional folder for loading materials anymore.
o Use the & refresh button to let EASE reread the folder, e.g. after a temporary
disconnect.
e The settings regarding data collection for software improvements can be modified.

3.2.2 Other Settings

On the ACCOUNT page, the currently active license can be viewed (more details are given in section 3.3).
Also, details about the installed program version are made available on this page.

On the THIRD-PARTY SOFTWARE page, license information is listed for the various components that are
used by EASE.

3.3 Managing Licenses

To view and manage your software license, click on the B e button and open the ACCOUNT
page.

New Project - EASE 5 Third Edition

@ License Information Product Information
. E-Mail Address
Oritane Jjohn.doe.afmg@gmx.de
P License ID

EASFRE-FAEQ00-001-000-5DA-077707-3300XK

Feature Level
Third-Party Software Pro (AURA 4, EARS)

=
=]
B
=
w
=
=
FS
-
5

Expiration Date

01.10.2025 - 657 days left Version: 5.68.0.1933 - InternalTest
Copyright AFMG 2015-2024
All Worldwide Rights Reserved

www.afmg.eu

Licensed Company
AFMG Technologies GmbH

Computer Name
DESKTOP-6D4URVM

Permission for Software Deactivation
Allowed

Deactivate Software || Switch License |

Figure 3.5 Viewing account data and managing licenses.

The page shows a number of details related to the currently active license:

e The E-MAIL ADDRESS corresponds to the log-in credentials that you have used for activating
the software (see section 2.3).

e The LIcense ID identifies the license that you are currently using. When you contact AFMG
about technical support questions, you will be most likely asked for the License ID.

e The FEATURE LEVEL provides information about which modules are available as part of this
license. It will also indicate whether the current license is a trial license and it will show the
expiration date for time-limited licenses.
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e During the purchase the license was registered under a specific company name. This name is
shown under LICENSED COMPANY. This name will also be included when saving result pictures
from the calculation modules of EASE.

e The CoMPUTER NAME shows the identifier that you used to activate the license initially (see
section 2.3).

o The PERMISSION FOR SOFTWARE DEACTIVATION setting determines whether only the same user
who activated the software can deactivate it or anybody using the computer.

These pieces of information have been either acquired when the software was activated or are part of
the license purchased. They will be updated when switching to another license or account.

3.3.1 Deactivating the Software

In EASE, after the software was activated (see section 2.3) it can be deactivated again in order to free
up the license for use on another computer. To do so, click on the DEACTIVATE SOFTWARE button. Note
that after successfully completing this step, EASE will close and cannot be used unless becoming
activated again.

If you are going to ultimately uninstall the software it is strongly advised to deactivate the license
before uninstalling.

3.3.2 Switching to Another License

If several licenses are registered under the same account, you can switch between them. After clicking
on SWITCH LICENSE, you will first be asked if you want to actually return the currently installed license.
This is required before activating a different license. After the current license was released successfully
you will be guided through the same activation process as described in section 2.3. Following these
steps, you can select a different license from the same user account or you can change the user
account, as well.

After completing all steps, the ACCOUNT page will be updated and show the current licensing status.

3.4 Managing Projects

In EASE 5, projects are managed using the FILE ribbon menu (Figure 3.6).

I I} Ne
“ File Surfaces Loudspeakers
T Iy

New Open Add Save Save Load
As

Project Drawing

Figure 3.6 The File ribbon menu is used to manage projects.

Clicking on the NEw button will discard the current project and create an empty, new project.

21



EASE 5 Third Edition — User’s Guide Program Overview

All Formats (*.eprj™frd:~* xld:*.c Using the OPEN button, you can load project files from the local
N e T e e g computer or from the network. Projects saved with EASE 5 will have
EASE 5 Project (".eprj) the file extension “.eprj”. You may also open projects saved by EASE
EASE 4 Project (*.frd) : . .

: _ 4, please see section 11.10 about importing from EASE 4 for more
Sound Systern Configuration (*.x1d) . . .
CAD Models (*.dwg) details. CAD model files in DWG format can be loaded as well.

Certain rules apply as to which data in a DWG file can be imported
(see section 7.1). In addition to complete projects or CAD geometry data, sound system configuration
files in the XLD text format can opened, too (see section 9.7.5).

Note that you can select recently used files by opening the FILE NAME dropdown menu.

The current project can be saved to its current file location using the SAVE button or saved in a new
location by clicking on SAVE As.

Further functions in the FILE ribbon menu are concerned with importing from and exporting to other
formats:

e Using the PROJECT > ADD command, existing EASE 5 projects as well as projects in EASE 4 or

DWG file format and sound system configurations in the XLD text format can be loaded and
inserted into the current project. The project to be added will be placed at the origin. A
selection set will be created automatically so that the inserted project can be moved and
manipulated easily.
This function is particularly useful when working with a library of frequently used objects, such
as columns or pews. It is also useful for updating an existing project based on a revised DWG
model file. The feature can be used for replacing parts of the model, such as the sound system,
as well.

e Projects can also be saved in DWG format as well as EASE 4 format using the PROJECT > SAVE
As button (see sections 11.9 and 11.10). Notice that the DWG and EASE 4 formats are not
completely compatible with EASE 5 and that data will be converted and reduced accordingly.
Additionally, the sound system part of the project can be exported in the text-based XLD
format for import and use on other platforms (see also section 9.7.5). The sound system can
also be exported as an APS model for noise immission forecasts (see section 11.11) In addition,
the XED text format can be selected. For this output format, the outlines of the faces of the
room are converted to consecutive line elements and saved as a wireframe drawing. This file
type can be used to create loudspeaker case drawings in EASE SpeakerLab.

e To support model entry and easier orientation, drawing images can be loaded, as well. Click
on DRAWING > LOAD to load a bitmap for the floor plan, front view, or section view (see section
7.1).

Note for EASE 4 users: Projects in EASE 5 do not need to be packed and unpacked. A project file always carries all
of the relevant information with it, including speaker model files (GLL, DLL) and material files (MAT). When the
project file is opened, these files will be automatically added to the local database if they are not already available
on the computer.

3.4.1 Limitations for Projects

It is important to note that EASE 5 has limitations regarding the size of the model as well as regarding
the number of items that the model consists of.

The software has been optimized for room models of up to approximately 10 000 faces and about
1 000 loudspeakers. Beyond these numbers, viewing or editing parts of the model may show notable

lag.
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Also, the software has been optimized for project dimensions of up to 2-3 km (up to 6 000 to 10 000
ft), in the vicinity of the origin. Working with significantly greater distances may lead to geometrical
inaccuracies, visual artifacts and possibly errors.

These recommended quantities also apply to the calculation functions in the main program as well as
in the calculation modules.

4 Viewing a Project

In the following chapter, example projects will be used to introduce and demonstrate the most
important functions for navigating and viewing a room in EASE. Example project files are installed along
with the software and can be found in the location c:\Users\Public\Documents\AFMG\EASE\Example

Projects\.

After zooming in, zooming out, or panning, you may want to return to the default view and default
zoom of the 3D VIEW window. Press the shortcut Ctrl+0 or use the PRESENTATION > SCALE TO FIT
menu command to reset the zoom factor so that the room model fits the current view section.

4.1 Navigating in 3D

The 3D VIEW window is the center piece for many functions of EASE. In particular, it is used to view
and modify the room model.

4.1.1 Coordinate System

When no room is loaded, the view window will show only the three axes establishing the coordinate
system: the x-axis (red), the y-axis (green) and the z-axis (blue). The meeting point of the three axes
represents the origin of the coordinate system, namely the location (0, 0, 0).

For better orientation, also a small version of the three coordinate axes is displayed in the bottom right
area of the view. This axis cross is located always at the same position in the window and indicates the
orientation of the main coordinate system.

For building room:s, it is recommended to put the origin at the front center of the stage or at another,
similarly important point that the audience will typically look at. It is also recommended to build the
room along the y-axis so that the stage has positive y-coordinates and the parts of the room where the
audience is located has negative y-coordinates. For venues that are left-right symmetric to some
degree, the yz-plane will then form the symmetry plane.

Note that it is possible to change the origin at a later point of time using the MOVE command (see section
11.2).

With respect to angles, the horizontal angle is defined in the xy-plane where the -y direction is 0° and
the +x direction corresponds to 90°. The vertical angle is defined relative to the z-axis, where positive
angles point upward (+z) and negative angles point downward (-z). The rotational angle is defined
relative to the axis of the object.
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3DView X | Acoustic Parameters ¥ 3D View X | Acoustic Parameters

' / Pl
P
Lk, |
Figure 4.1 Empty 3D View window Figure 4.2 View of loaded room model

4.1.2 Navigating by Mouse
Use the mouse to look at the room from different angles and at different zoom scales:

e Press Shift and drag the RMB in order to pan, i.e., to move the model inside the view section.
You can also press and move the MMB.

e Dragthe RMB to rotate the model. You can also press Shift and the MMB simultaneously for
the same effect. While rotating, the status text in the lower left shows the horizontal and the
vertical view angle.

e Use the mouse wheel to zoom in and out at the location of the mouse.

These mouse conventions correspond to the default conventions established by AutoDesk AutoCAD
and Rhinoceros 3D by Robert McNeel & Associates.

To return to the default view, press the Ctrl+0 shortcut or use the PRESENTATION > SCALE TO FIT menu
command.

4.1.3 Hovering and Selecting Room Elements

In the 3D View window of EASE, the left mouse button is primarily used to interact with elements of
the room. When moving the mouse over a surface or another object, the item under the mouse cursor
will be automatically highlighted and additional information will be shown in the status text (section
4.1.4). This is also called hovering an element. In the default view mode, the color of a surface element,
such as a face or an audience area, will change from light transparent blue to a darker blue, when
hovered. For elements that refer to an insert point, such as loudspeakers or listener seats, the outline
or symbol will be changed to blue and a filled triangle is shown directly above the insert point.

When an object is hovered, a left click will select it for further actions. The selected element is shown
in green if it is a surface element. If a point-like element, such as a loudspeaker or listener seat, is
selected, its color and its triangle are changed from blue to green.
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3DView X | Acoustic Parameters ¥ 3DView X | Acoustic Parameters ¥

428 | -1.56 | 18.57 [m] 529 | -4.34 | 18.23 [m]
ace  368.52 m?  Light construction Face 368.32 m*  Light construction

Figure 4.3 Hovered face in darker blue. Figure 4.4 Selected face in green.

It is also possible to select multiple elements for further processing. To do so, select the first element
by left click. Select additional elements by keeping Ctrl pressed while left-clicking on the elements of
interest. A selected element can be deselected by left-clicking on it while Ctrl is pressed. In the 3D view
all elements can be deselected either by left-clicking into the empty space around the room model or
by pressing Esc. Note that selections can be stored and later recalled using selection sets (section 11.6).

36w X | Ao paameters v

Figure 4.5 Several selected faces, in green.

One can also select many items at once. For this purpose, keep the left mouse button pressed and drag
the mouse over the screen area that contains the relevant elements of the room. While dragging, a
selection frame will be shown and the included items will be highlighted. After releasing the left mouse
button, the highlighted items will be selected. Keep Ctrl pressed while dragging to add items to the
current selection. Keep Alt pressed while dragging to remove items from the current selection.
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3D View X | Acou

D

Figure 4.6 Dragging with the left mouse button highlights  Figure 4.7 Selected items after using the selection frame.
the room elements inside the selection frame.

Elements can be located fully or partially behind other elements. To hover and possibly select an item
that is covered by another element, press Shift and scroll forward with the mouse wheel. If there are
multiple elements below the mouse pointer, the program will cycle through them while scrolling the
mouse wheel and stop at the one that is most far away from the view. In order to get back to the front,
either scroll back or move the mouse to an area of the view window that shows empty space. Instead
of the mouse wheel, also the Page Up and Page Down keys can be used to step through the items
under the mouse pointer.

Notice that there is a priority for how room elements are provided for hovering. So-called point
objects, i.e., loudspeakers and listener seats, are always hovered first. It does not matter whether they
are behind other objects. Then, surface objects, i.e., faces and audience areas, are hovered. These in
turn are preferred over drawings if both are located in the same plane, such as the ground plane (z =
0).

Note for EASE 4 users: It is not possible in EASE 5 to select elements that are located behind other elements by
subsequent left clicks at the same mouse location.

When hovering or selecting items other parts of the program may react to this event. For example, the
status text in the lower left of the 3D view window will provide context information about the hovered
element (see section 4.1.4). Also, when an item is selected, the properties window on the left will be
updated to show the primary data for the object of interest (see for example section 5).

Vice versa, if room elements are hovered in other parts of the software, they will usually also be
highlighted in the 3D view. If an item of the room is selected it will also appear as selected in the 3D
view.

Use the SCALE TO SELECTION command from the PRESENTATION ribbon or the Space key to center the
selected elements in the active 3D view and zoom in on them.
4.1.4 Context Menu

When using a 3D View window, functions can be accessed through a context menu, as well. It can be
opened by clicking the right-mouse button anywhere in the view area.
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The menu commands shown depend on the types of items selected. The context menu looks different
for a loudspeaker than for a face or for a mix of different items.

52 Toggle Visibility Ctrl + H | @ Toggle Visibility ~ Ctrl + H :
E} Duplicate Ctrl + Alt + D [+] Duplicate Crl+ Alt + D
“#  Move Ctrl + Alt + M % Move Crl+Alt+M |
0 Rotate Ctrl + Alt + R 5 Rotate Ctrl + Alt + R ’
- Mirror X | == Mirror X E

= Mirror Y = Mirmor Y

+  Store Selection Ctrl + Alt + S e Store Selection Ctrl + Alt + S c
' Copy Configuration I~ Invert Face Cirl + Alt + |
r‘g Paste Configuration “4  Area Above Face Ctrl + Shift + U t
‘= Hide Properties Cirl + Shift + P = Hide Properties Ctrl + Shift + P

Figure 4.8 Context menu for a selected loudspeaker. Figure 4.9 Context menu for a selected face.

If items of different types are selected simultaneously, all commands applicable to each of the included
types are available.

4.1.5 Status Text

The so-called status text is shown in the lower left corner of the 3D View window. It displays useful
information when objects are hovered or selected. It may also show options or suggestions when you
interact with the 3D model, e.g., when editing it. If color mappings are enabled (section 13), the value
corresponding to the mouse position is displayed when hovering over an audience area.

When no object is hovered, a E mouse symbol is displayed instead of the status text. Clicking on the
mouse symbol will remove the status text area from the lower left corner and attach it to the mouse

cursor. Click on the IEI symbol, to dock the status text again.
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Figure 4.10 Status text for hovered face, docked in lower
left corner.

4.2 Viewing Options

Bl
Figure 4.11 Status text for hovered face, attached to mouse
cursor.

The PRESENTATION ribbon gives access to most of the viewing parameters for the 3D view. It is available

only if the 3D view window is active.

The SCALE TO FIT button is used to adjust the zoom level and the location of the model on the screen
so that it fits the size of the window area. The SCALE TO SELECTION command adjusts the center of the
view as well as the zoom level so that they fit the currently selected room elements.

The various other controls of the PRESENTATION

ribbon will be discussed in the following sections.

New Project - EASE 5 Third Edition
Loudspeakers Recefvers Toals
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Figure 4.12 Presentation ribbon providing access to the various display options for the currently active 3D view window.

4.2.1 Perspective View

The first part of the PRESENTATION ribbon is concerned with how the 3D geometry data of the model is
displayed (projected) on the two-dimensional screen.

‘--'-— ~— B~ 0 0 L *
BN | NGRS S 4
Central Central Parallel Side (X} End (Y] Plan (Z) £ Fram
Wide  Narrow Perspective  Selection
Perspective View Direction

Figure 4.13 Perspective views and standard view directions.

The view can be switched between different PE

RSPECTIVE settings:
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In CENTRAL WIDE mode, the central perspective and a wide viewing angle will be used. This
typically corresponds to situations where the viewer is close to the building or inside the room
(Figure 4.14).

In CENTRAL NARROW mode, the central perspective is used as well but with a narrower view
angle. This is the default view mode. It corresponds to a viewing location outside of the model
that is not too far away.

In PARALLEL mode, an orthographic projection is used instead of a central projection. In this
mode, objects that are farther away will not appear smaller than objects closer to the viewer
(Figure 4.15). This option corresponds to a viewing location at a large distance. It is often
useful, especially for drawing or verifying models without perspective distortion.

oustic Parameters ¥ 3D View X | Acoustic Parameters -

' /;-/ [}
/—l : 4 L | - o
Figure 4.14 Central Wide Perspective. Figure 4.15 Parallel Perspective.

The VIEW DIRECTIONS can be applied to all PERSPECTIVE modes even though they are most useful for
the PARALLEL perspective:

The SIDE (X) button switches the view angles to show the model from the left or from the
right side, i.e., from the positive or negative x-direction.

The END (Y) button shows the model from the front or from the end, i.e., from the positive
or negative y-direction.

The PLAN (Z) button shows the model from the top using one of four different horizontal
angles.

The 3D PERSPECTIVE button changes the view direction to a diagonal direction (-120°, -30°,
60°, 150°) depending on the current orientation of the model. The vertical angle is fixed at
30°.

When a loudspeaker or listener seat is selected, the FROM SELECTION button switches the view
to the location and direction of the selected element. The perspective is automatically
switched to CENTRAL WIDE, as well.

Note that subsequent clicks on the buttons will cycle through all possible views.
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3D View X | Acoustic Parameters i |30 View x | Acoustic

x r

Figure 4.16 Parallel view in x-direction. Figure 4.17 Parallel view in z-direction.

4.2.2 Model Slices

To view or manipulate parts of the room more easily, slices or cutting planes can be configured. In
these slice views, parts of the room are hidden without actually changing the geometry.

e [ﬁ] Him): [ ¢ 20139 [

Show  Cutting  YImk[]| -1150/% g4
Everything Planes =
e Zm: ]| -325|% 1059+

Figure 4.18 Controls for model slices.

Use the CUTTING PLANES dropdown button to select which part of the model should be hidden and
which part should remain visible. In the dropdown window, sliders can be set for each axis. Each slider
represents the location of a cutting plane. The left slider determines the lower limit and the right slider
determines the upper limit for the parts of the model that should be visible. They are relative to the
bounds of the model. The cutting planes are applied only if the corresponding check mark is activated.

X-Ray X-Rayand X-Raj
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R 9RO @®
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Figure 4.19 Model slice in the center along the y-axis. Figure 4.20 Model slice at the bottom along the z-axis.

Press SHow EVERYTHING to disable the model slices and return to the full view.
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4.2.3 Display Styles

In the 3D view, the room can be displayed in various ways. These can be selected using the SURFACE
STYLE and the GEOMETRY ANALYSIS display modes.

Wireframe X-Ray  Solid Wireframe

%.’ Su

<

—  Default Default | I
Colors
]
Without Default Colors
Wireframe without Culling
With Material
Orientation Colors

“
Nyt
Material Colors

without Culling

Figure 4.21 Various ways to render the surfaces of the 3D model.

The differences with respect to the SURFACE STYLE are primarily related to how faces and their borders
are shown:

e Inthe WIREFRAME style, faces are indicated only by their border lines.
e Inthe X-RAY style, faces are drawn in semitransparent blue.

o Inthe DEFAULT mode, faces are drawn in a transparent style and they are outlined.

o Inthe WITHoUT WIREFRAME mode, the outline of faces is omitted.

o Inthe X-RAY WITH ORIENTATION mode, faces are drawn also in transparent blue but
their outline is thicker than normal. When looking at the acoustically active side of the
face, the color of the outline is light gray whereas when looking at the acoustically
inactive side of the face, its outline is dark gray. This mode is primarily useful to verify
the orientation of faces in the room (see sections 5.3 about faces and 7.4 about
geometrical consistency of the model).

e Inthe SoLID style, faces are drawn in a non-transparent, opaque style.

o Inthe DEFAULT COLORS mode, faces are filled using the program’s standard colors. Only
faces that are oriented towards the viewer are rendered, i.e., face culling is applied. In
this so-called dollhouse view, the model inside can be inspected easily.

o In the DEFAULT COLORS WITHOUT CULLING mode, faces are filled using the program’s
standard colors. All faces are rendered, independently from the location of the viewer.
For an inside view, one can move into the model using the central perspective views
or apply a cutting plane.

o Inthe MATERIAL CoOLORS mode, faces are filled using the color of the material assigned
to the respective face. Only faces that are oriented towards the viewer are rendered,
i.e., face culling is applied. In this so-called dollhouse view, the model inside can be
inspected easily.
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o Inthe MATERIAL COLORS WITHOUT CULLING mode, faces are filled using the color of the
material assigned to the respective face. All faces are rendered, independently from
the location of the viewer. For an inside view, one can move into the model using the
central perspective views or apply a cutting plane.

oy 4 -y “
@ A

X X

Figure 4.22 X-Ray view without outlines. Figure 4.23 Wireframe view.

L3 L3

Figure 4.24 Solid rendering with culled surfaces. Figure 4.25 Solid rendering using material colors.

The main purpose of the X-RAY surface style is to support building and modifying the venue. While it
is also useful for viewing and understanding the room geometry, the SoLID surface style is better suited
for visualizing the room due its ability to provide realistic renderings and to use surface colors.
However, the SoLID surface style is not designed for modifying the room model. The WIREFRAME surface
style is available for reference and easier comparison with other tools.

Please note that the SoLID surface styles using MATERIAL COLORS will show a completely black model
as long as no colors for the surface materials have been defined in the MATERIALS IN USE window
(sections 5.4 and 8.1). When using the SoLID styles the selection functions of EASE are adapted
accordingly, for example, only visible faces, loudspeakers, or listener seats can be selected. Also, if
several faces are located in the same plane and erroneously overlap each other, the rendering may
show a flickering.

In addition to the surface styles, geometrical problems that were detected for the model can be
highlighted using the GEOMETRY ANALYSIS functions (also see section 7.4).

When enabling HOLE OUTLINES the program will check all surfaces of the room and if there are any
gaps between them. When there are large gaps the edges of surrounding faces will be highlighted in
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red. Smaller gaps will be indicated in yellow. Notice that the calculation for this function is conducted
in the background but it may require a few seconds to complete. If so, a small progress indicator is
shown in the status bar.

The STACKED FACES mode is enabled by default. It highlights duplicate faces in orange (Figure 4.27) if
they have the same shape and if they are located at the same position. This is normally an error that
should be resolved by deleting one of the duplicates. The only allowed exception is when two faces
have the same shape and are located within 1 mm, facing away from each other. In this case, the
program will assume that the two faces represent a surface element with two acoustically active sides,
such as a ceiling cloud, a parapet or something similar. These are indicated in light green (Figure 5.5,
see also section 7.3.4). When hovering over stacked faces, the status text will display a warning or
information. The STACKED FACES mode is not available for the WIREFRAME surface style nor for the SoLID
surface styles that use MATERIAL COLORS.

Figure 4.26 The Hole Outlines mode indicates a missing side  Figure 4.27 The Stacked Faces mode indicates a duplicate
wall by showing a red outline. roof face by showing an orange filling.

Note that the GEOMETRY ANALYSIS settings apply to all 3D views windows simultaneously. Unlike the
other presentation settings, they cannot be toggled on and off for each window individually.
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4.2.4 Hiding Parts of the Room Model

The remaining buttons in the PRESENTATION ribbon are used to control which types of room items are
displayed.

= 0 B i

Drawings  Faces Loudspeakers Audience Listener Coordinate Calculation
Areas Seats System Parameters

Visibility
B

Case

(<

Symbol

9,

None

Figure 4.28 Enabling and disabling display of room items.

LOUDSPEAKERS can be displayed using a SyMBoL, using their CASE drawing or not at all. As a default, the
case drawing is shown. If the definition of the speaker model does not contain information about the
case, a symbol is shown instead.

Other room items, such as DRAWINGS, FACES, AUDIENCE AREAS, and LISTENER SEATS can either be shown
or not. The display of the axes of the global coordinate system and the summary of the current
calculation settings can be toggled on and off as well.

Room items can be individually hidden, also. See section 11.1 for a general overview.

5 Project Elements

An EASE project consists of various elements. First of all, the project carries meta data related to the
design project itself such as the name of the venue. It also contains 3D model information about
surfaces, receivers and sound sources. In EASE 5 also drawings such as a floor plan can be included
with the project. Last but not least, there are acoustic properties and settings related to the room or
the environment that are also part of the project. All of these elements are stored in the project file
when it is saved and recalled from it when it is opened.

In the following each type of room element will be introduced as a reference and the basic concepts
related to it will be explained. For this purpose, one of the example projects provided along with the
program installation will be used. These are typically located at
c:\Users\Public\Documents\AFMG\EASE\Example Projects\.
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5.1 Project Properties

The general properties associated with a project are shown in the PROPERTIES window when no other
object is currently selected.

The NAME field can be used to store the title of the project. It will be shown in various places including
in the graphics output.

The AUTHOR field can be used to store the name of the person, the team, or the company that is working
on the project. It will be noted in the result graphics as well.

The NOTES section is optional and can be used to store any additional information about the projects,
its specifics and perhaps any noteworthy settings.

Properties - Project v ax
Name: | Catholic Church
Author: |EASE User

Notes:

Figure 5.1 General properties of an EASE project.

5.2 Drawings

In EASE 5, section drawings can be loaded into the project and used as a reference while building the
3D room model. As such they are auxiliary elements because they do not have any effect on the
acoustic calculation results or on the modelling process itself. They are merely supplementary images
displayed in 3D, spatially associated with the venue.

A drawing is loaded as a bitmap file, e.g., as JPG, using the FILE > DRAWING > L0AD button in the main
ribbon. The basic properties of a drawing object in EASE 5 consist of its label, its location in 3D
coordinates (POSITION X, Y, Z) and its scaling. The SCALE LENGTH setting determines the size that the
dimensionless bitmap assumes relative to the coordinate system of the project. The image's aspect
ratio remains unchanged.
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Figure 5.2 Properties of a section drawing.

Further functionality related to the use of drawing bitmaps, such as placing the anchor point, hiding a
drawing, or choosing the orientation of the drawing is discussed in section 7.1. The section also
discusses the drawings table.

The display of section drawings as a whole can be toggled on and off in the PRESENTATION ribbon of the
3D view.

5.3 Faces

The surfaces that form the boundary of the acoustic volume, i.e., the room, are called faces in EASE.

A face has a number of vertices that define its shape in 3D. Faces must be planar, that means, all of its
vertices must be located in the same plane. This is automatically enforced by all drawing tools in EASE.
However, when importing DWG files or projects from EASE 4 small deviations are allowed.

The sequence of vertices defines the orientation of a face. Its acoustically active side is looking into the
room or volume whereas its acoustically inactive side is facing outward. By convention, when looking
at the acoustic side of the face, the vertices are in counter-clockwise order (right hand grip rule). They
are in clockwise order when looking at the outside of the face. A hovered or selected face is drawn
with a thick border when looking at the inward side of the face.
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Figure 5.3 Hovering outward-looking side of face — thin  Figure 5.4 Hovering acoustically active side of face — thick
border line. border line.

In EASE 5, faces cannot be two-fold, i.e., have both sides acoustically active. When importing from
EASE 4, each two-fold face is converted into two single faces that point away from each other and are
spaced apart very slightly (about 1 mm). Such two-fold configurations can be constructed in EASE 5 as
well: The AbDD BAck SIDE command creates the counter face for an existing face in order to model
ceiling clouds, parapets, or dividing walls (see section 7.3.4).

/PO

1.39 | 7.87 | 11.01 [m]
Face 2.51 m? Light construction
Two-Fold Configuration

Figure 5.5 A number of ceiling reflectors are modeled as faces in two-fold configuration, shown in sand color.

By assigning a wall material to a face, it is defined how the face absorbs and reflects sound energy. See
sections 5.4 about materials used in the project and section 8.1 about the material database for more
details.

In EASE 5, a face can have one or several holes. For example, when looking at a side wall with windows,
each window could be modelled as a hole in the face representing the side wall. The acoustic

37



EASE 5 Third Edition — User’s Guide

Project Elements

properties of the window or any other item in or on a wall are defined using a second face that is set
inside of the first face. In rare cases a face may also be split in several parts, e.g., when a curtain covers
a complete vertical section of a side wall.
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366
366

3D View X | Acoustic Parameters v
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Figure 5.6 The Properties window of a face with a hole shows two tables of vertices.

The PROPERTIES window of a face shows the surface area of the face, the acoustic material, as well as
whether the face is visible in the 3D views or not. Additionally, the window shows the list of vertices
describing the shape (OUTER BORDER). The sequence of rim points is arbitrary but consecutive. Any holes
and additional borders are displayed as tables as well. When hovering over the caption of a table or

over avertex a Il trash bin symbol is shown. It can be used to remove the vertex from the face or the
hole, respectively.

Properties - Face

Material: Light construction

Area[m’]: 16666

Outer Border: | #1 - Vertices: 4
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10,00

~10.00

-10.00

-1000
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0.00
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000
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Vertex of Face

Figure 5.7 Face properties with highlighted vertex.

When hovering over a face, the status text shows the surface area of the face as well as the wall
material that is assigned to it.
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When a face is selected, its vertices are indicated as gray circles in the 3D view. Hovering over any of
these circles or over any of the table rows in the properties window will highlight the vertex in both
views.

Faces can be created and modified in various ways. These functions will be introduced later in following
sections.

When an overview is needed, a table showing all faces of the project is available as well. For more
details, please see sections 7.5 and 11.8.

5.4 Materials

Room models that are used for room acoustic analysis have information assigned to the faces that
determines the acoustic properties of the face, i.e., its absorption and reflection behavior. This is
important for simulating reflections as well as the reverberant field. The information is not needed
when only the coverage of the sound system is of interest.

When hovering over a face in the 3D view the material assigned to the face is shown in the status text.
More information can be found in the MATERIALS IN USE window that can be accessed through the
SURFACES ribbon menu (section 8.2).

By default, the MATERIALS IN USE window shows a view with a number of tiles. Each tile represents a
material in the project that was assigned to at least one face. Hovering over a tile will highlight the
faces with the same material. The tile itself shows the name of the material as well as the surface area
that it covers, relative to the total in percent and absolute in square meters or square feet. The
background of the tile indicates the absorption spectrum in a light gray. The color button in the upper
right shows the color that is used for solid renderings based on material colors.

Properties - Project ~ B X||3DView X | Acoustic Parameters

4

Name: |Auditorium
Author: |AFMG

Notes: g ‘

Exemple project by AFMG. )
Version 6. = ‘

Materials in Use +ax
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713 % 16.7 % 11.9 %
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Figure 5.8 Materials that are used in the project. One of the material tiles is highlighted as well as the faces in the 3D view to
which the material is assigned.
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To see more details for a material, hover over the ©= information icon of the material tile. This tooltip
window shows the curves of the absorption and the scattering coefficient, the description, as well as
other information.

Seating, heavy upholstery, audience - with scattering

Avg. Abs.: 0.65
1.00

0.80

060 #V/-

0.40

Coefficient

0.20
0.00
315 63 125 250 500 1k 2k 4k 8k 16k

Frequency [Hz]
® Absorption ® Scattering

Search Tags: None

Medium to heavy upholstered chairs, seated audience on any seating type

with estimated scattering.

Surface Area: 51539 m® 167 %
Equivalent Absorption Area: 337.58 m?

Figure 5.9 Details window showing the properties of a material assigned to faces of a room model.

Materials in Use The small toolbar in the top part of the window provides access to further
| — o functions. The first three buttons toggle between different views of the
55 == B E materials in the project: the tiles view, the tabular view, and the absorption
curve editor. Each of the views shows similar information, but in a different layout. The fourth button
showing a clipboard icon allows copying the table to the Windows clipboard so that it can be used for
creating reports or archiving purposes.

ooo

Please see section 8 for more information about the material database and the MATERIALS IN USE
window. This section also discusses modifying materials and analyzing their effect on the reverberation
time.

5.5 Loudspeakers

In EASE, sound sources are called loudspeakers. The term loudspeaker is used also for objects that are
construed of several cabinets, such as mechanical line arrays or clusters, as well as for digitally steered
columns. The term loudspeaker is used for arbitrary sound sources or human voices such as speakers
or singers, as well.
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Properties - Loudspeaker
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Figure 5.10 Properties window for a loudspeaker showing its location, aiming angles, and gain setting.

The basic properties of a loudspeaker include the label, whether it is visible or not, the speaker model,
the position, the aiming direction as well as gain and delay:

The LABEL can be any name but it has to be unique throughout the project.

The loudspeaker can be visible or invisible in the 3D view, this can be controlled using the
<@ button.

Every loudspeaker must have a speaker model assigned from the local database (section
9.1). The speaker model represents a loudspeaker product and contains information about
the sensitivity, the directivity and the maximum SPL capabilities. The product name and
the brand of the currently assigned speaker model are shown behind the MoDEL caption.
Hover over the icon to see more information. The default speaker model is
OMNIDIRECTIONAL.

The PosITION of the loudspeaker is given in 3D coordinates by X, Y, Z values.

The ORIENTATION of the loudspeaker describes where the loudspeaker is aimed using the
VERTICAL and HORIZONTAL angles. The ROTATIONAL angle can be set as well. The default
orientation is in the -y direction.

The GAIN and DELAY settings are part of a filter stage that is attached to the loudspeaker
and that can be opened through the " filters icon or the LOUDSPEAKERS > FILTER STAGE
ribbon button (section 9.4 for more details). Note that the gain cannot be greater than
zero as it is defined relative to the loudspeaker’s maximum output.

Note that for all numerical fields you can use the v spinner buttons or the mouse wheel to increment
or decrement the respective value.

In the 3D view, the loudspeaker is represented by its case drawing and two arrows indicating the
aiming direction and the upward direction relative to the cabinet.

When hovering over a loudspeaker, the status text shows the label, manufacturer and position of the
loudspeaker. In the 3D view, aiming lines are displayed for the currently selected or hovered
loudspeaker.
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L3 L3 k
Figure 5.11 Case drawing, aiming lines and aiming arrows for conventional loudspeaker (left), mechanical line array (center),
digitally steered column (right)

Besides the FILTER STAGE window, there are two more windows that allow viewing and configuring
loudspeaker objects. Both can be toggled on and off using the LOUDSPEAKERS ribbon:

e The CONFIGURATOR window (section 9.7) provides access to the configuration of all types of
loudspeakers, and especially line arrays, clusters, and similar arrangements.

e The LOUDSPEAKERS TABLE window shows all loudspeakers that are currently defined in the
project (for more details about the table, see also sections 9.6 and 11.8).

Notice that in the upper right of the properties window a green rectangle is shown. This is a status
indicator for the loudspeaker object. It may be yellow or red if some of the properties
of the loudspeaker are in conflict. For example, if the current configuration of a line

| array exceeds the weight limit defined in the corresponding GLL file, the indicator will
be red. Hover over the rectangle to see more information.

o)
(©}

Loudspeakers can be assigned to signal processing blocks (see section 9.5). Such a block allows setting
gain, delay as well as filters for a whole set of loudspeakers simultaneously.

The configuration of a loudspeaker can be copied to other loudspeakers using the CoPy and PASTE
functions (section 9.7.7) and it can be loaded from and saved to a configuration file (section 9.7.5).

The display of loudspeakers in a 3D view can be toggled on and off in the PRESENTATION ribbon.

5.6 Audience Areas

In EASE, virtual listening planes can be defined. These are called audience areas and they are used to
calculate mappings and to investigate the spatial distribution of result quantities such as SPL or STI.
Audience areas are generally understood as parts of the room where the audience is located or where
listeners may be expected. However, they do not have any acoustic properties and they do not affect
the propagation of sound in the simulation. Rather, they represent imaginary surfaces that are scanned
at a certain resolution in order to generate mapping points that act as probe positions or acoustic
receivers.

The PROPERTIES window of an audience area is very similar to that of a face. It has a border consisting
of several points. It can have holes as well. An audience area also has a LABEL that must be unique in
the project. It is shown in the status text when hovering over an audience area in the 3D view. The <
button controls whether the audience area is visible or invisible in the 3D views.

How audience areas are inserted in the project is discussed in section 10.1.
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Properties - Audience Area = 0 ||3DView X |Acoustic Parameters
Label: Area Balcony
Ear Height [m]: 120
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Outer Border; | #1 - Points: 4 a
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761 -33.17 348
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[Heraniim |
Figure 5.12 Properties window of an audience area. Base plane and listening plane are indicated in the 3D view.
It is important to understand that in EASE 5 an audience area actually consists of two virtual surfaces:

e There is the base plane which can be imagined as the floor surface that people are standing
on. The X, Y, Z coordinates of the OUTER BORDER refer to this base plane. It is the base plane
that is entered by the insert function or modified by editing tools.

e Then thereis the listening plane which is at ear height above the base plane in the vertical (+2)
direction. The mapping will actually be computed at the listening plane. The height of the
listening plane above the base plane can be adjusted using the EAR HEIGHT setting. This makes
it very easy to compute results at different ear heights without changing the location of the
audience area itself.

The display of audience areas in the 3D views can be toggled in the PRESENTATION ribbon. A table
showing all audience areas can be accessed through the RECEIVERS or the WINDOWS ribbon. See sections
10.1.4 and 11.8 for more details.

An audience area in EASE 5 can have more than 4 points. However, the calculation modules can
manage only audience areas with three or four points. Therefore, when using the RooM MAPPING
module an audience area with more than four points is split into triangular areas. These triangular
areas are automatically combined to one area group that can then be selected easily as an area group.
The labels of the triangular areas have the label of the original area with a consecutive number
appended to them.

5.7 Listener Seats

In EASE, so-called listener seats can be used to represent important listening positions or measurement
positions. Mapping results can be calculated at these specific locations as well as auralization results.
Like audience areas, listener seats have no acoustic effect but act as virtual probes in the room.

A listener seat has a unique LABEL, a POSITION given in 3D coordinates X, Y and Z, as well as an
ORIENTATION defined by the VERTICAL, HORIZONTAL and ROTATIONAL angles. The default orientation is in
the +y direction. Using the <@ button the listener seat can be hidden in the 3D views.
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In the 3D view, the listener seat is indicated by a chair symbol. When hovering over a listener seat, the
status text shows the label of the listener seat.

Properties - Listener Seat ~ 0 X ||3DView X | Acoustic Parameters
Label: 'Seat 3

Position Orientation
X [m} 224|%  Vertical ['): 00|%
¥ [m} -1864|%  Horizontal [*) 1800 |%

Z [m}: 120|% Rotational [°] 00|%

L3

Figure 5.13 Properties window of a listener seat showing its assigned name, its position and its orientation.
Please find more details about inserting and managing listener seats in the room in section 10.2.

The display of listener seats in the 3D views can be toggled on and off in the PRESENTATION ribbon. A
table showing all listener seats can be accessed through the RECEIVERS or the WINDOWS ribbon. See
sections 10.2.2 and 11.8 for more details.

5.8 Acoustic Parameters of the Room

By default, there is a second tab right to the tab of the 3D VIEw window. It belongs to the AcousTIC
PARAMETERS window. This window provides access to several important quantities that are derived
from the room geometry, such as the room volume, as well as access to general acoustic properties of
the room, such as the reverberation time.

This window shows each room parameter as a tile in a schematic view. The view also indicates
dependencies between quantities. Some tiles can be hovered and selected in order to view more
information or edit settings. You can zoom in on a diagram tile by scrolling with the mouse wheel when

hovering over the tile or by clicking on the A zoom icon.
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Figure 5.14 Acoustic parameters window showing various elementary properties of the room.

Please refer to section 19 for the formal definitions of the displayed quantities and acoustic
parameters.

5.8.1 Air Properties

In the upper part of the window, the AIR PROPERTIES are shown. Click on the tile to select it. In the
PROPERTIES window on the left, the TEMPERATURE, PRESSURE and HUMIDITY of the air in the venue can be
specified. These parameters have an effect on the absorption of sound as it propagates through air as
well as on the speed of sound (see also section 19).

Air Properties Properties - Air 0¥
Temperature [*C]: 20,0
20°C, 60 %
r 0 Preszure [hPa]: 1010 «
Temperaturs Humidity
Humidity [36]: 60 ~
Figure 5.15 Air properties tile. Figure 5.16 Air properties window.

5.8.2 Room Volume and Room Surface Area

The tile labelled VoLUME shows the overall volume of the room (see Figure 5.17). It is estimated from
the surfaces that have been defined for the room. If you have modelled a venue without a roof or if
you have entered just some listening areas on the ground, this quantity will have little meaning. In
particular for calculations based on statistical acoustics which assume an established diffuse sound
field the room must be closed.

The vertical bar on the right of the volume tile indicates whether EASE considers the room as open or
closed. Hover over the bar to be informed about the current status:

e Ifthe baris green, the surface elements defined for the room form a consistent, closed surface.
o If the bar is yellow there are small gaps or inconsistencies.
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o |f the bar is red, the missing or inconsistent pieces of the room are big enough to put
calculations based on statistical acoustics in question. The equation of Eyring or Sabine for the
reverberation time cannot be applied reliably in these cases (see also 19.1). Also, when running
ray-tracing calculations, sound particles may leave the room unintendedly and thus lead to
erroneous results.

How to analyze and resolve problems in the room geometry is explained in more detail in section 7.4.

Note that in the special case that the room volume is shown as a negative figure, this indicates a
problem related to the orientation of the surfaces. It is likely that most of them are oriented in the
wrong direction and therefore lead to a calculated volume that is negative. The function SURFACES >
INVERT ALL FACES can then be used to switch the orientation of all faces of the room as a starting
point.

The SURFACE tile shows the overall surface area of the room (see Figure 5.17). Like the room volume it
is estimated based on the surfaces of the room model. Errors or inconsistencies related to those will
also affect the accuracy of the calculation of the surface area.

Volume Surface Average Absorption Coefficient

11 276.93 m? 3 077.88 m? 0.25

1 kHz (1/3rd Oct)

Figure 5.17 Tiles for room volume, surface area, and average absorption coefficient.

5.8.3 Average Absorption Coefficient

As an indicator for the overall absorption the average absorption coefficient is shown for the 1/3™
octave band of 1 kHz in the AVERAGE ABSORPTION COEFFICIENT tile (see Figure 5.17). It is calculated as
the average over all surfaces of the room and the absorption coefficient assigned to them.

5.8.4 Reverberation Time

The parameters defined above can be used to estimate the reverberation time (RT) of the room
according to Eyring or Sabine within the model of statistical acoustics (see also 19.1). The result is
shown in the CALCULATED REVERBERATION TIME tile. Like for the room volume a vertical bar on the right
indicates any problems arising from the current definition of the room. These may be related to
guestionable results for the room volume or to missing information about the room’s absorption data.

You can zoom into the diagram by hovering over a tile and clicking on the &) zoom icon or using the
mouse wheel. This will show the RT curve in greater detail. The single value displayed as a number is
the average RT of the mid-band frequency range from 400 Hz to 5 kHz.

Clicking on the diagram shows the PROPERTIES window for the calculated RT, as well. The table lists the

=
RT values for each 1/3™ octave band from 25 Hz to 20 kHz. The = | button can be used to copy the

table to the clipboard and use the data elsewhere. Use the RT button to switch the effective
calculation model between EYRING MODEL and SABINE EQUATION.
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Measured Reverberation Time Calculated Reverberation Time
1.90 s 1.88 s
Mid-Band Mid-Band, Eyring

Reverberation Time

1.88 s

Mid-Band

Figure 5.18 The reverberation time can be either measured or calculated. The switch in the center determines which curve is
used.

The MEASURED REVERBERATION TIME tile works similar to the CALCULATED REVERBERATION TIME tile. It
allows you to enter a user-defined reverberation time, for example, if the RT was measured or if a
target RT was chosen. Click on the S zoom icon to view the data. In the PROPERTIES window the RT
curve can be specified, either in 1/1 octave resolution or in 1/3™ octave bands. If only a mid-band
estimate is available for the RT this can be entered as well and the software will extrapolate the given
value in the frequency domain based on an average of typically encountered RT curves. Use the Af
button to select the frequency resolution for entering the data.

Note that you can copy and paste an entire set of values from another software application into the
text fields by pressing Ctrl+V.

Either RT, calculated or measured, can be used for room acoustic calculations such as of Total SPL or
STI. To select one of them, click on the switching symbol above the REVERBERATION TIME tile. The
REVERBERATION TIME tile will then show the selected curve and subsequent calculations will use the
according data. For room-acoustic calculation using the measured RT, the average absorption for each
frequency band is calculated using the inverse Eyring equation.

Calculated Reverberation Time Measured Reverberation Time
3.0 Mid-Band (400 Hz - 5 kHz): 1.88 s 3.0 Mid-Band (400 Hz - 5 kHz): 1.90 s
25 Eyring 2.5

20 20

215 =
E

10 10

05 0.5

00 0.0

315 63 125 250 500 1k 2k ak 8k 16k

Frequency [Hz] Frequency [Hz]

Figure 5.19 Reverberation time calculated based on Eyring's  Figure 5.20 Reverberation time that was, e.g., measured or
equation (green), compared to the Sabine RT (gray). chosen as a target given only by a mid-band value.

Further details about using the reverberation time in EASE are provided in section 8.3.

Schroeder Frequency In all three diagrams that show the reverberation time the background of the
28 Hz very low frequency range may be shaded (see Figure 5.19 or Figure 5.20). The
upper cutoff frequency of the shaded area is the Schroeder frequency. It is
generally assumed to represent the lower frequency limit for Eyring/Sabine
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statistics and geometrical acoustics. The exact value for the Schroeder frequency is shown on the
SCHROEDER FREQUENCY tile below the REVERBERATION TIME tile. For more information about this acoustic
guantity, please see section 19.1 in the appendix.

5.8.5 Input Signal

The type of input signal that is used for simulating the excitation of the room by the sound system is
shown in the INPUT SIGNAL tile in the upper left of the ACOUSTIC PARAMETERS window. The following
different types of input signals are available:

e PINK NoISE: When using this signal, every 1/3™ octave band of the spectrum is driven at the
same level. This is the default.

e The SPEECH CRITICAL (IEC 60268-16:2020) signal is a broadband signal with emphasis on
the speech bands as defined by the STl standard. The spectral shape is representative for the
frequency spectrum of talking male speakers. This option should typically be selected for STI
calculations, and in particular for modeling worst-case scenarios and emergency
announcements.

e The SPEECH OFFICE (ISO 3382-3:2022-04) signal is also a speech signal but represents a
mix of male and female voice spectra. It was defined in particular for analyzing office
environments.

e The PROGRAM (IEC 60268-1) signal is a broadband test signal with a spectral shape that is
similar to typical program material and relatively close to pink noise. This signal covers a broad
range of applications and is not as unnatural as pure pink noise.

e TheMusic (EIA 426B) signalis a broadband signal with a spectral shape that is derived from
the average of many pieces of different music.

Additionally, the Use LIMITED BANDWIDTH option can be selected for any of the input signals. It applies
a bandpass that attenuates the input signal outside of the bandwidth of 100 Hz to 10 kHz. More
precisely, the filter is a Butterworth bandpass with a slope of 12 dB/octave (2" order) and the corner
frequencies of 88 Hz and 11.3 kHz. When active, this option allows comparing absolute levels between
the Acousteer mapping calculations (section 13) which are conducted at the full audio bandwidth and
the calculation modules (section 14 and following) which are limited to the 1/3™ octave bands of 100
Hz to 10 kHz. When inactive, due to the different signal bandwidths, different absolute levels will be
achieved based on the modeling of the maximum input voltage (see below as well as sections 9.4.1,
13.7,19.2.1).

The SAFETY MARGIN FOR CREST FACTOR setting for the input signal relates to the absolute level of the
input signal. If a value different from the default value of 0 dB is chosen, an additional broadband
attenuation is applied to the input signal. If the achievable maximum output SPL of the sound system
is a design aspect, this setting can be used to include additional headroom in the simulated signal
processing. It could be necessary, for example, if the MIV of the loudspeakers in use, that is specified
in the speaker model GLL, is too high for the type of application or program material and clipping or
distortion have to be expected in practice when it is applied. More details are discussed in sections
9.4.1 and 13.7.

The background of the INPUT SIGNAL tile shows the frequency spectrum of the selected signal in gray.

c: . . . .
To zoom in, scroll the mouse wheel or click on the « zoom icon while hovering over the chart. Click
again to return to the full view.
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Figure 5.21 Selection of input signal with available options in the properties window on the left: pink noise, speech, program,
music.

By default, each loudspeaker in the simulated venue is driven at the loudspeaker’s maximum input
capabilities so that its maximum output SPL is produced.

e For loudspeakers referring to GLL-based speaker models, the drive level is automatically
maximized on the basis of the spectral shape of the signal so that the maximum input voltage
(MIV) of the loudspeaker is reached. The resulting output SPL may be higher or lower
depending on the type of input signal. This consideration also includes the internal filter
settings of the loudspeaker as well as any filters defined directly at the loudspeaker inputs.

e Forloudspeakers referring to proprietary, DLL-based speaker models, it is not possible for the
software to determine the MIV. The input signal is therefore applied as a relative spectrum
where the maximum is 0 dB. All other bands are attenuated, accordingly. Choosing a signal
different from pink noise will result in an equal or lower broadband output SPL.

The drive voltage applied to a loudspeaker can be viewed in the loudspeakers table (section 9.6). The
EFFECTIVE MIV column of the table shows the simulated effective input voltage in dBV based on the
selected input signal and the loudspeaker’s internal filter settings. For the effect of filters higher up in
the signal chain, please see section 9.4.1.

5.8.6 Global EQ and Sound System

The input signal that is fed into the sound system can be modified with respect to its gain and its
spectral shape. Such global filter elements are defined and adjusted using the GLOBAL EQ tile in the
ACOUSTIC PARAMETERS window.

The global EQ can be used, for example, to set the level of the sound system to maximum output or to
a user-defined operational level. It can also be used to equalize the sound system as a whole.

After selecting the GLOBAL EQ tile, the gain setting can be changed in the PROPERTIES window. Further
filters can be applied using the FILTER STAGE window. It is available also for individual loudspeakers
and processing blocks and can be opened by clicking on the <" filters icon or using the WINDOWS >
FILTER STAGE ribbon menu. See section 9.4 for more details about the filter stage functions.
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Figure 5.22 The global EQ allows applying signal processing to the entire sound system. In the example shown, a gain of -6 dB
is applied as well as a light high-pass filter.

Note that the global EQ is applied to the input signal independently from the other elements in the
signal processing chain. The global EQ affects the output signal of all loudspeakers in the same way.

Sound System Below the GLOBAL EQ tile there is the SOUND SYSTEM tile. It indicates the
number of active loudspeakers as well as the overall number of

20 o loudspeakers.

Active Loudspeaksrs

A vyellow or red bar on the right represents a warning and indicates that the
sound system configuration is not well defined. Note that the sound system status can change when
the simulation configuration is changed (section 13.2.4) because the simulation configuration
determines which loudspeakers are active.

5.8.7 Reverberant Level

When the sound system is turned on, it will fill the room with acoustic energy. This energy is absorbed
by the air as well as by the surface materials in the room. When the equilibrium of energy that is
supplied by the sound system and of energy that is absorbed is assumed, the steady-state level of the
reverberant field can be determined. This quantity is shown on the REVERBERANT LEVEL tile in the lower
left of the window.

The value is determined for each 1/3™ octave band based on the sound power output of the active
loudspeakers as well as the room volume, its reverberation time, and the average absorption
coefficient. As the metric depends on the frequency, as well, the corresponding diagram is shown in
addition to the broadband figure on the tile. It can be viewed in greater detail by zooming into the tile
using the mouse wheel or the St zoom icon.
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Like for the reverberation time, the very low frequency range where this type of calculation is not
reliable is indicated by a shaded background.

The reverberant level cannot be computed, for example, if there is no sound system or if the room is
not closed. Also, loudspeakers based on proprietary speaker models (DLLs) are ignored. The bar on the
right of the tile indicates related warnings and errors based on the input data available for the
calculation.

Reverberant Level

100.0 Broadband: 99.0 dB (A), 101.8 dB (2)
80.0
60.
40.
Reverberant Level 20.
0.
99.0 dB (A) P

Level [dB]
c 5 & &
o [=] o

o

101.8 dB (Z)

Frequency [Hz]

Figure 5.23 The Reverberant Level tile (left) and diagram (right) show information about the acoustic energy contained in the
steady-state diffuse field.

Selecting the tile will automatically switch the PROPERTIES window to display the spectrum of the
reverberant field in a tabular format. If needed the data can be exported to the clipboard like from
other windows. Like for the reverberation time, the frequency range below the Schroeder frequency
is indicated in the diagram by a shaded background and in the PROPERTIES window by rows that are
grayed out.

Please note that the numbers displayed here may deviate slightly from the values calculated in the
calculation modules (sections 14 and 16) as the main program is using a more precise and faster
method to determine the sound power output of the loudspeaker system.

5.8.8 Noise Level

The settings in the right bottom of the AcousTiCc PARAMETERS window are used to define the ambient
noise for the simulated room. Clicking on the MEASURED NOISE LEVEL tile will update the PROPERTIES
window to show the current noise level values. The frequency spectrum of the noise is shown in the
NoISE SPECTRUM tile below. Clicking on the % z00m icon or scrolling the mouse wheel will zoom in on
the related two tiles. In EASE 5, the noise level can be defined based on a single BROADBAND value or
based on a fractional-octave spectrum in OCTAVE or 1/3 OCTAVE resolution. The frequency resolution
can be chosen using the Af button.

With respect to data entry, you can copy and paste values from another application into the table. The
absolute level of the noise spectrum can be adjusted in increments of 1 dB using the + and - buttons.
Noise spectra, such as NC or RC curves, can be imported also from files, including from the database

installed with EASE. To select and load a noise spectrum file, press the EE button.

The resulting curve is shown in the NOISE SPECTRUM tile. It will be applied to all calculations that require
information about the ambient noise level, such as STI calculations. The MEASURED NOISE LEVEL tile
shows the corresponding broadband noise level in dB (A) and dB (Z).
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While the noise spectrum is generally defined from 25 Hz to 20 kHz, parts of the program use only the
range of 100 Hz to 10 kHz, such as the Room Mapping module. Note also that the above-mentioned
noise spectrum files are limited to this smaller frequency range, as well.

Properties - Measured Noise Level ~ B X| 3D View Acoustic Parameters X v
-
£] Af +-
Frequency Band Noise Level [dB] izzREE] (e v
25 Hz
- 39.0 dB (A)
w0k 493 dB (2)
50 Hz
63 Hz
80 Hz
100 Hz 39.0
125 Hz 404
160 Hz 344 Schroeder Frequency Noise Spectrum
200 Hz 320
250 Hz 323 3 6 HZ L ;,
g
400 Hz 348 T T im, i = - o
500 Hz 337 1
630 Hz 253
800 Hz 271 |~

Figure 5.24 Properties window (left), broadband level display (upper right) and diagram for noise spectrum (lower right).

Use the switch below the NOISE SPECTRUM tile to turn off the noise for any calculations.

AN

125 250 500 1k 2k ak 8k

Frequency [Hz]

[

Figure 5.25 Switch for ambient noise.

5.9 Further Project Elements

When several items are selected simultaneously, the PROPERTIES window shows a summary of the
selection. This includes the total number of selected room elements as well as the number of selected
items of each different type. Additionally, the total surface area of the faces and of the audience areas

is displayed.
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Figure 5.26 Selecting multiple elements displays a statistical overview in the properties window.

A project can have further elements:

e Processing blocks can be used to group loudspeakers and apply additional signal processing
functions to them, such as gain, delay, and filters. See section 9.5 for more details.

e Selection sets are used to group any number of room items. These selections can then be
recalled at a later point of time, e.g., to jointly modify the items assigned to the set. See section
11.6 for more details.
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6 Prerequisites for Inserting or Editing a Room

6.1 Undo and Redo

Whenever the room model is changed, the change is stored in memory. It can be undone using the
undo button from the quick access menu. The icon on the button shows an arrow pointing
counterclockwise. You may also press the shortcut Ctrl+Z to the same effect.

meE >

Figure 6.1 Quick access menu with program icon, save button, undo button and redo button (from left to right).

If you wish to redo a change that was undone before, click on the redo button or press the shortcut
Ctrl+Y. The redo button is the button with the arrow that points clockwise.

Note that the information about any editing steps is lost when closing the program. Opening a project
will also discard the undo memory.

6.2 Mouse Modes

EASE 5 offers a range of different mouse modes that are used to view and edit the room model.

An important mouse mode is the SURFACES > INSERT POLYGON mouse mode because it is used to define
the surfaces that establish the room. We will discuss it in section 7.3. Another important mouse mode
is the SELECTION mouse mode (see also section 4.1.3 about hovering and selecting items) which is
available on the very left of most ribbon menus. In the following section 6.3 we will use the MEASURE
mouse mode from the TooLs ribbon menu to explain how 3D coordinates can be inferred or entered.
A mouse mode can be switched on by clicking on the respective button.

All mouse modes except for the SELECTION mode can be left by pressing Esc or switched off via their
corresponding menu ribbon buttons. Most mouse modes remain activated after the operation was
finished, such as inserting a face. This allows performing several operations in a row without having to
re-activate the mode each time.

Notice that some modes require multiple steps to finish, e.g., in the INSERT POLYGON mode at least
three vertices spanning a plane must be defined to create a new face. On the other hand, the INVERT
FACE mode requires only a single step, namely selecting the face that should be inverted.

Some modes require an object to be selected before they can be activated, such as the FACE IN FACE
mode. Other modes require an object to be selected as the first step after they have been activated,
such as the Move mode. Many modes, such as INVERT FACE have a dual function. They can be activated
when there is no item selected in order to select and change items subsequently. If one or multiple
items are already selected before activating the mode, the change is immediately applied to all
selected items and the mode is switched off again. A number symbol on the respective ribbon button
indicates the number of affected items (Figure 6.2). Refer to the tooltip of each mode for more details.

+ O
7

Invert
Face

Figure 6.2 Invert face ribbon button if three faces are selected.
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In most modes the previous step can be reverted by pressing the shortcut U.

Many editing modes provide a preview while editing. For example, when the Move mode is active any
displacement of the object to be moved is indicated by a light, yellow version of the object in the new
place.

Figure 6.3 Preview while moving a face.

6.3 Defining 3D Coordinates

Many mouse modes in EASE 5 require 3D coordinates as input. For example, when inserting a face, the
X, Y, and Z coordinates of each of its vertices must be defined. When moving an object, the target
coordinates must be known, as well. However, when using the mouse cursor on the computer screen
only two coordinates are immediately defined whereas the depth is unknown. Therefore, additional
assumptions and tools are required that facilitate specifying 3D coordinates.

The functions introduced in the following sections are explained and shown interactively in our video
tutorial for room entry.

6.3.1 Measuring Distance and Delay

In the following section we will use the TooLs > MEASURE mouse mode to describe all important ways
to define coordinates and infer locations in 3D space. These functions and techniques are available in
all modes, sometimes in a slightly modified or extended way. But generally speaking, they are
consistent throughout the program.

The MEASURE mode is a two-step mode. That is because measuring distances requires defining a start
point and an end point. A left-click in the 3D view or any of the functions introduced in the following
sections can be used to define the start point for the measurement.

After the start point is set, measurements will be automatically taken and displayed assuming that the
current mouse location is the end point. Left-clicking again will define a new start point.
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Distance: 12.33 m | 35.983 ms z
polar: Ver @.8° | Hor 125.1° -
Displacement: 10.09 | 7.89 | @.e0 [m] Y
Start Point: 12.32 | -16.67 | @.@@ [m] X
Target Point: 22.41 | -9.58 | e.ee [m]

Absolute v X[ml:| 2293 Y[m: -8.60 Z[m: 000

Figure 6.4 Measuring the distance from a defined start point to the mouse location.
The following measurement information is shown in the status text:

e In the first line, the DISTANCE between the two points is displayed as well as the delay that is
computed based on the speed of sound (see also sections 5.8.1 and 0).

e The line labeled PoLAR shows the vertical and horizontal angle for the differential vector
pointing at the end point.

e The DISPLACEMENT is the spatial offset between the two points in the X, Y and Z directions.

e START POINT and TARGET POINT correspond to the absolute locations of the first point set and
the current location of the mouse.

6.3.2 Entry of Coordinates by Mouse or Control Bar

Generally, 3D coordinates can be defined either by clicking with the mouse in the 3D view or by
entering information in the control bar that is located at the bottom of the window (see Figure 6.4).
Sometimes these functions are also used in combination.

For an empty project, the situation will look similar to Figure 6.5:

1. The cross at the mouse cursor indicates the 3D position. This is, e.g., where the next point will
be set when left-clicking. The cross symbol will also be called insert cross or positioning cross
in the following.

2. The status text shows the current 3D coordinates derived from the mouse location.

3. The control bar allows to enter 3D coordinates manually.

When using the mouse and there are no further objects in the project the 3D coordinates are
determined using the Z = 0 plane. That means that it is assumed that the mouse is used to choose the
X and Y coordinates whereas Z is always zero.

The control bar at the bottom of the window can be used without further assumptions, i.e., all three
coordinates X, Y and Z can be entered freely.
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3D View X | Acoustic Parameters

«

" ks

Start Point: 6.25 | 5.8 | 8.00 [m]

Absolute ¥ X[m]: 000 Yml: 000 Z[m}: 000 3

Figure 6.5 Positioning cross and mouse cursor (1), status text showing coordinates (2), and control bar (3).

The Tab key can be used to move the focus from the 3D view to the control bar. When the focus is on
the control bar, moving the mouse over the 3D view will remove the focus from the control bar.

Whether the focus is on the 3D view or on the control bar is indicated by the '« symbol on the right.
Only if this symbol is highlighted, the control bar is active and can be used to confirm coordinates by
pressing Return (Figure 6.6, Figure 6.7).

Absolute v X [m]: Y [m]: 0.00 Z [m]: 0.00 ‘J

Figure 6.6 Focus is on control bar. It is active for confirming keyboard input.

Absolute v X [m]: Y [m]: 0.00 Z [m]: 0.00

Figure 6.7 Focus is not on control bar. It is inactive for confirming keyboard input.

When the control bar has focus pressing Tab will cycle through all fields of the control bar. If you change
the data in one of the fields, pressing Tab will update the preview and also the location of the
positioning cross in the 3D view.

When the control bar does not have focus one can also start typing numerical values. This will also
move the focus to the control bar and put it on the first text field that is enabled. When done typing,
pressing Tab will move the focus to the next field and update the preview.

Coordinates can be confirmed either by left mouse click when the mouse is active over the 3D view or
by pressing Return when the control bar is active and coordinates from the coordinate fields are to be
used. Confirming a coordinate will return the focus to the X text field automatically.

At any time, coordinates can be transferred from the mouse location to the control bar by pressing the
S shortcut. This will also activate the control bar, i.e., move the focus to the control bar.
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6.3.3 Snapping by Mouse - Inferring from Point Objects and Surface Objects

If room elements exist already, 3D coordinates can be inferred by snapping to a room element,
hovering over it or referring to it in some other way. This is usually accomplished by either left-clicking
on the object or location of interest, or by pressing a specific short cut.

The following distinguished points can be directly snapped to:

e The origin at (0, O, 0).

e The corner points of faces and audience areas. (This includes the temporary points of a
previewed face or audience area while creating it.)

e The midpoints of the edges of faces or audience areas.

e The insert points of listener seats and loudspeakers.

e In some modes (Face in Face, Move Vertex, Move Point) the edges of the surface object can
be snapped to, as well.

e The anchor point in those editing modes where it is defined, such as in Move, Duplicate,
Extrude, or Rotate.

When snapping to a point, the snap location is indicated by a filled pink circle. Snapping to points can
be suspended temporarily by keeping F3 pressed.

I

Figure 6.8 Snapping to the origin (left) and to the corner point of a face (right).

Coordinates can also be inferred by snapping to drawings or hovering over them. When the mouse is
over a drawing, the plane of the drawing will be used to determine the 3D coordinates associated with
the mouse location.

Also, points can be inferred from the planes of faces and audience areas by hovering over them. By
default, this function is active only for some modes, e.g., the MEASURE mode. For most other modes it
has to be switched on first by pressing F2 once. Pressing F2 again will disable this type of snapping
again. The setting is remembered until the same mode is started again or a new mode is started.

- ¥
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Figure 6.9 Hovering over a drawing (left) or a face (right) to determine 3D coordinates in the plane of the object.

There are two important applications of snapping to faces. First of all, a point can be placed on a face.
This can be helpful when drawing a face that is adjacent and perpendicular to another face, for
example. In this way the new face can be attached directly to the existing face. A second important
use case is the determination of intersection points of lines with faces. This will be discussed a little bit
further below.

6.3.4 Inferring Coordinates Using Constraints

In the context of EASE 5, a constraint represents a restriction or limit that in some way reduces the
available degrees of freedom for determining 3D coordinates from the full 3D space to a plane, a line,
or just a point.

Constraints are created primarily in the following ways:

1. When creating or modifying a planar element, i.e., a face or an audience area: When inserting
a face or audience area and at least three points not in line are given, a so-called plane
constraint is automatically activated for entering the following points. When inserting a face
into a face or modifying the points of a face or audience area the plane constraint is active
from the beginning.

2. When defining an axis constraint by selecting a base point and pressing the X, Y or Z shortcut:
This will limit the space of possible 3D coordinates to a line that runs through the base point.
If there are no other constraints the direction of the line will be the direction of the x-, y- or z-
axis, respectively. If a plane constraint is additionally active, the 3D coordinates will be derived
by projecting the line of the constrained axis onto the given plane, i.e., by calculating the points
in the plane.

3. When activating the Z-plane constraint by pressing Shift+Z: This will limit the space of possible
3D coordinates to the Z plane of the last point specified. If a plane constraint is already active,
activating the Z-plane constraint will usually result in a line that represents the intersection of
the two planes.

When a plane constraint or an axis constraint is active, the snapping behavior described before is
modified as follows:

e If a point is snapped or a drawing is hovered, the coordinates are projected onto the plane of
the plane constraint or the line representing the axis constraint (Figure 6.10).

o Ifaface oraudience area is hovered while an axis constraint is active, the resulting intersection
point is calculated and displayed - if there is one. This assumes that the function for snapping
to faces is active (see above).

Note that the axis and plane constraints also apply when the control bar is used to enter coordinates.
These coordinates are projected onto the currently active line or plane, as well.

A constraint can be deactivated by pressing the same shortcut again or by pressing U. However, in
those cases where a plane constraint is active due to the nature of the function, such as when inserting
or modifying the vertices of a face, the constraint cannot be switched off.
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Figure 6.10 The tip of the back wall is inferred by using a Z-constraint and projecting from the tip of the front face (left) or
from the drawing (right).

6.3.5 Inferring Coordinates Using a Reference Point, Relative Coordinates

When using the control bar, coordinates can be entered in two different ways, namely in absolute
mode (ABSOLUTE) and in relative mode (RELATIVE). When working with absolute coordinates all
coordinate entries happen in the room coordinate system, i.e., relative to the origin. In relative mode,
all entries refer to the current reference point.

Absolute ¥ X [m]: 11.45 Y [m]: -9.99 Z [m]: 0.00 ¢J

Figure 6.11 Control bar in absolute coordinates mode.

Relative < AX [m]: AY [m]: 0.00 AZ [m]: 0.00 .J

Figure 6.12 Control bar in relative coordinates mode.

In the 3D view, the reference point is indicated by a small axis cross (Figure 6.13) when relative mode
is on. When using the mouse, by pressing R, the reference point can be set manually on any location
or snapped point. It is automatically set to the respective base point when an axis constraint is
activated using the X, Y or Z shortcuts. In both cases, the focus is moved to the control bar and the
mode is switched to relative mode. Also, only the field of the free coordinate can still be modified
whereas the other two fields in the control bar are disabled.

When using the control bar, the reference point can also be set to the current coordinates by pressing
R.
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Figure 6.13 Reference point and mouse location indicated by small axis crosses.

The reference point is set automatically when starting some modes, for example, when moving or
duplicating an object. For loudspeakers and listener seats the initial reference point has the same
coordinates as the location of the object that is going to be manipulated. For faces and audience areas
the initial reference point has the same coordinates as the anchor point that is selected when the
operation is started. When inserting faces or audience areas, the reference point is set automatically
to the location of the most recently defined vertex or point.

W

-2.49 | 3.78 | e.e@ [m)
Length: 5.80 m

Relative b AX [m]: 5.00 AY [m]: 0.00 AZ [m]: 0.00 _J

Figure 6.14 Coordinate entry relative to reference point - in this case by using the X-constraint and a distance of 5 m from the
reference point.

Using the relative mode, it is very easy to define 3D coordinates as an offset relative to an already
known point. Just snap to the point, press the shortcut for the axis constraint, type the distance and
press Return (Figure 6.14).

Notice that the reference point is not visible in absolute mode.

6.3.6 Inferring Coordinates from an Intersection

Snapping to faces is particularly useful when intersection points need to be computed. For example, if
the X and Y coordinates of a point on a slanted roof are known but the Z coordinate is not, this value
can be determined using the intersection function. The function works as follows:
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1. First enable snapping to faces so that faces are highlighted when the mouse is hovering over
them (F2). Find the right starting point in the X-Y plane and activate the axis constraint by
pressing Z. Now the coordinate entry is restricted to the vertical and relative to the base point.

2. Use the mouse to hover over a face that is located along this axis. Its intersection point with
the vertical line will be shown and it can be selected by a left mouse click. If a face is hovered
that does not have an intersection point but whose plane has, the corresponding point on the
plane is highlighted (Figure 6.15).

The intersection function is particularly useful to draw columns and other volume objects that are
attached to arbitrary surfaces.

Figure 6.15 Calculating intersection points with the plane of a face: Inside (left) and outside (right) of the face. Select base
point and axis constraint (1), hover over face to determine intersection point with plane (2).

6.3.7 Function Overview
The following is a complete list of functions available to determine or infer a point in 3D space:

e Use the mouse to snap to a point, to the origin, or to the midpoint of an edge. Deactivate
snapping temporarily by pressing F3.

e Use the mouse to select (snap to) a listener seat or a loudspeaker.

e Hover over (snap to) faces, audience areas, drawings, or the ground plane (Z = 0). If not
switched on, activate by pressing F2.

e Activate an axis constraint using the X, Y, or Z shortcuts. This will use the current mouse
location as the base point. It will also move the reference point to the base point.

e Set a reference point for relative coordinate entry by pressing R or by activating an axis
constraint.

e Activate the horizontal plane constraint using the shortcut Shift+Z. This will fix the plane to the
z-coordinate of the previously set point.

¢ When an axis constraint or a plane restriction is active, project from any of the points selected
in one of the first three ways.

e Use the control bar to manually enter coordinates in relative or absolute mode.

e Use the S shortcut to transfer the coordinates of the current mouse location to the control bar
and modify them.
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7 Defining the Geometry

In this chapter, an overview will be provided about the toolset that can be used to create the room
geometry in EASE 5. In principle, there are three different approaches that can also be combined or
mixed:

e The geometry of the room can be entered manually using known coordinates and the drawing
functions of EASE.

e Section drawings can be imported as bitmap files. These are used as the basis for drawing the
room geometry in EASE.

e A 2D or 3D room drawing can be imported as a DWG file. It can be subsequently extended or
modified in EASE.

It is common to all three approaches that after the geometry is defined (see sections 7.1, 7.2, and 7.3),
the consistency of the model should be checked for problems, duplicates or missing parts (section 7.4).
After that, acoustic materials can be assigned to the surfaces (section 8.1) and important acoustic
quantities like the reverberation time can be computed (section 8.3).

Defining the sound system and the audience areas will be discussed separately in the next chapters.

7.1 Importing Graphics Files for Section Drawings

An introduction into the basic properties of drawing bitmaps was given in section 5.2. We will expand
on that here and discuss more details of managing and using drawing bitmaps.

After loading a graphics file using the FILE > DRAWING > LOAD menu command, the bitmap is shown
in the 3D view. The drawing is selected automatically as the currently active item of the project.
Accordingly, the context ribbon menu SELECTED DRAWING is shown. Through this menu, functions
relating to the currently selected drawing can be accessed.

TREHE 98/

Floor Front Section Rotate Anchor Scale Drawings
Point Table
Type of Drawing Edit

Figure 7.1 Context ribbon menu for the selected drawing.

When a drawing is selected, the anchor point of the drawing is indicated by an orange square and the
scale line is indicated by an orange line.
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4

3D View X | Acoustic Parameters

N

Figure 7.2 Selected drawing with default anchor point and scale line.

After the import of the file, first select whether the drawing is a floor plan (or ceiling plan) using the
TyPE OF DRAWING > FLOOR option, a front or end view using the FRONT button, or a side view using the
SECTION button. This will turn the drawing into the corresponding plane.

If the orientation of the drawing relative to the coordinate axes needs to be adjusted, the ROTATE
command can be used to rotate the drawing in place.

As the next step, set the anchor point by starting the ANCHOR POINT mode from the ribbon menu and
left-clicking on a distinguished point of the drawing (Figure 7.3). The PosITION X, Y, Z fields in the
properties window can then be used to define the position of this point on the drawing in the 3D
coordinate system of the room or venue (Figure 7.4).

3D View X | Acoustic Parameters

7.11 | s0.30 | 0.0@ [m]
Drawing X

Fig()re 7.3 Anchor point placed at front center point of F)'gure 7.4 Coordinates of anchor point set to origin (0, 0, 0).
assumed stage.

Finally, the drawing has to be scaled because bitmap files typically do not carry any information about
the physical size of the objects they are depicting. Activate the SCALE mode from the ribbon menu and
place the scale line on a line of the drawing that has a known length or place its ends on two points for
which you know the distance. The scale line does not need to be parallel to either axis. It is
recommended to define as long a scale line as possible to minimize scaling errors.
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3D View X | Acoustic Parameters v [30 View X | Acoustic Parameters v
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Figure 7.5 Scale line placed on dimension line. Figure 7.6 Resized drawing after entering length for scale
line.

After that, enter the real-world length of the line section in the SCALE > LENGTH field. The drawing will
then be enlarged or downsized accordingly. The aspect ratio of the bitmap cannot be modified.

The described procedure can be repeated for multiple drawings. A typical arrangement if all view
directions are available is shown in Figure 7.7. Notice that the front and the section drawing are
displaced relative to the origin so that they do not interfere when drawing the room.

3D View X | Acoustic Parameters

4

N

Figure 7.7 Three section drawings loaded.

Once the drawings are in the right spot, faces can be inserted manually by referring to points and lines
on the drawings and projecting from them (see also sections 6.3.3 and 6.3.4).

For convenience, the LABEL property can be used to assign a user-defined name to a section drawing.
Use the <& and 92 buttons or the shortcut Ctrl+H to hide and unhide the currently selected drawing.
The DRAWINGS TABLE provides an overview over all drawings in the project and allows selecting
drawings that are not visible in the 3D view (for more details about tables in general, see also the
overview in section 11.8). The ToGGLE VISIBILITY command in the TooLs ribbon menu allows hiding
and showing the currently selected drawings.
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Drawings Table v X
g a column header here to group by that column Q
Vis. [ Label « | X[m] [Y [m] | Z[m] |Scale [m]
& Elevation 20.00 0.00 0.00 30.00 -~
€ End 0.00 20.00 20.00 30.00
» & Floor 0.00 000 -1.00 30.00
€)

Figure 7.8 Drawings table showing three different drawing bitmaps.

7.2 Importing DWG Drawing Files

EASE 5 supports the import of 3D CAD models in DWG file format. DWG is a native format of the
AutoDesk AutoCAD software. Other common CAD tools, such as Trimble SketchUp Pro, Vectorworks
or Rhinoceros 3D by Robert McNeel & Associates, can save models in DWG file format as well.

Room models that are created with a CAD tool outside of EASE should already be suited for acoustic
simulations. The degree of detail should be reduced so that they fit the simulation purpose and the
EASE tools that will be used. In fact, it is expected that the DWG-based model considered here is
created primarily for use in EASE 5. Arbitrary DWG-based models used for general architectural
applications, on the other hand, are often not suitable for import and use in EASE.

EASE models can also be exported in DWG format. Please refer to section 11.9 for more details.

7.2.1 Import Rule Set

In order to import CAD models into EASE 5 the corresponding DWG files must comply with an import
rule set. This rule set consists of some restrictions specifying how the model has to be drawn and which
elements it has to be composed of in order to be properly supported by the EASE import module.

In EASE 5, the following CAD model base elements are supported by the import function:

e 3D Polylines

e 3D Faces

e Polyface Meshes
e SubD Meshes

e 2D Polylines

e LW Polylines

e Arcs
e Circles
e Ellipses

All of these types of elements are converted to EASE faces. All other elements are ignored.

Block references can be used within the DWG file. Upon import, blocks are resolved into the single
base elements.

Many CAD applications allow to hide certain elements. Such hidden elements are imported and
displayed as long as they fulfil the import conditions.
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The following specific conditions apply to the import:

o Asurface element must not be an intersecting surface, that is, the border of the polygon must
not intersect itself.

e 3D Polylines and 3D Faces have to be planar.

e Polylines that are not closed are closed automatically.

o Arcs, Circles and Ellipses are converted into faces with straight edges using an angular
resolution of approximately 15°.

o Polyface Meshes and SubD Meshes can also be imported into EASE 5. This is particularly
important for importing DWG files that were created with SketchUp. A mesh should be planar
to be imported, i.e., all points of one mesh must be in one plane. Normally, upon import all
partial faces of one mesh are combined to one face with one outline in EASE. In the special
case that faces of the mesh share only one common point (not a common edge) the import
splits the mesh into two or more faces. If a mesh is not planar, triangles that are outside of the
main plane are imported as separate faces.

e |tis assumed that a mesh consists only of triangular and quadrangular faces. Faces with five
points or more will not be imported.

e Holes of meshes are correctly processed to holes in EASE faces. Block references are resolved
as described above. Edges of a mesh can be marked as visible or invisible in the DWG file. This
property has no influence on the import.

Various units of length are supported. Drawings loaded in one of these unit systems are converted and
displayed in the currently selected EASE unit system. These units are:

e Metric unit system: millimeters [mm], centimeters [cm], meters [m], decimeters [dm],
hectometers [hm], kilometers [km].
e US customary system: inches [in], feet [ft], yards [yd], miles [mi].

If the length unit is not defined properly, EASE 5 will make a plausible assumption and inform you
about it.

Note that EASE will convert the imported drawing to the internal unit system which is metric. The
project will be displayed in the unit system selected in the options area (see section 3.2).

EASE 5 also supports importing layers or tags. These are typically used to organize and manage the
project. All layers provided by the DWG file are converted to selection sets (see section 11.6). The room
items assigned to a layer will be assigned to the respective selection set, accordingly. This allows you
to perform numerous changes to the model after the import such as:

e Assigning acoustic materials to faces on specific material layers,

e Adding audience areas to the faces of a respective layer,

e Creating back side faces for the faces of a layer used for parapets or ceiling clouds,
e Deleting items from layers that are not needed.

If you need to deal with different custom groups of faces in EASE 5, assigning them to layers in the
respective CAD software before importing can be the quickest way to establish this structure.
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Figure 7.9 Layers or tags are imported as selection sets. In this manner, for example, faces on different layers can be assigned
different acoustic materials in EASE.

Note for EASE 4 users: Importing other room items like audience areas, listener seats or loudspeakers is not
supported by EASE 5. The import of additional face properties such as the acoustic material or color is also not
supported. Except for the color, all of these aspects can be easily added to the model in EASE 5 itself.

7.2.2 Importing DWG Files

To load a DWG file, click on the FILE > PROJECT > OPEN button and select the DWG file. Note that
importing a DWG file in this way automatically sets up a new project with default settings.
Alternatively, use the FILE > PROJECT > ADD button to insert the contents of a DWG file into the
current project.

For large DWG files a progress bar is shown. The software will automatically abort the import process
if it takes longer than 60 seconds. In this case, it is recommended to reduce the complexity of the
model in the file.

If the file contains elements that cannot be imported or if the unit system is not supported an import
log will be shown that lists the issues that occurred during import.

If you have imported the drawing of a complete room, it is highly recommended to verify the geometry
after the import. Please see section 7.4 for details. If some faces have not been imported or they are
missing for other reasons you will have to either draw them in EASE or modify the original DWG file
and import it again. Faces that have the wrong orientation can be inverted in EASE.

The DWG file may also contain faces that are located where the audience areas in the EASE room
model should be. For these faces, use the INSERT AREA ABOVE FACE function introduced in section
10.1.2 and delete the faces afterwards.

7.2.3 Exporting from Trimble SketchUp Pro

When exporting DWG files from SketchUp Pro a few steps need to be taken in order to ensure that the
import in EASE 5 works smoothly:

1. Itis recommended to run the Solid Inspector plug-in first and resolve any issues.

2. To save a DWG file, select ExPORT > 3D MoDEL from the File menu.

3. Open the DWG/DXF EXPORT OPTIONS window by clicking on the OPTIONS button in the SAVE
DIALOG window.

4. For the AUTOCAD VERSION select the AUTOCAD 2018 setting.
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5. Make sure the option EXPORT > FACES is selected. The other options can be ignored.

Notice that as of SketchUp 2026 exported files in AutoCAD 2010, 2013, or 2018 format make use of
SubD Meshes instead of Polyface Meshes. Importing SubD Meshes is supported only by EASE 5.78 or
higher versions.

DWG/DXF Export options X

AvutoCaD version
AutoCaD 2018 w

Ewport

Faces
[JEdges
[] Constuction geametmy

[] Dimensions

[JText
[] b aterialz

Cancel

Figure 7.10 Recommended settings when exporting a DWG file from SketchUp Pro.

7.2.4 Exporting from AutoDesk Revit

Typical models exported from Revit may not be fully compatible with EASE and therefore need to be
modified before export or after import. If, in the Revit model, walls are represented using volume
objects, i.e., boxes, these have to be replaced by single surfaces in EASE for the statistical calculations
to be correct. For the statistical calculations according to Eyring/Sabine there can be only a single
volume which must be the volume of the room. The faces of the room model determine its boundaries.

However, AURA and raytracing calculations are concerned only with the surfaces themselves and do
not have to make any assumptions about the room volume. Nonetheless, care has to be taken when
setting up AURA calculations as the suggested default parameter values for the number of particles
etc. are based on statistical assumptions.

For a clean model, it is therefore recommended to export from Revit only the inside surfaces of a room.
One way to facilitate this is to assign the inside elements (wall finish faces) of a room to a so-called
space in Revit.

7.3 Entering and Modifying Surfaces

In this section we will outline how faces can be created in order to build the room model. It will be also
detailed how faces can be modified in order to adapt or extend the room model. These functions are
accessed mainly through the SURFACES ribbon menu.

% :"\, + s
L A E Eﬁﬁ
Selection Polygon  Polygon  Add Back Edit Join Subtract Face Invert Invert All
v in Face - Side Vertices Faces Faces Face Faces

Insert Modify Extrude Orientation

Figure 7.11 The Surfaces ribbon menu provides access to functions for adding and modifying faces.
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Please refer to chapter 11 for more general tools that allow, e.g., moving a face as a whole or
duplicating it.

For more details on the following contents please also see the tutorial videos by AFMG.

7.3.1 Inserting a Face

In EASE 5 the main function for creating new faces is the SURFACES > INSERT > POLYGON tool. Click on
the menu button to activate the mode. After that, you can draw a new face vertex by vertex. The
location of each point can be defined using the various means detailed in section 6.3.

If there are no 3D DWG files available, it is practical for most projects to start by drawing the floor faces
of the room. If you have an image of the floor plan loaded you may just trace the lines by left-clicking
and inserting vertices at the respective points of the drawing.

Creating a Floor Face

As an example, the following sequence has been applied to insert the rectangular floor face shown in
Figure 7.12.

1. Left-click on the drawing to insert the first point A.

2. Move the mouse to snap to the first point A and press X to activate the x-axis constraint. Now
move the mouse to the upper right to the location of the second point B and left-click to insert
the point at the right distance.

3. Move the mouse to snap to the second point B and press Y to activate the y-axis constraint.
Now move the mouse to the lower right to the location of the third point C and left-click to
insert the point at the right distance.

4. Move the mouse to snap to the third point C and press X again to activate the x-axis constraint.
Now move the mouse to snap to the first point A and left-click to insert the point D at the same
x-coordinate as the first point A.

5. Press Cto close the polygon.

If you have activated the wrong axis constraint or used the wrong position for a point, press U to undo
the last step.

=,

e A . s

Figure 7.12 Simple insert sequence for a polygon (see text).
Creating a Slanted Floor Face

As a second example we will enter the slanted floor face as well:

1. Move the mouse to snap to the previously inserted point D. Left-click to insert a point at the
same location.

2. Move the mouse to snap to the previously inserted point C. Left-click to insert a point at the
same location.
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3. Move the mouse to the back of the room, find the corner point E with the mouse and press Z
to activate the z-axis constraint. Now move the mouse up and hover over the section drawing
at the right height to project onto the vertical line. Left-click to insert the third point E at the
selected height.

4. Press Shift+Z to activate the z-plane constraint based on the previously inserted point E. Move
the mouse to the lower left until you reach the other back corner F. Hover over the floor plan
to select the right distance. Left-click to insert the fourth point F.

5. Press Cto close the polygon.

Al

3D View X | Acoustic Parameters

4

E—
| 30 View X | Acoustic Parameters

" 13.84 | -15.70 | e.e0 [a] 15.01 | -19.98 | 4.99 [m]
Length: 21,1 m P

Length: 16.16 m |
3D View X | Acoustic Parameters - 3D View X | Acoustic Parameters

15.68 | -15.98 | 5.61 [m]

26.6a | -21.08 | 16.26 [m]

Length: 38.82 m

Figure 7.13 Insert sequence for slanted floor face (see text).
Note that when the z-plane constraint was activated, the movement of the insert cross was restricted
to aline. That is because after the third point was defined, also the automatic plane constraint is active

that enforces all subsequently defined points to be in the same plane. The combination of these two
plane constraints is a line.

Creating a Side Wall

Whenever an axis constraint is activated, one can also type the corresponding distance in the control
bar instead of selecting it with the mouse. We will do that now in the last example where the side wall
is drawn.
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1. Move the mouse to snap to the previously inserted point B. Left-click to insert a point at the
same location.

2. Move the mouse to snap to the previously inserted point C. Left-click to insert a point at the
same location.

3. Move the mouse to snap to the second point C and press Z to activate the z-axis constraint.
Now enter (type) the height of 16.67 m in the control bar and press Return to confirm. This
will insert point G.

4. Move the mouse to snap to the third point G and press Y to activate the y-axis constraint. Now
move the mouse to snap to the first point B and left-click to insert the point H at the same y-
coordinate as the first point B and at the same height as point G.

5. Press C to close the polygon.

3D View X | Acoustic Parameters ¥ 3D View X | Acoustic Parameters ¥
L4 H -
Tl
v, T | .
@ -~ G
B B. }
[ \ “C
Pl P o
< T~ | & S~ |
~ ~
~ ~
~. ~.
[ o.00 O] \ - 10.02 | T I T~
g & yd ength: 9.58 ) P
Rl ~|  AX[m) &Y [ azimy| 67 [ Rl v AX(ml avimk| 900 8z (m
3D View X | Acoustic Par v
L4

“L P s {
~ y
~ /
~_
‘ 373 | 157 | e.e0 (m] .
Draning

Z

Figure 7.14 Insert sequence for side wall (see text).

Creating an Arc

As part of drawing a new polygon, one or several circular arcs can be created. While inserting new
points, press A to start the arc submode.

In EASE 5, three points constitute an arc:

1. The starting point of the arc. It is automatically set to the last point defined. Drawing an arc
therefore requires at least one point to be defined already before the submode can be
activated.
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2. The end point of the arc (Figure 7.15). This is the first location that has to be chosen after
activating the arc submode. It can be at any 3D coordinates.

3. As alast step, a point must be chosen that is on the arc, also in 3D coordinates (Figure 7.16).
Its position determines the opening angle and the radius of the arc.

While drawing, a preview of the arc is shown. After the end point was set, one can snap to the midpoint
of the connecting line from the starting point to the end point. This can be helpful if the height of the
arc is known.

The number of segments for the arc is determined automatically. The approximate angular resolution
is 15° unless there are fewer segments than eight which is the minimum.

The points that have to be set for the arc follow the same rules that apply to defining points for a
polygon. After a total of three points have been defined, the plane of the polygon is fixed and
subsequent points are constrained to that plane.

A .

[z [z
“5.95 | 14.41 | 8.88 [n] " -
Length: 19.77 m X -4.84 | 26.84 | @.00 [n] %
Chonse arc end point Set 3rd point to complet

Figure 7.15 Setting the end point of the arc after activating  Figure 7.16 Setting the point that is on the arc after the end

the submode. point of the arc was defined.
e A =Y .
A s N
e Y .'{ Ny
.
15,68 | 2.87 | 6.68 [m] 1 u:;z_\ézéﬁv 8.88 [n] [“\'7-
Figure 7.17 Selected face after closing the polygon. Figure 7.18 Creating a polygon with several arcs.

Verifying Coordinates

There are various ways of making sure that the coordinates that were entered are correct. One way to
do so is to use the different view directions in parallel perspective. For example, use PRESENTATION >
PERSPECTIVE > PARALLEL and PRESENTATION > VIEW DIRECTIONS > SIDE (Z) to check the model
against the floor plan. Another possibility is to select each newly created face and inspect the
coordinates in the properties window.
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30 View X | Acoustc Parametors ¥ [properties - Face -0 x| [30View % | Acoustic Paramaters

T
Drawing

Figure 7.19 Top view in parallel perspective. Figure 7.20 Properties of side wall face.

Messages and Suggestions while Drawing

While drawing, certain conditions may prevent from actions or steps that are allowed otherwise. In
that case the software will notify you either by a note in the status text or by an error message shown
temporarily in the lower right area of the 3D view.

A Point could not be added X

Please avoid crossing lines or clicking
on previous points.

-8.48 | -7.24 | @.00 [m]
Length: 63.91 m

Figure 7.21 Error message about crossing lines.
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Please rotate the model to improve the visibility of the insert plane and determine insert points.

Figure 7.22 Suggestion in status text at the bottom of the 3D view.

7.3.2 Inserting a Circular Face

Circular faces can be entered using the SURFACES > INSERT > CIRCLE tool. Click on the dropdown
menu button to activate the mode.

E File Surfaces
I,-_\’
[% g N

Selection Polygon | Polygon Ad

v in Face ~ ¥
iy Insert
|
L0

Properties -} _ ~~
P Polygon
Name: |N
RN
Author: Yo
Circle I}
Notes:

Figure 7.23 Dropdown menu allowing insertion of arbitrary faces and circular faces.
After that, the circle is defined using two distinct steps:

1. Determining the location of the center point by selecting a 3D coordinate using mouse or
control bar.

2. Determining the circumference of the circle by selecting a point that is on the circle in 3D
coordinates or by entering the radius of the circle (Figure 7.24).

Both coordinates can be defined using the various means detailed in section 6.3. Notice, however, that
initially the circular face must be horizontal, i.e., co-planar to the Z-plane. Use the TooLS > ROTATE tool
afterwards to turn the circle into another plane, if needed.

Note that the number of segments is set to 24 automatically. This corresponds to an angular resolution
of 15°.
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Figure 7.24 Inserting a circular face: Preview while defining  Figure 7.25 Inserting a circular face: Selected face after
a point on the circumference. insertion.

7.3.3 Inserting a Face in a Face

After the primary geometry of the room model has been defined, additional faces can be inserted in
existing faces in order to model secondary parts of the room. Such parts could be windows or doors in
side walls, absorber panels on side walls, or carpets on the floor.

This insert function can also be used to cut holes into faces by first inserting the new face and then
deleting the face itself. In that case, if created simultaneously with the new face, the hole will remain.
This hole can then be used, for example, as a starting point for drawing pillars that extend from the
floor to the ceiling. A hole in a face can be removed by deleting it in the properties window of the face
(section 5.3).

For EASE 4 users it is important to understand that the holes concept is different from coated faces. In EASE 4,
faces are coated on top of other faces in order to model secondary elements and replace the acoustic material of
a part of the considered surface area. Using that approach the underlying face remains unchanged. In EASE 5,
however, there are no coated faces anymore. Instead, faces can have holes that can be filled with faces in turn.
These inserted faces can have different acoustic materials. Acoustically speaking both concepts are equivalent.
When importing EASE 4 projects, all coated faces are automatically converted to holes with filling faces.

In the following we will distinguish between the so-called base face and the insert face. The base face
is the face in which the new face is inserted. The insert face is the new face that is created as a cut-out.

In order to start drawing, the base face must be selected first. After that, activate the POLYGON IN FACE
mode from the SURFACES > INSERT ribbon menu. If you wish to insert a circular face, activate the
CIRCLE IN FACE mode from the SURFACES > INSERT ribbon menu.
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Figure 7.26 Inserting a circle in a face.

For drawing an insert face the same toolset is available as for creating a regular face as described in
sections 7.3.1 and 7.3.2. However, a few exceptions apply:

e The insert face must be in the same plane as the base face. That is why from the beginning a
plane constraint is active that enforces that all new points are placed in the plane of the base
face.

e One can snap to the edges of the base face or to the edges of other holes inside the base face
in order to create a vertex.

Note that EASE 5 allows extending the insert face beyond the boundaries of the base face. In that case,
only the part inside of the boundaries will be cut from the base face. If you want to make sure you are
not exceeding the boundaries of the base face, use the snapping functions to place points on the edges
of the base face.

If an insert face is not needed anymore, there are two ways to remove it. One can delete the face itself
as well as the corresponding hole from the base face (section 5.3). Alternatively, the two faces can be
combined again using the JOIN FACES command from the SURFACES ribbon menu (section 7.3.8).

In general, EASE 5 supports and enforces planar faces. But room models can be imported also from
DWG files or EASE 4 projects. In these cases, the selected base face might not be exactly planar. If so,
an insert face created with this mode is created on the mean (average) plane of the base face. As a
consequence, the insert face will be planar. Notice that although the outer border of the base face is
maintained, the original, non-planar 3D shape of the internal surface area of the base face is adapted
so that its surface connects tightly to the outline of the planar insert face.
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Figure 7.27 Drawing an absorber panel on the back wall. Left: first two points set. Right: Insert face completed.
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7.3.4 Creating a Two-Fold Configuration

Faces are normally used to model the outer boundaries of the acoustic volume, such as the side walls.
Very thin surface elements that are inside the room and basically have two acoustically active sides,
such as parapets, reflectors, or dividing walls, can be modeled, as well. In EASE 5 these are represented
by two faces that are positioned very close to each other and that point away from each other. Each
face can have its own acoustic material assigned, thus allowing to model the front side and the back
side independently.

| a3 rase | 1es
‘‘‘‘‘

Figure 7.28 Inserting a reflector by drawing the first face and adding a back side to it.

In order to create a two-fold configuration, first insert a face in the room that has the right place and
location. After that there are two ways to proceed:

1. Assuming that no faces are selected, activate the SURFACES > ADD BACK SIDE mouse mode.
Then click on the face inserted previously. This will create the counter face and assign the same
acoustic material to it. The mode will remain active until Esc is pressed or another mode is
selected so that multiple back sides can be added if necessary.

2. Select the face inserted previously. Then click on the SURFACES > ADD BACK SIDE menu button.
This will immediately create the counter face and assign the same acoustic material to it. This
function can be applied also to multiple selected faces at the same time. The number of
affected faces is displayed as a small number symbol on the ribbon button. After creation, the
new counter faces are selected automatically.

If the GEOMETRY ANALYSIS > STACKED FACES presentation mode is enabled, the two faces will be colored
light green.

7.3.5 Moving the Vertices of a Face and Adding New Vertices to a Face

A face can be modified with respect to its shape by moving its vertices. Also, vertices can be added to
the border of a face in order to subsequently move them or to snap to them when placing other room
elements. For that, the face has to be selected first. After that, the EDIT VERTICES mode can be
activated by clicking on the corresponding button in the SURFACES > MODIFY menu.

In order to add a new vertex, left-click at the desired location on an edge of the face. A filled pink circle
with a plus symbol indicates the position of the vertex to be inserted. It will automatically snap to the
closest edge nearby.

In order to move the vertex of a face, the vertex has to be selected by a left-click. When moving the
mouse close to any vertex of the selected face, a filled pink circle with a symbol that shows arrows in
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all directions will highlight the snapped vertex. Note that when snapping to a vertex that cannot be
used in this mode, a symbol with a red cross is shown.

After selecting it, the vertex can be placed at a new position either by mouse or by control bar. For this
step all of the functions can be used that are generally available for defining 3D coordinates as
described in section 6.3. The following exceptions apply:

e The selected vertex can be moved only in the plane of the selected face. A plane constraint is
automatically active when the mode is started.

e The vertex cannot be moved to a position where the connecting lines to its two neighbor points
intersect with one of the other edges of the face.

e [fthe vertexis placed on another vertex of the face, these two vertices will be merged and the
area of the face will be reduced accordingly. In this way a face can even be cut in half. Similarly,
when placing the vertex on a non-adjacent edge of the face, any vertices on the border
between the original vertex location and the new one will be removed from the face.

e [f the face is not plane, the vertex will be placed on the average plane of the face.

The location of vertices can be verified in the properties window of the face (section 5.3). Vertices can
also be deleted in the properties window.

Figure 7.29 Raising the roof ridge. Left: select vertex to be moved. Right: move vertex vertically.

7.3.6 Extruding Faces

After the floor faces have been drawn it is mostly quite easy to build the side walls. This can be done
using the SURFACES > EXTRUDE > FACE function. Given a selected face (base face), the extrude function
creates a counter face of the same shape opposite to the base face and connects the two faces by
guadrangular side faces. The distance and angle of the extrusion can be chosen freely.

To extrude a face, first select the base face. After starting the mode, an anchor point for the extrusion
has to be selected. It can be located on the base face or somewhere else. Finally, the target 3D position
must be determined, for example, by projecting or snapping with the mouse or by typing the height in
the control bar (section 6.3). These 3D coordinates determine the position of the counter face in
reference to the selected anchor point of the base face.

79



EASE 5 Third Edition — User’s Guide

Defining the Geometry

3D View X | Acoustic Parameters v 3D View X | Acoustic Parameters i
= — = B —
—— — — L T -
; = — . f T T
P ~ - ~ |
_ : 1 - | o5 -
- 10 g 20g ]
1 1
= /
M /“ /
— " w |/
|-
Y
1 1 E— e
=
Tiew 10.20 | 0.22 | 16.67 [n]
Disi : ©.00 | 2.20 | 16.67 [m] -
- e: 16,67 n

Figure 7.30 Extruding the floor face. Left: select ﬂ;ce to be extruded and anchor point. Right: extrude to giver; height by
projecting from drawing.

Note that as a default an axis constraint is active if the base face is located in the XY-, YZ-, or XZ-plane.
This will allow you to enter the distance for the extrusion immediately. If you do not wish to extrude
perpendicular to the base face, press U to deactivate the constraint.

If the base face is not located in one of the main planes, the current mouse location will be used. If the
mouse is over an empty area of the 3D view, the Z value of the target point will be assumed to be zero.
In this case the extruded body may look distorted. It may even not be visible at all if the base face is in
the z-plane, as well.

7.3.7 Inverting the Orientation of a Face

In EASE, faces have an acoustically active side and an inactive side (section 5.3). While building the
room and drawing new faces, EASE 5 will try to detect in which direction a face should point but this
may not always result in the correct orientation. Also, imported rooms may have faces with the wrong
orientation.

The INVERT FACE button from the SURFACES > ORIENTATION ribbon menu allows changing the
orientation of individual faces in the following ways:

1. If no face is selected when the button is clicked, it will activate a mouse mode. In this mouse
mode, clicking on a face will invert its orientation. The mode remains activated to allow
inverting several faces in a row.

2. If one or multiple faces are selected, clicking the button will flip all of the selected faces
immediately. The number of selected faces is displayed as a small number symbol on the
ribbon button.

In addition to that, the INVERT ALL FACES menu command in the SURFACES > ORIENTATION ribbon
menu will flip all faces in the project at once.
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Figure 7.31 Inverting a wrongly oriented face using the Invert Face mouse mode. Left: before invert. Right: after invert. Notice
that the thick border line has changed to a thin border line indicating that the face is now aiming correctly into the room.

7.3.8 Joining Faces

If there are faces that are adjacent to each other and that are located in the same plane, it can be
useful to combine these faces and merge them. Typical uses cases include a floor or side wall that was
drawn in several pieces that can be joined or cleaning up sets of triangles after importing architectural
drawings. In EASE, the SURFACES > MODIFY > JOIN FACES command can be used for this purpose.

button. This will determine the largest face in the selection and expand it by all other, smaller
Join faces. The assigned material and selection set as well as the orientation of the largest face
Faces will be retained.

gﬂ To join several faces into one, first select the faces in questions. Then press the JOIN FACES

If some of the faces are not in the same plane or have a different normal direction, they will be
projected onto the plane of the largest face first and then they will be joined.

7.3.9 Subtracting Faces

Faces can also be cut out from other faces. While the INSERT > POLYGON IN FACE command allows
drawing and cutting a single face from a given face, the MoDIFY > SUBTRACT FACES command allows
cutting one or several existing faces from any adjacent faces. This can be particularly useful, for
example, when a panel or window has been duplicated several times and each new window face still
has to be cut out in the corresponding side wall.

O To use this command, first select all faces that you wish to cut out. Then press the SUBTRACT
J FACES button. EASE will automatically determine any faces that are located close by and

Subtract  remove those parts from them that overlap with any of the selected faces.
Faces

7.4 Geometrical Consistency

After the 3D model of the room has been completed it is recommended to verify the consistency of
the model. Especially when using statistical room acoustics or raytracing methods in EASE, calculations
may provide erroneous results if the room is not closed properly. This is not as important when only
the coverage of the sound system is investigated.

The most important steps are as follows:
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1. Check the room volume using the VOLUME display in the AcousTiC PARAMETERS window (Figure
7.32).
e |f the volume indicator is red, several faces are missing or have the wrong orientation.
e |[f the volume is negative, most of the faces have the wrong orientation.
2. Check for holes in the surface of the room using the PRESENTATION > GEOMETRY ANALYSIS >
HoLE OUTLINES mode (Figure 7.33). Missing parts or inverted faces will be indicated with a red
border.

If faces are missing you will have to draw them (see section 7.3 about inserting faces). If faces have the
wrong orientation, they can be inverted using the SURFACES > ORIENTATION > INVERT FACE command.
See sections 7.3.7 and 5.3 for more information about face orientation.

Note that the calculation modules cannot be opened when the room volume is negative.

3D View Acoustic Parameters X v 3D View X | Acoustic Farsmet ters

Pink Noise 20°C, 60% 992084 m’ | 270896m? 026
00 d8 190 s 180 s |
2 I 180 s | 487 dB (A)
' o dotte 515 d8 (2)
993 dB () 30 Hz
021 a8

1557 [ e [ 207 [m]
Face  375.88 n Oefault, 1068 reflective

Figure 7.32 Room volume and related indicators are red due to Figure 7.33 Hole outlines mode outlines missing or
missing or inverted faces. inverted faces in red.

7.5 Faces Table

All faces that are defined in the project can be viewed in a tabular form. The corresponding window
can be opened using the SURFACES > FACES TABLE or the WINDOWS > FACES TABLE menu command.

The faces table shows the name of the material assigned to each face as well as the surface area of the
face. It also shows whether the face is visible in 3D views or not. Items in the table can be hovered,
selected, sorted and filtered. For more details, please see the general tables overview in section 11.8.
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Figure 7.34 Tabular view of all faces in the project.

8 Determining the Acoustic Properties of the Room

After the geometry of the room is defined, acoustic materials can be assigned to the surfaces to enable
the calculation of room-acoustic quantities. The reverberation time can be computed using statistical
acoustics, and in particular, using the Eyring equation or the Sabine equation (for more advanced
calculations see section 12 and following). If a measured reverberation time is available, the materials
assigned to the room model can be adjusted so that the calculated reverberation time matches the
measured RT. This so-called calibration enables subsequent modifications of the room to show results
that relate more closely to the measured properties of the room.

In the following, first the general material database is introduced. After that, functions related to the
materials in the project are explained. Finally, the reverberation time and the adjustment of materials
to calibrate the modeled room to the measured room are discussed. All of these functions are
necessary only when considering the acoustic properties of a room. Acoustic materials and
reverberation time are not relevant for studies related only to coverage.

8.1 Assigning Materials from the Database

Every face in the project refers to a material that determines its acoustic properties. Use the MATERIALS
part of the SURFACES ribbon menu to select materials from the EASE database and assign them to faces.

Materials Material
in Use Editor

Materials

Figure 8.1 Functions for accessing the material database and assigning materials are available in the Surfaces ribbon menu.

If you click directly in the search field, a drop-down list with many materials will open. To get an initial
overview, close the collapsible area labeled AFMG DATABASE. Then all five subdivisions of the database
will be visible. They are defined as follows:
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e The MATERIALS IN USE database contains all materials that are currently assigned to faces in
the project.

e The GENERIC MATERIALS database contains a small number of designed datasets that each
represent a class of material. This database is read-only.

e The AFMG DATABASE contains a large number of curated materials. It is based on published
datasets from various books, articles, and other sources. This database is also read-only.

e The MANUFACTURER MATERIALS database includes a number of datasets provided by
manufacturers of acoustic materials to be shipped with EASE. The manufacturer name is
automatically added as a search tag. This database is also read-only.

e The CusToM DATABASE can be equipped by the user. To add your own materials, a MAT file

needs to be created using the material editor (see chapter 18) and then saved in the folder
C:\Users\Public\Documents\AFMG\EASE\Custom Materials. Upon start of the software, EASE
will load all materials in this folder and provide them for selection in this menu. An additional,
user-defined folder can also be defined as described in section 3.2.1.

Note that the number of materials in each database is shown in parentheses on the right.

b [ (= Materials in Use I} (3) a
Light construction ) Ligh

Seating, light upholstery ight construction

Soft, porous material (drapes, tiles) Seating, heavy upholstery, audience

Generic Materials (Ma Soft, porous material (drapes, tiles)

Absorber (ceiling tiles, wall panels) Generic Materials (1) &
Carpet

Default, 100% reflective Absorber (ceiling tiles, wall panels)

Glass Carpet

Light construction
Massive construction

Default, 100% reflective

Opening, 100% absorbing Glass

Seating, hard
Seating, heavy upholstery, audience

Light construction
Massive construction

Seating, light upholstery

Soft, porous material (drapes, tiles) Opening, 100% absorbing

AFMG Database (2924) & Seating, hard

#1100 Acoustic Foam, Reeves Brothers Inc. Seating, heavy upholstery, audience
#1200 Acoustic Foam, Reeves Brothers Inc. Seating, light upholstery

#2110 Film/ Foam, Reeves Brothers Inc.
#2140 Film/Foam Mat, Reeves Brothers Inc.

Soft, porous material (drapes, tiles)

#2210 Film/Foam Material, Reeves Borthers Inc. AFMG Database (2110) »
#2211 Film/Foam Material, Reeves Borthers Inc.

#3120 Upholstery Mat, Reeves Brothers Inc. Manufacturer Materials 40)w
#3220 Upholstery Mat, Reeves Brothers Inc

#3221 Upholstery Mat, Reeves Brothers Inc Custom Database T

0.75" wall panel, fabric wrapped 7 pef fiberglass, type A

1.5" wall panel, fabric wrapped 7 pef fiberglass, type A
1" wall panel, fabric wrapped 7 pcf fiberglass, type A
1" wall panel, polyester fabric bonded to 7 pcf fiberglass

1" wall panel, vinyl covered 7 pcf fiberglass, type A
1/2" gypsum board celling
1/2" gypsum board on each side, 3-5/8" studs

1/2" gypsum board on each side, 3-5/8" studs + fiberglass
1/4" pegboard, 1/4” dia.holes 1" o.c, over 1" fiberglass, 3 pcf
1/4" pegboard, 1/4" dia.holes 1" o.c,, over 2" fiberglass, 3 pef
1/4"pegboard, 1/4" dia. holes 1" o.c., over 4" fiberglass, 3 pcf

Figure 8.2 EASE material database. Left: full view. Right: collapsed subdivisions.

Hover over any of the material entries in the list to see more information about the dataset.
the following items:

e Name of the material at the top.

e Curve of the absorption spectrum, average absorption coefficient in the upper right.
e Curve of the scattering spectrum, if available.

e SEARCH TAGS that can be used for searching the material in a database.

e Description of the material’s properties and structure.

e The REFERENCE field indicating the origin of the data.

It shows

This display is very similar to the information shown in the MATERIALS IN USE window that was

introduced in section 5.4 and that will be further discussed in section 8.2.
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Carpet Seating, heavy upholstery, audience - with scattering

Avg. Abs.: 0.27 Avg. Abs.: 0.65
1.00

0.60

Coefficient
Coefficient

0.40

0.20 -~

0.00

35 &3 125 0 s00 1 % Ak 8k 16k 315 63 125 250 500 1k 2k 4k 8k 16k

F H
requency [Hz] Frequency [Hz]

® Absorption * Scattering (no data defined) * Absorption ® Scattering

Search Tags: None Search Tags: None

Carpet, any kind en hard ground Medium to heavy upholstered chairs, seated audience on any seating type

Reference: Standard material created by AFMG with estimated scattering.

Figure 8.3 Information window showing details about the hovered material (see text). Left: Standard material by AFMG. Right:
Standard material by AFMG with scattering information added.

Note that currently the database is largely limited to the frequency range of 100 Hz to 10 kHz.
Coefficients outside of the defined frequency range are extrapolated automatically and indicated by a
shaded background as shown in Figure 8.3. The data of all frequency bands can be adjusted as needed
after assigning the material to surfaces in the room (section 8.2).

In some cases, it can also be useful to modify an acoustic material from the database before applying
it in a project. For this purpose, materials can be exported and saved to a file. This file is stored in
AFMG’s MAT format and can subsequently be updated using the material editor or it can be loaded

into another AFMG software. To export a material, click on the =1/ save icon that is displayed for the
list entry that the mouse is currently hovering over.

When using the database, it is practical to enter a search text like “carpet”. The drop-down list will
then contain only the matches for the search.

At this point there are two ways to assign a new material to one or several faces.

1. If there are no faces currently selected when you choose an item from the list, the drop-down

will be removed and the mouse cursor will change to a paint bucket. In this mouse mode,
materials can be assigned to faces by selecting the faces in the 3D view (Figure 8.4). Note that
when hovering over a face the status text will show the previous material and the new
material.
You can also replace a material that is currently used in the project by the selected material.
To that end, left-click on the corresponding tile in the MATERIALS IN UsSE window (Figure 8.5).
To learn more about the MATERIALS IN USE window please refer to section 8.2 about materials
used in the project.

2. |If faces have been selected already, the currently selected list item in the drop-down list will
show a number symbol that indicates the number of faces that would be affected. Clicking on
the list item will immediately change the material assigned to all selected faces to the new
material.
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Current: Light construction
New: Carpet

Figure 8.4 Replacing the material assigned to a face. The status text in the lower left shows the current material as well as the
new one.

Materials in Use

555 == @ '253

Light construction Seating, heavy upholst... E W osof, porous material (d... |
713 % 16.7 % 11.9 %
2 195.86 m* ‘a 51539 m? 366.64 m*

Replace Material
New: Carpet

Figure 8.5 Replacing a material in the Materials in Use window. The status text shows the new material that will replace the
current one for all faces that use it.

Notice that the default material in EASE 5 is labelled DEFAULT, 100% REFLECTIVE and you will find itin
the GENERIC MATERIALS list. It is automatically assigned to new faces.

Materials in EASE 5 can also carry information about the scattering coefficient. Additionally, there are
several default settings available in the RooM MAPPING module as well as a user-defined setting that can
be used globally for the project. The so-called S-curve is a good starting point for most projects.

The properties of a material that is assigned to a face can be viewed and changed in the MATERIALS IN
Use window as well as using the PROPERTIES window (section 8.2).

8.2 Materials in the Project

After a material from the database was assigned to one or multiple faces in the project it is considered
part of the project. The information about the material is stored along with the project so that the
project can be opened and used again at any later point of time and regardless of the state of the
global database.

In addition to assigning materials to faces it is also possible to modify these materials in the context of
the project. A modified material is not stored in the global database but saved only with the project. It
can, however, be saved manually for import into the database or use in other projects.
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Materials assigned to faces of the project can be viewed in the MATERIALS IN USE window. When
selecting a material in EASE, its data is shown also in the PROPERTIES window. Both windows can be
used to modify the material. Its name can be changed, its description can be extended, and its
absorption coefficients can be adjusted. All of these changes are applied only within the context of the
project.

8.2.1 Materials in Use
The MATERIALS IN USE window can be accessed through the SURFACES ribbon menu.

By default, the window shows a view with a number of tiles. Each tile represents a material in the
project that was assigned to at least one face. The tile shows the name of the material as well as the
surface area that it covers, relative to the total in percent and absolute in square meters or square
feet. The background of the tile indicates the absorption spectrum in a light gray.

When hovering over a tile, faces with the same material will be highlighted in other windows such as
the 3D view. Vice versa, when hovering over a face in the 3D view, the tile that corresponds to the
material assigned to the face is highlighted. Note that you can also select a tile to make the visualization
of associated faces permanent. Selecting a material will switch the PROPERTIES window to show the
properties of that material.

4

Properties - Project v B X||3DView X ‘ Acoustic Parameters

Name: |Auditorium
Author: | AFMG

Notes: ‘

Example project by AFMG.
Version 6. - ~ ‘

Materials in Use >~ aXx
con == |
g8 = i@ E
Light construction Seating, heavy upholst.. & B Soft, porous material d.. M
713 % 16.7 % 11.9 %

2195.86 m? 51539 m? 366.64 m?
IS i

X 1

Figure 8.6 Materials that are used in the project. The Seating material tile is highlighted as well as the faces in the 3D view to
which the material is assigned.

The R selection button that is shown in the caption of the hovered tile can be used to select all faces
with the respective material.

The color button in the upper right of the tile can be used to open a dialog window that allows selecting
the color for the material. This color is black by default and is stored along with the project information.
The color is applied when rendering surfaces and can be used to illustrate the location of acoustic
materials or to show the room in a way that is visually close to the real room. To activate the material

87



EASE 5 Third Edition — User’s Guide Determining the Acoustic Properties of the Room

colors either select SOLID and MATERIAL COLORS as the SURFACE STYLE from the PRESENTATION ribbon or
select MATERIAL COLORS from the DYE menu in the Room MAPPING module.

To see more details for a material, hover over the © information icon of the material tile (Figure 8.7).
This detailed view shows the following information:

e Name of the material at the top.

e Curve of the absorption spectrum in light brown, average absorption coefficient in the upper
right.

e Curve of the scattering spectrum, if defined, in light blue.

e SEARCH TAGS that can be used for searching the material in a database.

e Detailed description of the material’s properties and structure.

e The REFERENCE field indicates the origin of the data.

e The SURFACE AREA covered as well as the EQUIVALENT ABSORPTION AREA.

ing, heavy upholstery, audi - with scattering
Avg. Abs.: 0.65
1.00
0.80
o

o P
£ 060 -
]
&
T
S o040

0.20

0.00

315 63 125 250 500 1k 2k 4k 8k 16k

Frequency [Hz]
© Absorption ® Scattering

Search Tags: None

Medium to heavy upholstered chairs, seated audience on any seating type

with estimated scattering.

Surface Area: 51539m?* 167 %
Equivalent Absorption Area: 337.58 m?

Figure 8.7 Details window showing the material properties.

Materials in Use The small toolbar in the upper left of the window provides access to a number
. of functions. The first three buttons toggle between different views; the tiles
Bl == = ‘= view, the tabular view, and the graphical editor.

In the tabular view (Figure 8.8), the same information as described before is shown, but in a different
layout. Additionally, the table shows the absorption coefficients of each material based on an octave-
band average. Similar to the tiles view, hovering over a row of the table will highlight the associated
faces in the 3D view. More details about tables in general are provided in section 11.8.

Materials in Use ax
g8 = = £
Label ~ | Surface Area [m?] Percentage [%)] | Equiv. Abs. Area [m?) Description Absorption | Avg. | 31.5 Hz | 63 Hz | 125 Hz | 250 Hz | 500 Hz | 1 kHz | 2 kHz | 4 kHz | 8 kHz | 16 kHz
Light construction 2 195.86 71.3 237.15 Light construction wall or floar.. N 0.1 015 045 0.15 015 012 008 008 007 007 0.07 -
Seating, heavy uph... 515.39 16.7 337.58 Medium to heavy upholstered... . 0.66 060 0.60 0.60 0.61 065 069 070 070 070 0.70
Soft, porous mater 366.64 19 183.32 Soft, porous materials such as. - 050 030 030 0.30 032 045 059 065 069 070 0.70
3)

Figure 8.8 Tabular view of the materials used in the project and their properties.
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The graphical editor (Figure 8.9) shows the absorption curves of all materials. The legend area on the
right allows hiding individual curves from the graph by deselecting the corresponding checkbox.
Hovering or selecting a legend item corresponds to hovering or selecting a material in the other views
and highlights materials and associated faces accordingly.

Materials in Use T ax
[T =
g8° == s ;\
! [ seating, heavy u
5 [ Soft, porous mat...
o e e e e 3 s G e e ———
T 06 e o8 Y Light construction
2 04 g O o -
2 7 *—o—@ Show Original
———+— o o,
0 Show All
315 3 1 H 0 1k 4k 8k 16k
Frequency [Hz]

Figure 8.9 Graphical editor for absorption curves used with materials in the project. The dark blue curve was modified and the
original data is shown as a dashed line with circle markers that are not filled.

The SHoW ALL item in the legend allows selecting or deselecting all curves for display. The SHow
ORIGINAL item can be switched only when a material is already selected. It toggles the display of the
absorption spectrum of the original database material before it was modified. The curve is shown as a
dashed line and will be covered by the current curve if no modifications were made yet.

In this view, the absorption spectrum can be adjusted directly with the mouse. Drag the marker of a
curve at any frequency to another absorption value to change the course of the curve.

Please note that the curve colors used in the editor are automatically assigned to the materials. These
colors do not correspond to the material colors in the tiles view which are used for rendering.

The fourth button in the toolbar showing a clipboard icon allows copying the table to the Windows
clipboard in order to paste it into other applications such as MS Word or Excel. Note that all of the data
is copied independently from the current configuration of the table.

8.2.2 Properties of a Project Material

The PROPERTIES window for a material is shown when a material is selected in another view or window,
such as the MATERIALS IN USE window. It allows viewing and editing important properties of the
selected material:

e The name of the material can be changed in the LABEL field. Note that the label has to be
unique among materials in the project.

e Right to the LABEL field, the O reset button can be used to undo any modifications to the
material and return it to its original state when it was assigned from the database. Note,
though, that the color assigned to the material is not reset.

e Also in the upper right, hovering over the icon shows the details window described
previously.

e The DESCRIPTION control can be expanded and then provides access to the full text.

e The absorption spectrum is shown in the table at the bottom. The coefficients can be edited
for each frequency.
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Properties - Material v X Properties - Material > ox
Label: Seating, heavy upholstery, audience O = 1e0liiz 060 § [+
200 Hz 0.60 o
Description: | Medium to heavy upholstered chairs, seated audie... ~ Py o ¢
Absorption Coefficients: 315 Hz 0.62 ¢
Frequency Absorption 400 Hz 063 &
25 Hz 060 & 500 Hz 065 %
31.5 Hz 060 % 630 Hz 067 4
40 Hz 060 % 800 Hz 0.68 o
50 Hz 060 % 1 kHz 0.70 o
63 Hz 060 % 1.25 kHz 070 %
80 Hz 060 % 1.6 kHz 070 o
100 Hz 060 % 2 kHz 0.70 o
125 Hz 060 & 25 kHz 070 %
160 Hz 060 % 3.15 kHz 070 %
200 Hz 060 % 4 kHz 070 o
250 Hz 060 % 5 kHz 0.70 o
315 Hz 062 % 6.3 kHz 070 %
400 Hz 063 % 8 kHz 070 o
500 Hz 065 % 10 kHz 070 o
630 Hz 067 & 12.5 kHz 0.70 o
800 Hz 068 % 16 kHz 070 %
1 kHz 070 § 2 20 kHz 070 5 2

Figure 8.10 Material name, description, and absorption values can be edited in the Material Properties window.

8.3 Viewing and Calibrating the Reverberation Time

Open the AcousTIC PARAMETERS window to check the RT for your room in the CALCULATED
REVERBERATION TIME tile. For more details about the ACOUSTIC PARAMETERS window please also refer to
section 5.8.

Properties - Project * I X| 3D View Acoustic Parameters X v
Name: | Auditorium it e Propertes verage Abmorpton Coeh
- . 4 3 2
Author: | AFMG it S | 3077.88 m =
Notes:
Example project by AFMG
Version 6. Glosal £Q Vieasured Reverberation Time Calculated Reverberation Time
0.0 dB 190 s 188 s |
2 1.88 s 48.7 dB (A)
= speakers B 515 dB @)
99.0 dB (A) 28 Hz
1018 dB (Z)
Cakulations

Figure 8.11 Acoustic Parameters window showing the calculated RT (center tile).

If a measured reverberation time is available, it can be used to adjust the materials of the model so
that the calculated reverberation time matches the measured RT. This process is also called calibration.
In EASE, the model’s statistically-based RT can be matched very easily using the ACOUSTIC PARAMETERS
view and the MATERIALS IN USE window.

A typical workflow is illustrated in Figure 8.12. In the upper graph, the given RT measurement is shown
as a light brown curve. The green curve corresponds to the calculated RT. Dragging points of the curve
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in the editor of the MATERIALS IN USE window or changing the value in the PROPERTIES window allows
modifying the material’s absorption spectrum in such a way that the calculated RT approximates the
measured RT within the desired uncertainty.

While database materials are normally based on measurements from professional labs, the acoustic
characteristics of many types of surfaces may change when they are actually applied in a room.
Spacings, fillings, boundary effects, and deviations from the catalogue original may lead to a slightly
different acoustic behavior in practice. For example, by correcting the absorption spectrum toward
higher or lower absorption in the low frequency range one can take into account if the actual spacing
between the primary and secondary structure is different from the published material data.

Properties - Materia * B X| 3D View Acoustic Parameters X hd
Label Seating, heavy upholstery, aud
Description: | Medium to heavy upholstered chai..
Absorption Coefficients:
Frequency Absorption
25 Hz 060 & 5 o
A a
o & Reverberation Time
40 Hz 060 3
50 Hz 060 & i
. a 3.0 Mid-Band (400 Hz - 5 kHz): 1.88 s
63 Hz 060 %
80 Hz 050 & 25 )}/\}O
100 Hz 0.60 § 0—0—0—0—0—0—0—0
= 20
125 Hz 060 4 =
160 Hz 0.50 § = 15
200 Hz pa2 1.0
— 0.5
315 He 062 5
400 Hz 063 5 0.0
500 Hz 065 & 315 63 125 250 500 1k 2k 4k 8k 16k
630 Hz 067 4 Frequency [Hz]
800 Hz 0.68 2
1 kHz 0.70 4
25 kHz 070 4
16 kHz 070 4
2 kHz 070 3
o || Materials in Use B x
25 kHz 070 % =
3.15 kHz o70 &4 ||88° = e =
4 kHz 070 3
5 kHz 070 % - + Seating, heavy u...
G 08 s N
6.3 kHz 070 & = B e e o e s S ] [ saft, porous mat.
2 s
B A = et py [ Light canstruction
8kHz 070 4 5 .
~ z L1
10 kHz 0.70 = 02 il
' hd < S [ show Original
12.5 kHz 070 4 0 O show Al
16 kHz 070 & 315 63 125 250 500 T b 2% 8k 16k
20 kHz 070 % Frequency [Hz]

Figure 8.12 Adjusting the absorption coefficients of a material in order to match the statistically calculated RT with the
measured RT: The top graph shows the measured RT in light brown and the calculated RT in green. The bottom graph shows
the modified absorption curve as a solid line and the original absorption curve as a dashed line. On the left, the material
properties are shown.

The details window (Figure 8.13) shows these adjustments in the same way. The original name
(ORIGINAL LABEL) and reference (ORIGINAL REFERENCE) that provided the basis for the modified
material are displayed along with the current data.

Note that a modified material can be saved to a file in the same way as other materials from the
database. In the materials search list, select the material in question from the MATERIALS IN USE

category and click on the ! save button. When saving the data to the MAT file information about the
original data and references is lost.

91



EASE 5 Third Edition — User’s Guide Setting Up the Sound System

Seating, heavy upholstery, audience - modified

Avg. Abs.: 0.64
1.00
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Frequency [Hz]
Original Absorption ® Absorption * Scattering (no data defined)

Original Label: Seating, heavy uphalstery, audience
Search Tags: None
Medium to heavy upholstered chairs, seated audience on any seating type

Original Reference: Standard material created by AFMG

Figure 8.13 Material details after modifying the absorption curve.

8.4 Noise Level

After the absorption materials and the reverberation time have been defined, you may also want to
define the ambient noise level in the MEASURED NOISE LEVEL tile. It affects all computations that use
the noise floor as input, such as the speech intelligibility figure STI. For more details about the AcousTIc
PARAMETERS window and setting the background noise please refer to section 5.8.

Properties - Project 0 X | 3D View Acoustic Parameters X v
Name: | Auditorium ot Signal i Properties e Surface Average Abscrption Coeficient
P G Pink Noise %O:C 62% 11276.93 m® | 3077.88 m* OKZSU
Notes:

Example project by AFMG.
Version 6. ozl EQ Massured Reverseration Time Cacuared Reverbaraton Time
0.0 dB 190 s 188 s |
2. 1.88 s 48.7 dB (A)
Active Loudspeakers Mi-aerd 515 dB @)
99.0 dB (A) 28 Hz
1018 dB ()

Figure 8.14 Acoustic Parameters window showing the background noise level on the lower right.

9 Setting Up the Sound System

Given that the geometry and the acoustic properties of the room are established, the sound system
can be defined. In this chapter we shall introduce all of the functions and windows related to the
configuration of the sound system in EASE 5. They can be accessed through the LOUDSPEAKERS ribbon
menu.
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g (& @ 5 &= A =,

Selection Import  Download Configurator Processing  Filter Loudspeakers

Blocks Stage Table

Figure 9.1 Loudspeakers ribbon menu.

To add a loudspeaker to the room and position it, first a speaker model has to be selected from the
database (sections 9.1 and 9.2). After that the loudspeaker can be aimed and its basic properties can
be defined (see also section 5.5). The FILTER STAGE can be set up for the loudspeaker (section 9.4) and
loudspeakers can be assigned to PROCESSING BLOCKS (section 9.5) if they share the same signal
processing. Global EQ and gain can be defined for the sound system as a whole as well (section 5.8.6).
Additional settings for all types of loudspeakers, and especially loudspeaker arrays, can be configured
through the CONFIGURATOR window (section 9.7). A configuration can also be loaded from a file using
the CONFIGURATION > LOAD button (section 9.7.4) or copied from one loudspeaker to another
loudspeaker using the Copy and PASTE commands (section 9.7.7). Finally, an overview over all
loudspeakers in the project can be obtained using the LOUDSPEAKERS TABLE (section 9.6). The function
REPLACE SPEAKER MODEL is useful for updating existing loudspeakers (section 9.3).

9.1 Database

In order to insert a new loudspeaker object into the room, a speaker model has to be chosen from the
local EASE database. You may either click directly into the SEARCH FOR SPEAKER MoDEL field or type a
search term such as the model’s name. A drop-down list will be shown accordingly. It is subdivided
into brands and sorted alphabetically. The number of models available for the respective brand is
shown in parentheses on the right-hand side.

I, o>

Line Array
<—_) AFMG
afmg I
AFMG (8) a
Ceiling Lspk A (30 W, 70x70) Manufacturer: AFMG
Ceiling Lspk B (80 W, 100x90) Model: Ceiling Lspk A (30 W, 70x70)
Ceiling Lspk C (30 W, 70x70) Version: 4.00
Line Array Authorization: Yes
Omnidirectional 2.00 Data Accuracy: High
Omnidirectional 1.03 Information:  Imaginary System!
Passive Two-Way 3.00
Passive Two-Way 2.00 Unique ID: FLDQ
Figure 9.2 Database of speaker models using the search filter Figure 9.3 Detailed information about the hovered

“afmg”. speaker model.

Hovering over any of the entries will display a temporary window that contains the following
information about the speaker model:

e The MANUFACTURER is the loudspeaker company that produces the loudspeaker or loudspeaker
system.

e Inthe MoDEL field the official name of the speaker model is shown.

e The VERSION indicates the version of the dataset. There may be several versions for the same
model in the database. It is recommended to use the model with the highest version number.
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e The AUTHORIZATION states whether the dataset was authorized by the loudspeaker company
for the given brand name. If the data file was created by someone else it will show as not
authorized.

e The DATA ACCURACY property is related to how and which measurements were taken. If the
underlying data was defined in high resolution, it will show HIGH. This means for example, that
instead of coarse measurements using 1/1 octave or 1/3™ octave band resolutions impulse
response data were measured and included in the data file.

e The INFORMATION field shows further details about the speaker model as provided by the
loudspeaker manufacturer.

e The UNIQUE ID is atechnical property related to the underlying GLL data file. It can be used to
distinguish between datasets that look the same but contain different data.

When hovering over an entry a ! trash bin symbol will be shown, as well. It can be used to delete the
speaker model from the database. Note that you cannot remove the AFMG example speaker models
(listed below). Note also that loading a project file will always import all speaker models included in
the project into the local database. For this reason, speaker models that may have been removed
before can appear again.

If you cannot find the loudspeaker brands or models that you wish to use, please visit the AFMG
website for the latest downloads (SPEAKER MODELS > DOWNLOAD menu item) or contact the respective
manufacturer. If you have loudspeaker GLL files already available, use the SPEAKER MODELS > IMPORT
menu command to load them into the local database.

EASE 5 ships with a number of example speaker models created by AFMG.

e The OMNIDIRECTIONAL model has a spherical radiation characteristic. It is the default for
inserting new loudspeakers. It is also used as a fallback when projects with invalid speaker
models are imported in EASE 5.

e The LINE ARRAY model is a two-way mechanical line array with real-world data.

e The PASSIVE Two-WAY is a simple loudspeaker model with a horn and a woofer that is based
on actual measurements, as well.

e There are three ceiling loudspeakers included as well: CEILING Lspk A, CEILING LsPk B and
CEILING Lspk C.

There are two typical situations where speaker models have to be selected from the EASE database:
when inserting new loudspeakers using the INSERT LOUDSPEAKER menu function and when replacing
the speaker model of existing loudspeakers using the REPLACE SPEAKER MODEL menu function. These
functions will be explained in the following sections. In any case, for both functions a speaker model
must be selected from the database.

On the one hand, the speaker model can be selected from the drop-down list that is displayed when
using the search field as explained above. On the other hand, in the section above the search field, one
or multiple tiles are displayed (Figure 9.4). These tiles represent the speaker models that are currently
in use in the project. There is also one tile that corresponds to the speaker model that was selected
from the database most recently.

Click on one of the tiles to select a speaker model for inserting new loudspeakers or updating existing
loudspeakers. If the tile was already selected before, clicking on it again will lock the speaker model
and the selected mode for multiple actionsin a row, i.e., for inserting or updating several loudspeakers.
This is indicated by a black border. The mouse mode can be canceled by pressing the Esc key or by
activating the default mouse mode using LOUDSPEAKERS > SELECTION.
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Omnidirectional  Passive Two-Way
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Figure 9.4 Tiles displayed above the search field show the speaker models in the project as well as the currently selected model
if not in the project. The Omnidirectional speaker model is currently selected for insert or replace.

9.2 Inserting and Aiming Loudspeakers

To create a new loudspeaker and to position it in the room, first click on the % insert loudspeaker
button to determine the mode of action, then select the desired speaker model from the drop-down

list or tiles display. The mouse cursor will change accordingly to show the 4 insert cross and a
preview of the new loudspeaker is shown.

After that, left-click in the 3D view to insert the new loudspeaker at any location or use the control bar
to enter its position. In fact, you may use all tools available for determining 3D coordinates as described
in section 6.3, such as snapping, constraints, and projection.

[Insert Line array at -0.65 | 5.05 | 11.33 [m] | Insert ceiling Lspk A (38 W, 78x70) at 9.80 | 6.27 | 1.67 [m]

Figure 9.5 Inserting a line arrray usir;g the z-axis constraint Figure 9.6 Inserting a loudspeaker on a face.
and projection from a drawing.

There is an additional function especially for loudspeakers that makes it easier to position loudspeakers
that are mounted on side walls or ceilings. In order to make use of it, activate face snapping using the
shortcut F2. Now you can hover over a face, select it by left click and as a result the loudspeaker will
be inserted at the position of the mouse cursor. It will be placed in front of the face at a distance of 0.2
m and aimed in the direction of the surface normal of the face, i.e., the direction perpendicular to the
surface (Figure 9.6).

After the loudspeaker was inserted, its properties can be verified in the properties window (section
5.5). Most often, after choosing the position, the aiming direction has to be set. Note that for a hovered
or selected loudspeaker an aiming line is shown. Use the ORIENTATION fields in the properties window
to change the aiming angles:

e Type the angles you wish to use in the respective fields.

r
e Use the ¥ spinner buttons on the right to increment or decrement the respective angle.
e Use the mouse wheel while hovering over the text field to change the aiming angle.

The last method is usually the fasted and most intuitive one when combined with the 3D view.
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9.3 Replacing the Speaker Model

In order to exchange the speaker model of a loudspeaker, switch the mode from inserting loudspeaker
to replacing speaker models by selecting the S replace button.

Now there are two ways to make the change:
1. Assuming that no loudspeakers are selected, choose a new speaker model from the search list

or tiles display. This will activate a mouse mode and the mouse cursor will change to the ‘CQ
symbol accordingly to indicate the mode. When in this mode, hovering over a loudspeaker in
the room model will show its current speaker model as well as the potentially new one in the
status text (Figure 9.7). Left-clicking on the loudspeaker will replace the speaker model. The
mode remains activated to allow switching several loudspeakers in a row.

2. If one or several loudspeakers are already selected, each speaker model tile as well as the
current row in the search list results will display a number symbol that indicates the number
of loudspeakers that will be affected by the change (Figure 9.8). Left-clicking on the tile or on
the list item will then apply the change immediately.

Note that switching the speaker model will retain most of the properties of the loudspeaker but not

all. Properties that are specific to the speaker model, in particular the configuration of a line array, will
be reset to a default.

3D View X | Acoustic Parameters v

| S P
\‘ />< o2 >4
: . < 7
Current: Passive Two-Way [ v //
New: omnidirectional g

Figure 9.7 Replacing the speaker model of a loudspeaker. The status text shows the current speaker model and the new one.

=y
Omnidirectional
AFMG o

Figure 9.8 Speaker model tile with a symbol indicating the number of selected loudspeakers. A click on the tile will switch the
loudspeakers to this speaker model.
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9.4 Loudspeaker Filters

In EASE 5, signal processing can be configured for each loudspeaker. This is done in the FILTER STAGE
window which can be activated through the LOUDSPEAKERS ribbon menu.

By default, the content of the window is arranged as follows:

1.

On the left, there is a vertical area where a library of available filter types is shown. These
filters can be selected and added to the processing.

The center area shows a tiles view that contains the filter elements that are currently defined.
The right area shows a diagram titled FILTER TRANSFER FUNCTION that displays the overall
frequency response of the filter, both level and phase.

Filter Stage - Loudspeaker - Left Sax
A, Fiterstage  [@[B] = Filter Transfer Function
=B 0 180
4 [Gan s8]
—\ A 20 120
Gain [dB]: e
- . . 2 10 3 60
+  Delay s|B|@ = )
=) o %
~+  Delay [ms] 0.000 |4 E i
-10 60
20 120
-30 -180
1 315 63 12 250 500 1k 2k Ak Bk 16k
Frequency [Hz]
| o Level  Phase

Figure 9.9 Initial setup of the Filter Stage window.

The FILTER STAGE, GAIN, and DELAY filter elements are defined by default and cannot be removed.

Clicking on one of the filter types in the library area on the left will add it to the configuration. It can
be removed again by clicking on the trash bin icon in the upper right of the respective tile.

Filter Stage - Loudspeaker - Left A%
N Fiterstage A[@][8] = mHighrass  [5][B] @ Peak [s[elm Filter Transfer Function
. 30 180
/v Gain [s15]l@ Shepe:|Butterworth  » | Shape: | Standard i
_\_ Gain [dB]: 00 %  Frequency [Hz): 125 %  Frequency [Hzl: | 1000 % o 120
- Slope [dB/Oct): | -48 v|  Gain [dB]: 50/4 10 °°
+  Del s|e
N it g AN =
<4 Delay [ms] 0000 7 Q Factor: 5000 % S0 — — o
Ny é | £
Low Pass [s)e|m 10 50
Shape: Butterworth
20 / | 120
Frequency [Hz: 8000 % /
230 -180
Slope [dB/Oct: 24 v 315 63 125 250 500 1k 2 ak 8k 16k
Frequency [Hz)
© Level Phase

Figure 9.10 Filter Stage window after adding a peak filter, a high pass, and a low pass.

The following signal processing blocks or filter types are available:

The FILTER STAGE element allows inverting the polarity, i.e., applying a phase shift of 180° to
the entire set of filters, by using the |2! button. It also allows bypassing the filter stage as a
whole.

The = button opens a submenu that provides access to additional functionality:

o The SAVE FILTER CONFIGURATION command allows saving the filter settings of a filter
stage to a file in XGFB format. This text-based format can be used to exchange data
with other AFMG software, such as EASE Focus or SysTune, as well as to transfer filter
settings between filter stages or EASE projects.

97



EASE 5 Third Edition — User’s Guide Setting Up the Sound System

o The LoaD FILTER CONFIGURATION opens and applies a filter setting from an XGFB file
to the currently selected filter stage.

o The RESET FILTER STAGE command can be used to remove all user-defined filter
settings from the filter stage.

e The GAIN is defined by a broadband gain value in dB. Note that the value is the same as the
gain that can be adjusted in the properties window of the loudspeaker.

e The DELAY is defined by a delay time in ms.

o The PEeAK filter is a parametric filter of order 2 defined by center frequency, gain and Q factor.
Inserting a negative gain will change the filter to a notch filter. The SHAPE parameter allows
choosing between the STANDARD implementation or the SYMMETRIC implementation. For the
latter, the filter curve is symmetric for positive and negative gains.

e TheH1GH Pass filter and the Low Pass filter are standard filters. They can have a BUTTERWORTH,
LINKWITZ-RILEY or BESSEL shape. Their cut-off frequency and their slope can be adjusted. For
BESSEL filters one can also choose the alignment setting.

e TheALL Passfilter can be a BUTTERWORTH, BESSEL, LINKWITZ-RILEY or SALLEN-KEY (active) filter.
The FREQUENCY and the ORDER of the filter can be adjusted as needed. For the BESSEL shape,
the ALIGNMENT can be chosen additionally. For the active filter, the Q FACTOR can be entered.

e The HIGH SHELF and Low SHELF filters are standard, first-order Sallen-Key filters. They can be
adjusted using FREQUENCY and GAIN.

e The FIR / TF filter can be created only by loading XGLC configuration files. It represents a
linearly-spaced filter function in the time domain or in the frequency domain. It is often used
for filter settings of digitally steered columns.

e The 1/3RD OCTAVE and the 1/24TH OCTAVE spectrum filters represent complex-valued filter
transfer functions that are logarithmically spaced and that can be loaded also only from
configuration files. The first is often used for basic equalization curves whereas the latter can
be used for beam-steering filters as it is more memory-efficient than the FIR filter for most
applications.

For each filter element, the S and B buttons on the tile allow switching it to solo mode or to bypass
mode, respectively. Putting a filter element in solo mode deactivates all other filter elements so that
only the selected one has an effect. Putting a filter element in bypass mode deactivates the selected
filter element so that it has no effect.

Use the ¥ spinner buttons to change a particular value quickly or scroll the mouse wheel while hovering
over the text field.

The * eye button on the GAIN and DELAY tiles allows adjusting whether the value is included in the
displayed filter curve. This can be useful to see or hide their effect on the overall filter transfer function.

Note that if the global EQ or a processing block is selected, gain, delay and filter settings for the
selected element are made available in this window, in the same way as for a single loudspeaker.

9.4.1 Loudspeaker Filters in the Calculation

By default, EASE simulations apply the maximum input voltage (MIV) to each loudspeaker in order to
achieve its maximum SPL output. When reducing the input voltage broadband or for a bandwidth, the
SPL generated by the loudspeaker will be reduced as well.

Accordingly, the filter function defined for the loudspeaker is interpreted as relative to the maximum
input voltage of the loudspeaker.
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That means that the gain of the filter frequency response summed over the entire signal processing
chain of the loudspeaker, i.e., global EQ, processing block, and loudspeaker filters, must not exceed 0
dB in any frequency band. If the summed gain for at least one loudspeaker exceeds 0 dB, a
corresponding gain reduction will be applied before conducting any SPL calculations. The gain
reduction that is necessary equals the maximum excess across all loudspeakers. Once determined, the
same amount of reduction is applied to all loudspeakers so that the relative level relationships
between individual loudspeakers in the project are preserved. The gain reduction applied to each
loudspeaker can be viewed in the loudspeakers table (section 9.6) in the HEADROOM column.

Note for EASE 4 users: Comparing with EASE 4, this filter corresponds to the 1/3™ octave band filter in the
loudspeaker properties window of EASE 4.

With respect to the signal processing chain, the filter defined here is applied to all inputs of the
loudspeaker. In case the loudspeaker is of line array or cluster type, the filter is applied to the inputs
of all cabinets.

In more general terms, the model that approximates the loudspeaker drive voltage in EASE works as
follows:

e |tis assumed that each loudspeaker is connected to a virtual amplifier. This amplifier ensures
that the maximum possible input voltage is applied, taking into account the input signal and
any filters defined directly at the inputs of the loudspeaker or internal to the loudspeaker
(section 5.8.5). This function can be thought of as an auto-gain: When positive gains are
applied, the input voltage is reduced, and when negative gains are applied, the input voltage
is increased. The result is called the effective maximum input voltage.

e |ncontrast, filters applied outside of the loudspeaker, i.e., filters that are part of the global EQ,
a processing block, or the loudspeaker filter stage are considered as external to the virtual
amplifier as well. It is assumed that these filters affect the drive level of the virtual amplifier
itself. Applying a negative gain will result in a reduction of the output level. However, applying
a positive gain will apply a gain reduction to all other loudspeakers as described above,
resulting in additional headroom for those loudspeakers.

Note that the MIV for each loudspeaker is specified by its speaker model (GLL) data. According to the
GLL measuring conventions laid out in the User’s Guide of EASE SpeakerLab, the AES2 standard should
be used to determine the MIV. In particular, the MIV represents an RMS value for a pink noise signal.
The SAFETY MARGIN FOR CREST FACTOR setting introduced in section 5.8.5 allows applying an additional
level attenuation to the overall signal processing. This setting can be used if the MIV in the GLL data
has not been measured according to the AES2 standard and the crest factor of the signal is not fully
considered. It can also be used if the signal and thus its crest factor is modified in a way, such as by
high-pass filtering, so that more headroom should be included.

Please note that EASE assumes that the MIV is based on the thermal limit of the loudspeaker. For
example, if a band-pass filter is applied to a loudspeaker, the output SPL will be higher for the
frequencies in the passband than without the filter. The auto-gain function of EASE keeps the
broadband power sum the same for both configurations. MIV values not based on the thermal limit
may therefore lead to wrong calculation results.

9.4.2 Loudspeaker Delays in the Calculation

In EASE, many calculations make use of the propagation time or are derived from it. The total
propagation time from a loudspeaker to a receive location is calculated as the sum of the delays
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assigned to the loudspeaker at the various filter stages and of the time that the sound wave needs to
travel through air (see also section 19.2.7).

For Acousteer real-time simulation this sum includes all filter stages, i.e., global EQ, processing blocks,
loudspeaker, loudspeaker inputs as well as the internal filters of the loudspeaker (see also Figure 9.17).
For technical reasons, the calculation modules do not consider delays assigned to individual
loudspeaker inputs or delays defined by the internal filter settings of a loudspeakers. However, these
are normally very small delay times so that the difference between the two calculation engines is not
a problem in practice. It is noted here for the sake of completeness.

With respect to loudspeakers that are modeled by a set of coherent sound sources, such as multi-way
loudspeakers, line-array-type or cluster-type loudspeakers, it should be noted that EASE always
considers the arrival time of the first sound source as the arrival time representative for the
loudspeaker.

9.4.3 Loudspeaker Filters Imported from EASE 4

When importing projects from EASE 4, the level values of the 1/3™ octave band filters defined for the
loudspeakers will be imported, too. They will appear as read-only filter elements in the filter
configuration. Hover over the tile to see the entire table.

1/3rd Octave 1

Frequency Level [dE]

100 Hz -6.50
125 Hz -4.88

Figure 9.11 1/3rd octave filter block imported from EASE 4.

9.5 Processing Blocks

If the same signal processing is applied to several loudspeakers, EASE 5 offers the possibility to define
a so-called processing block. As an example, a processing block could represent the delay applied to a
line of under-balcony loudspeakers or the gain that aligns the front fills of a sound system to the main
cluster.

In EASE 5, a processing block is an independent entity in the project that provides shared signal
processing functions for all associated (connected) loudspeakers. If assigned to a block, the individual
properties of the included loudspeakers are not affected and can still be modified separately. For
example, if a processing block has a gain setting of -6 dB, that setting will affect the SPL output of the
connected loudspeaker by the specified amount. But the gain settings for the loudspeaker itself, e.g.,
-3 dB, will be considered as well. The total filter gain will be the combination of both gains, in this
example -9 dB.

The easiest way to create a new processing block is to use the CREATE PROCESSING BLOCK command
from the LOUDSPEAKERS ribbon menu. The command creates a new block and assigns the currently
selected loudspeakers to it. If any of these loudspeakers were already connected to a processing block
before, they are moved from that block to the new one.

To configure and delete processing blocks use the PROCESSING BLOCKS window that can be accessed
through the LOUDSPEAKERS ribbon menu. The window (Figure 9.12) has two areas:
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1. The left-hand area shows in a tiles view all the blocks that are defined.
2. The right-hand area shows the loudspeakers that are not assigned to any block.

Procassing Blocks -ax
Unassigned Loudspeakers
‘ I' BL-S |I' BR-S H I' cL-s1 | -
‘uq CR 31 H" DODEC H" Fill HL1 |
RN R
s 5 s

! L g Hest | 2 I( HRS2

[ rrss  |[1g st |[ag Reference |

Figure 9.12 Window to manage processing blocks with no block defined.

In order to create a new block from within the PROCESSING BLOCKS window, drag loudspeakers from
the right to the left. Whenever you drop a loudspeaker in the free area on the left, a new block will be
created. When you drop a loudspeaker over the tile of an existing block, it will be assigned to the block.
To remove a block, click on the trash bin button in the upper right of the respective block.

Processing Blocks - X%
Block 1 Block 2 Unassigned Loudspeakers
OOdB OOdB ||| BL-S H|| BR-S H" cL-s1 |‘
0.000 ms 0.000 ms ||| CR51 H|| DODEC H|| Fill HLY |
1 Loudspeaker 1 Loudspeaker
i s ||' Fill HLZ H 1 FillHRY H 1l Fill HR2 |
||| HL-S3 H 1 HLsS H 1§ HL-s7 |
||| HR-53 H 1{ HR-S5 H 1l HR-57 |
||| Reference H 1 sLs1 H 1 SR-51 |

Figure 9.13 Two processing blocks with two loudspeakers each.

The tile of the block shows the delay and the gain settings of the block as well as the number of
associated loudspeakers. The curve in the background indicates the filter transfer function resulting
from the filter settings of the processing block. The label of the block is displayed in the caption of the
tile. When hovering with the mouse over a block, the ¥ selection button is shown. Clicking on it will
select all loudspeakers that are assigned to the processing block.

In addition to the drag-and-drop commands, the set of loudspeakers assigned to the processing block
can also be changed based on the loudspeakers currently selected in the room model. The related
functions can be accessed by hovering over a block. The # add button assigns all currently selected
loudspeakers to the block and retains already connected loudspeakers. The 5 replace button assigns
all currently selected loudspeakers and removes all loudspeakers that were previously connected to it.

Note that loudspeakers can be assigned to only one block at a time. When assigning loudspeakers to a
processing block, if any of these loudspeakers were already connected to a different processing block
before, they are automatically unassigned from that block. If the block is empty afterwards, it is
automatically removed from the project.

For a systematic overview of all assighnments of loudspeakers to processing blocks, the loudspeakers
table can be helpful as it shows the processing block that each loudspeaker is assigned to (section 9.6).

To configure a processing block, select its corresponding tile by left click. This will switch the properties
window to show the properties of the processing block, i.e., its label and its delay and gain settings.
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Properties - Processing Block - ox
Label: |Block 1
Filter Configuration
Gain [dB]: 00|35
Delay [msk 0.00|%

Figure 9.14 Properties window of a processing block.

In the properties window, enter the name of the block in the LABEL field. Adjust the DELAY and the GAIN
in the corresponding fields as needed. With respect to the filters, the same adjustments and functions
are available as for a single loudspeaker (section 9.4). The corresponding FILTER STAGE window can
be opened through the - filters icon or the WINDOWS > FILTER STAGE ribbon button.

When a block is selected, the right-hand area of the PROCESSING BLOCKS window shows the
loudspeakers that are connected to the block. Remove one from the block by dragging it to the bottom
part of the right area.

Processing Blocks - Ax

0.0 d8 0048 :
0.000 ms 0.000 ms

2 Loudspeakers 1 Loudspeaker

Figure 9.15 Selecting a block shows the connected loudspeakers on the right.

Note that whenever you hover or select a block, the connected loudspeakers will be highlighted in
other windows, such as the 3D view. Whenever you hover or select a loudspeaker somewhere, the
corresponding processing block will be highlighted, as well. This highlighting happens also if multiple
blocks or multiple loudspeakers are selected.

Processing Blocks -
Reference Front Row Row 10 Row 20 Back Row Unassigned Loudspeakers

0.0 dB -8.0 dB -10.0 dB -12.0 dB -140 dB oo |ETEs 5T i
0.000 ms 13.500 ms 40.000 ms 65.000 ms 80.000 ms |.| Fill HL1 H.| Fill HL2 H.q Fill HR1 |

1 Loudspeaker 2 Loudspeakers 2 Loudspeakers 2 Loudspeakers 2 Loudspeak

||| Fill HR2 H 1f sL-st H 1l sR-51 |
Balcony

-15.0 dB ks
90.000 ms

2 Loudspeakers

Figure 9.16 Configuration of several delay lines.

When you select a loudspeaker in the 3D view or in another window, for easier selection, the right-
hand area will show only that loudspeaker if it is not assigned to a block yet.
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Input Signal
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Figure 9.17 Block diagram for an exemplary signal chain with input signal, global EQ, processing blocks and loudspeaker filters.

9.6 Loudspeakers Table

In addition to the 3D view, the loudspeakers defined in the project can be viewed also in a tabular
form. Click on the LOUDSPEAKERS TABLE button in the LOUDSPEAKERS ribbon menu to open the
corresponding window.

Loudspeakers Table *ax
Q
Vis. | Ac

t.|Label = | Speaker Model v "] | Hor. [*] | Rot. ['] I 5] | Total Gain [dB] | Total Delay [ms] | Headroom [dB] | Effective MIV [dBV]
150 90.000 150 2

15.0 90.000 15.0

BR-S
cL-51
CR-51
DODEC
Fill HL1
Fill HL2

20 1300 00 00 .000 - - - 0.0 0,000 0.0 i
20 -1300 0.0 0.0 0.000 00 0.000 00 308
0.0 00 00 0.000 0.0 0.000 00

-70.0 0.0 0.0 0000 - - - 0.0 0.000 0.0

50.0 00 00 0.000 00 0.000 00

606066857

Figure 9.18 Tabular view of the loudspeakers in the project.

The table shows the basic properties of each loudspeaker, such as its visibility (VISs.), its LABEL, its
assigned SPEAKER MODEL, its POSITION and its aiming angles (ORIENTATION). The GAIN and the DELAY as
defined in the filter settings (section 9.4) are included, as well. If the loudspeaker is connected to a
PROCESSING BLOCK, the LABEL, the GAIN and the DELAY of the block are displayed as well.

The table also shows the TOTAL GAIN and the TOTAL DELAY. These are the gain and delay values summed
across the filter stages of global EQ, processing block, and loudspeaker.

The HEADROOM column shows the gain reduction applied to the loudspeaker, see section 9.4.1 for more
details. The EFFECTIVE MIV column displays the drive voltage applied to the loudspeaker, see section
5.8.5 for additional information.

The second column labeled AcT. shows | if the loudspeaker is active with respect to calculations and
O if not. See section 13.2 for more details.
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Hovering over a loudspeaker in the table or selecting it, will highlight the loudspeaker in the 3D view
and vice versa. The same is true for selecting several loudspeakers. This function can be very useful to
better understand the setup of the sound system. More information about using a table in general is
given in section 11.8.

The % clipboard button can be used to copy the content of the table to the clipboard in a formatted
way. It can then be pasted into other applications, such as MS Word or MS Excel for further use like in
a report, for example. Note that all of the data is copied independently from the current configuration
of the table.

9.7 Configuring Line Arrays, Clusters, Loudspeakers and Steerable
Columns

In EASE 5, there are different types of loudspeakers and most of them support additional configuration
functions. These functions are managed through the CONFIGURATOR window, which can be opened from
the LOUDSPEAKERS ribbon or by pressing the CONFIGURATOR button in the PROPERTIES window.

The window looks different for each type of loudspeaker:

- Forline arrays, the CONFIGURATOR window allows defining the mechanical setup, adjusting splay
angles as well as applying filter settings.

- Other loudspeaker arrangements, like horizontal arrays or two-dimensional matrix arrays, are
called clusters in EASE. Clusters have their own version of the CONFIGURATOR window.

- Digitally steered columns are often modeled using proprietary, programmable plug-ins, so-
called DLLs. These plug-ins have a proprietary setup window that can be accessed from the
CONFIGURATOR window.

- For loudspeakers based on conventional speaker models the options provided by the
CONFIGURATOR window are limited to the input configuration and filter settings for the single
box.

All types have in common that the top area displays the label of the loudspeaker object. Except for
proprietary speaker models (DLLs), also a colored rectangle is shown on the right. It indicates warnings
and errors related to the setup of the loudspeaker.

Each of the types above will be described in more detail in the following sections.

9.7.1 Line Arrays

For a line array system, the CONFIGURATOR window consists of two areas in addition to the top area
(Figure 9.19):

1. A tool bar that allows switching between three different views and that provides further
functions.

a. By default, the tuning view is shown. It is represented by the = tab. In this view,
frames and boxes can be chosen as well as splay angles and box gains can be adjusted.

b. The *= tab switches to the schematic view. This view allows selecting frames and
boxes as well but it shows a graphical overview with labels attached to frame and
boxes instead of providing more configuration options.
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c. The [k tab provides access to the input configuration view. In this tabular view, the

f.

input configuration as well as the filter settings for each element of the array can be
selected.
The first button on the right switches between auto-scale mode and manual scaling.

F.

When the . auto-scale icon is shown, the line array drawing will be automatically
updated to fit the view area. This happens a few seconds after a change to the

configuration of the array. When the [<>j icon for manual scaling is shown, the drawing
will not be updated until you click on the button to re-scale. Double-click on the button
to return to the auto-scale mode.

This button is available only for the first two views.

The g* button allows selecting configuration defaults. If presets are provided along
with the speaker model (GLL), these can be selected from the drop-down list that is
shown after clicking the button. In any case, the list offers a default configuration that
is also applied automatically when a new loudspeaker object is created in the room. It

is indicated by the < icon.

0
The A button resets the filter configuration, see section 9.7.4.

2. The bottom area depends on the chosen type of view and provides functions for configuring
the line array in different ways.

The tuning and the schematic view allow assembling the array based on the available types of array
elements. For this purpose, the following functions are provided:

e The ? button toggles the visibility of the library of elements on the right.

e The graphical configuration area on the left shows the system as currently configured.
o The library of elements available for configuring the system, i.e., box types and frames as
defined by the loudspeaker data file is shown on the right.

=B = [0k

Configurator - Line Array

AFMG Line Array (8x) [ ]

X
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B = Nk e
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ing Elements 7
Box Types & Adapters
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Figure 9.19 Layout of configurator window for line arrays: Tuning view (left), schematic view (center), filter configuration view

(right).
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Defining the Structure of the Line Array
To add or remove cabinets from the line array it is helpful to use the schematic view. It shows the

model names of the boxes and of the frame that currently form the array. Click on the *= tab if the
schematic view is not already active.
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2: Passive Box

3: Passive Box
4: Passive Box
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Figure 9.20 Inserting a selected box type using the (+)

symbol.

frame type.

Figure 9.21 Switching the frame by double-clicking on the

A box can be added to the array by selecting the desired type from the right area labelled Box TYPES

& ADAPTERS. After that click on one of the (O] symbols in the drawing in order to insert the box at the
respective position in the array.

Boxes can be removed by selecting them in the line array drawing and pressing the Delete key.

To switch the frame to another type, double-click on the desired frame in the FRAME TYPES area.

Alternatively, select the frame with a single click and click on the ® switch symbol in the drawing.

Note that these functions are available also in the tuning view.

Adjusting Splay Angles and Box Gains

To adjust splay angles and box gains, the tuning view of the line array configurator has to be used. Click

on the = tab if the tuning view is not already visible.
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To change the splay angles between boxes, move the mouse over the corresponding aiming line. A list
with the available splay settings will be shown. Press the left mouse button and drag the mouse to the
new setting in order to change the splay angle.

i
uuuuun!n_u_u_

0

¥ 9°
10° 10°

Figure 9.22 Adjusting the splay angle of a line array box. Left: hovering over an aiming line displays the available options.
Right: drag and drop to change the splay angle.

To change the gain setting for one of the boxes move the mouse over the loudspeaker symbol. A small
pop-up window will be shown that allows muting the box or adjusting the box gain using a slider. Note
that you can also scroll with the mouse wheel to change the gain.
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Figure 9.23 Adjusting the gain of a line array cabinet. Figure 9.24 Fully configured line array.

The volume bar displayed left to each line array cabinet above its aiming line shows the gain setting of
the cabinet.

9.7.2 Clusters

In EASE, clusters are loudspeaker arrays where each element can have an arbitrary location and aiming
direction. They are typically used for representing horizontal arrays and two-dimensional matrix arrays
as well as for other arrangements that don’t fit the requirements for a vertical, mechanical line array.

The CONFIGURATOR window provides two different views to manage the properties of the cluster:

- The schematic view can be accessed using the = tab. It provides a table of all array elements.
For each element, it shows the box type, the label, the relative orientation angles and the
position relative to the insert point of the cluster.

If supported by the definition of the speaker model, this table can be edited by the user and
arbitrary arrangements can be created.
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- The input configuration view can be accessed via the [k tab. It shows a list of all array

O
elements and their respective filter settings (Figure 9.25). The U button can be used to reset
the filter configuration. For more details, please see section 9.7.4.

For most clusters, one or several base setups are available. These represent predefined geometrical
configurations for the array that are provided by the manufacturer and are part of the speaker model.
They do not include any filter settings. In contrast, a preset is derived from a base setup and often also
has a number of filter settings included. Both types of predefined configurations can be accessed using

the §,, button. If allowed by the manufacturer, the USER DEFINED option is available as well. When
selected, the loudspeaker arrangement itself can be modified by the user. In the schematic view,

elements can be added using the % button and deleted using the Del key. By editing the text fields,
their types, positions, and orientations can be changed as needed (Figure 9.26).

3D View X | Acoustic Parameters w | Configurator - Cluster T Ix

L-Acoustics ARCS Il (6x) [ |

= §* @’ ;

1 ARCSIIHF Up Active 2-Way -

L 0~
Input =

2 ARCSIIHF Up Active 2-Way -

7 L 0 ~|ae
Input -

3 ARCSIIHF Up Active 2-Way -

L M][ o]
Input -

4 ARCSIIHFUp Active 2-Way -

L 0 - a8
Input -

5 ARCSIIHFUp Active 2-Way -

L [M][ o]
™ Input -

6 ARCSIIHFUp Active 2-Way -

L 0 v|a
Input -

X

Figure 9.25 Input configuration view showing a predefined base setup with 6 elements.
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4[x2mMp30  ~|[lowertet  |[ 00]4 [ o00]4 [ ool4[ -030/4[ om0|$[ oool4

Figure 9.26 Schematic view showing a user-defined cluster setup, configured as a loudspeaker matrix of 4 elements.
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9.7.3 Single Loudspeakers

For conventional loudspeakers, the CONFIGURATOR window shows only the input configuration view
where filter settings can be adjusted. Presets can be selected as well.

9.7.4 Selecting Input Configurations and Filter Settings

Some speaker models support different input configurations and filter settings, especially line arrays
and clusters. These settings are defined by the manufacturer and can be viewed and adjusted in the

I input configuration view. This tabular view also shows the names of the array elements and their
associated settings, like gains or splay angles.

If multiple input configurations are available for a box type, a drop-down list is shown on the right of
the corresponding row. Expand the row using the * button to view the inputs and the filter settings
available for each input.

Each row of the table can be expanded or collapsed. Use the ¥ and & buttons to expand and collapse
all of them.

Configuration files may also include custom filter settings, such as beam-steering filters from third-

L]
party software. If active, such filters will be indicated by an OVERRIDE label. In this case the U reset
button can be used to return to default filter settings.

The "+ filters button opens the FILTER STAGE window for the selected input. Each input of a
loudspeaker or of an array element can have its own filter settings applied. All of the standard signal
processing elements are available for that purpose (see section 9.4).

Note that unlike the filter settings of the global EQ, processing blocks, and loudspeakers, the input
filters are subject to the auto-gain function in EASE. This function is applied automatically to each
loudspeaker object. It maximizes the input voltage fed into the loudspeaker by considering all inputs
of the loudspeaker, determining the input with the lowest maximum input voltage and choosing the
simulated input voltage for all inputs so that the lowest MIV is matched. This means that decreasing
or increasing the gain of all inputs of a loudspeaker equally has no effect on the calculated output SPL
because it is compensated by the auto-gain.
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Figure 9.27 Different line arrays providing options for input configurations and filter settings.
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Figure 9.28 Different cluster arrangements providing options for input configurations and filter settings.

The input configuration view is available also for conventional loudspeakers. It displays just a single

box.
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Figure 9.29 Different loudspeakers providing options for input configurations and filter settings.
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9.7.5 Loading and Saving Configuration Files
EASE supports text-based file formats that describe the configuration of a sound system.

- Files in XGLC format contain the configuration of a single loudspeaker object. For example, in
case of a line array, the XGLC files stores information about the number of elements, the splay
angles and the box types used.

- Files in XLD format contain general information of the sound system as a group of loudspeaker
objects. The format describes each loudspeaker object by its speaker model, its position and
aiming angles, as well as its delay and a 1/3™ octave-based EQ.

These two file formats complement each other. Both formats can be read by EASE 5 whereas XGLC
files can also be saved for use in other projects or in other software. Further details are discussed in
the following.

Loading a Loudspeaker Configuration

The CONFIGURATION > LOAD menu button can be used to load XGLC loudspeaker setup files for line
arrays, other loudspeaker clusters and single loudspeakers. These files may have been saved by other
software applications, such as AFMG’s EASE Focus software.

Loading a configuration file applies the setup stored in the file to the currently selected loudspeaker
objects. For line arrays, this includes the frame, the number of elements, the box type of each element,
the connecting angle as well as the gain for each element, the input configuration and the filter setting
for each input. For loudspeakers, this includes the settings for input configuration and filters. For
clusters, the configuration file includes the number of elements, the type and the name of each
element as well as the relative location and orientation. It also includes the input configuration and
filter settings for each element.

Like AFMG’s EASE Focus software, EASE 5 supports positive box gains up to +6 dB. A box gain of less
than -60 dB is adjusted to -60 dB and the box is muted.

Note that each XGLC file is linked to a specific GLL-based speaker model. It is not possible to load a
configuration file that does not match the speaker model. A corresponding warning will be shown in
that case. Note also that invalid gains and angles that do not match any of the possible settings are
changed to the nearest valid neighbor.

The CONFIGURATION > LOAD button is enabled only if a single loudspeaker is selected or if multiple
loudspeaker objects are selected and they are based on the same GLL speaker model.

Saving a Loudspeaker Configuration

The CONFIGURATION > SAVE button allows storing the configuration information for the selected
loudspeaker in an XGLC loudspeaker setup file. The menu item is disabled when multiple items are
selected or when the loudspeaker is based on a proprietary speaker model (DLL).

The data that is saved for the loudspeaker is the same as when loading an XGLC file as described before.
That means that the file format can be used to manage loudspeaker configurations independently from
a particular EASE project. It can also be used to transfer data between software solutions, for example,
EASE SpeakerLab allows loading XGLC files as well.

Note that when saving the setup of a line array or cluster, the gain of a box is set to -60 dB if the box is
muted. If a filter block of the input filter stage is set to solo mode, the other filter blocks are exported
as bypassed. Like EASE Focus, EASE 5 may export positive gain values for boxes in a cluster or line array.
These may not be compatible with all target software, and in particular EASE 4.
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Loading a Sound System Configuration

The PROJECT > OPEN and PROJECT > ADD commands from the FILE ribbon menu can be used to import
sound system configurations in the XLD format. After the data was imported, corresponding
loudspeakers are created in the room model at the respective locations. Speaker models are assigned
automatically from the database if available. If a referenced speaker model is not found in the
database, the OMNIDIRECTIONAL default model is assigned. The filter transfer function that is given in
the XLD file in a resolution of 1/3™ octave bands is imported in two steps: The maximum value across
all frequency bands is imported as the broadband gain for the loudspeaker. The spectrum relative to
the maximum value is imported as a 1/3™ octave filter block for the loudspeaker.

One prominent use case for loading XLD files is the transfer of sound system configurations from
AFMG's EASE Focus software as well as from proprietary manufacturer design software such as d&b
ArrayCalc or L-Acoustics SoundVision.

Saving a Sound System Configuration

The sound system can also be stored in XLD format. For this purpose, the PROJECT > SAVE As command
from the FILE ribbon menu can be used.

The text-based file format allows transferring loudspeaker labels, locations, aiming angles, assigned
speaker models, EQ, and delay times to other EASE projects as well as to 3™ party tools such as
Woelfel’s IMMI software for noise immission calculations or design tools for immersive applications
such as Spat Revolution by Flux. Since the output is text-based it can also be used for reports or
documentation purposes.

9.7.6 Configuring Proprietary Speaker Models (DLLSs)

There are a number of loudspeaker systems, mostly digitally steered columns, that are not available
as loudspeaker GLL files but as DLL files because they implement proprietary steering algorithms or
other calculations. For that reason, they have their specific user interface each.

If a loudspeaker is based on this kind of speaker model, the CONFIGURATOR window will show a single
button that allows opening the configuration window provided by the DLL file.

Configurator - Proprietary Speaker Model (DLL) M

Lspk 4

Configuration

Due to technical reasons the configuration dialog may appear in the
background. Please activate it through the Windows task bar.

Figure 9.30 Configurator window for proprietary speaker models.

Click on the button to open the settings window for the DLL speaker model. It will be shown as a modal
dialog which means that the rest of the software cannot be accessed while the window is open. Adjust
and confirm the settings to update the loudspeaker and to return to EASE.

Please note that the proprietary speaker model based on MS Windows DLL files was introduced with
EASE v4 in the year of 2002. While still supported by the calculation modules (section 14), it is not
supported anymore by the new Acousteer real-time engine (section 13) which works exclusively with
GLL-based speaker models.
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9.7.7 Copying Loudspeaker Configurations

The configuration of a loudspeaker consists of many different properties. Especially for larger projects
with many loudspeakers it can be tedious to keep loudspeakers synchronized if they should be using
the same settings. The CopPy and PASTE commands from the LOUDSPEAKERS > CONFIGURATION ribbon
menu can be used to easily copy the configuration from one loudspeaker to one or several others.

To do so, first select the loudspeaker whose properties should be copied and press
5 5 the Copy button. This will store the configuration information in internal memory for

Copy Paste further use. Now select the loudspeakers that should receive the configuration and
M press the PASTE button. You can select another set of loudspeakers and copy the
configuration to those as well.

The small number symbol on the PASTE button shows the number of loudspeakers the configuration
will be copied to.

By default, the following properties are copied:

- Speaker model

- Configuration data as shown in the Configurator window
- Filters applied to the loudspeaker

- Vertical angle

The following properties are not changed:

- Label

- Visibility

- Horizontal and rotational angle

- X, Y, Z coordinates

- Assignments to processing blocks, selection sets etc.

Which properties are copied can be selected in the OPTIONS area for the PASTE command. In addition
to the coordinates (X, Y, Z) and aiming angles (Ver., Hor., Rot.) the configuration of the loudspeaker
and the loudspeaker filters can be included in the copy or they can be excluded from it. The
CONFIGURATION consists of all the data shown in the CONFIGURATOR window, such as the splay angles of
aline array. The FILTER STAGE relates to the filter settings defined in the FILTER STAGE window for the
selected loudspeaker.

&8 @ {7

Import Download  Copy Paste

Options O
" x Ver. et
[y [l Hor.

L[]z [] Rot.

Configuration Filter Stage

Figure 9.31 Paste options for the loudspeaker configuration.
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Note that the configuration stored for pasting is kept in memory even when loading a project or
creating a new project. In this way, existing configurations can be transferred also to other projects if
needed.
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10 Audience Areas and Listener Seats

To create mapping planes and reproduce measurement locations in the room, audience areas can be
inserted as well as listener seats. Please refer to sections 5.6 and 5.7, respectively, for the basic
properties of these two types of items. The functions for inserting and modifying these room items are
located in the RECEIVERS ribbon menu.
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' p— e
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'

]

.'; - == =
k2 "R = S
Selection  Audience Area Above Listener Edit Areas Seats
Area Face Seat Points Table Table

Insert Modify

If you wish to move or copy an audience area or listener seat, please refer to sections 11.2 about
moving objects and 11.3 about duplicating items.

10.1 Audience Areas

10.1.1 Inserting Audience Areas and Modifying Their Shapes

To insert an audience area in the room, activate the INSERT > AUDIENCE AREA mouse mode. Its
functionality is identical to the SURFACES > INSERT > PoOLYGON mode discussed in section 7.3.1. For
more details, please refer to the information provided there.

To change the shape of an audience area, use the MoDIFY > EDIT POINT function. It works very similar
to the SURFACES > MODIFY > EDIT VERTEX mouse mode which is detailed in section 7.3.5.

While moving or deforming of areas is very similar to the respective modes for faces, it should be noted
that the primary element of an audience area is its base plane. When inserting an audience area or
when moving the points of an audience area, the coordinates always refer to the base plane.

Figure 10.1 Modifying the point of an audience area.
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10.1.2 Creating an Audience Area Based on an Existing Face

In many projects, audience areas follow the shape of the room. In this case, they do not have to be
drawn point by point. Use the INSERT > AREA ABOVE FACE mode to create an audience area with a
base plane that is identical to the selected face in shape and position.

There are two ways to do that:

1. Assuming no face is selected, left-click on the AREA ABOVE FACE button to activate the mode.
Then select the face for which an audience area should be created. The mode will remain active
until Esc is pressed or another mode is selected so that multiple areas can be created in a row,
one for each face that is selected.

2. Select one or several faces first. The number of selected faces is displayed as a small number
symbol on the ribbon button. Then left-click on the INSERT > AREA ABOVE FACE menu button
to immediately create an audience area for each one of them. Notice that the newly created
audience areas are selected automatically for further use.

Note that the audience areas created in this manner will have the same number of points and the same
location as the original faces. They will also have holes if the original face has holes.

10.1.3 Setting the Ear Height

After inserting an audience area, make sure that the ear height for mapping calculations is correct.
Selecting the audience area will show its properties in the properties window. The EAR HEIGHT field
can be used to enter the exact height of the listening plane above the base plane. Alternatively, you
may also select a preset from the drop-down list.

4

Properties - Audience Area = I X|[30 View x | Acoustic Parameters

Label: Main Area
Ear Height [m: 20 <
Audience standing (1.70 m)

Audience sitting on chairs (1.20 m)

Area [m’]:

Outer Border: | Aydience kneeling (1.00 m)
Audience sitting on ground (0.80 m)
Head on the ground (0.10 m)
15.00 -20.00 5.00
10.00 000 000

-10.00 0.00 0.00

Figure 10.2 Setting the ear height of the selected audience area.

116



EASE 5 Third Edition — User’s Guide Audience Areas and Listener Seats

10.1.4 Audience Areas Table

In addition to the properties window and the 3D view, audience areas can be viewed also in a table.
The corresponding window can be opened using the RECEIVERS > AREAS TABLE or the WINDOWS > AREAS
TABLE menu command.

In the first column, the audience areas table shows the visibility of each audience area, indicated by
the @ and 2> symbols. The second column labeled AcT. shows | if the audience area is enabled for

calculations and O if not (see section 13.2 for more details about calculations). The remaining columns
display the label of each audience area, its surface area, and its ear height.

The items in the table can be hovered, selected, sorted, and filtered. For more details, please see the
general tables overview in section 11.8.

Audience Areas Table > X
Drag a column header here to group by that column Q
Vis. | Act. | Label ~ | Ear Height [m] | Area [m?]

@ | Balcony Center 1.20 67.97 -
@ | Balconyl 1.20 74.22
@ | BalconyR 1.20 74.22
@ | Floor Center 1.20 90.59
@ | FloorL 1.20 98.94
@ | FloorR 1.20 98.94
(6)

Figure 10.3 Audience areas displayed in the table window along with their labels, visibility and activity statuses, ear heights
and surface areas.

10.2 Listener Seats

10.2.1 Inserting and Modifying Listener Seats

Listener seats can be inserted easily using the INSERT > LISTENER SEAT mode. Activate the mode by

. . . b ¥ B
left-clicking on the menu button. The mouse cursor will change accordingly to show the *'Hﬁ insert
cross and a preview of the new listener seat is shown, as well.

After that, left-click in the 3D view to insert the new listener seat at any location or use the control bar
to enter its position. In fact, you may use all tools available for determining 3D coordinates as described
in section 6.3, such as snapping, constraints, and projection.

There are two additional functions that make it easier to place listener seats at the right locations:

e  When left-clicking on a face the listener seat is automatically inserted 1.2 m above the
face.
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e When left-clicking on an audience area, the listener seat is inserted at the ear height of
the audience area.

Note that snapping to faces and audience areas is automatically enabled in the Insert Listener Seat
mode. Press F2 to switch it off.

Figure 10.4 Inserting listener seats. The seat on the left was inserted by clicking on the audience area at an ear height of 1.7
m. The listener seat on the right was inserted at 1.2 m by clicking on the floor face.

Finally, verify the properties of the inserted listener seat in its properties window. Enter a specific name
in the LABEL field instead of the default name. Check the PoSITION and adjust the ORIENTATION angles
if needed.

~ @ X ||3DView X | Acoustic Parameters v

Position Orientation

X [m]: 002 | % Vertical [°]: 009

Horizontal [*} 1800 |%

<
3

E4RES

PTIIRTS

Rotational [°]: 00|%

L3

Figure 10.5 Add a label and adjust the orientation of the listener seat in its properties window.

10.2.2 Listener Seats Table

Like for audience areas, there is also a table for listener seats. Use the RECEIVERS > SEATS TABLE or
the WINDOWS > SEATS TABLE menu command to open the corresponding window.

The listener seats table shows the label of each listener seat as well as its visibility, its position and its
orientation angles. The items in the table can be hovered, selected, sorted and filtered. For more
details, please see the general tables overview in section 11.8.
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Listener Seats Table

<> Balcony 1 8.05
<&> Balcony2 -145
<&> Balcony 3 -4.55
<> Floor 1 11.86
<@ Floor 2 0.59
<> Floor 3 -5.49

Vis. | Label 4« | X[m] |Y [m]

-13.95
-19.33
-12.99
-15.15
-13.33
-14.43

Z [m] | Ver. [°]
7.99 0.0
8.90 0.0
7.40 0.0
2.85 0.0
1.98 0.0
2.29 0.0

Drag a column header here to group by that column

Hor. [°] | Rot. [°]

180.0
180.0
180.0
180.0
180.0
180.0

Q
0.0 -~
0.0
0.0
0.0
0.0
0.0

(6)

Figure 10.6 The table for listener seats shows the relevant properties: visibility, label, coordinates, and angles.
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11 General Tools

In this chapter, we will introduce a number of general tools that can be applied to any room element.

The MEASURE function from the TooLs ribbon menu was introduced in section 6.3.1. Please refer to this
section for more details.

N 2 @ R T N

Selection  Toggle Show Duplicate Move Rotate X Y Measure Store Selection  Clipboard File

Visibility All Selection Sets
Edit Mirror Grouping Send Picture to...

Figure 11.1 The Tools ribbon menu provides functions applying to all room items or the project in general.

11.1 Hiding Room Items

Items of the room can be made invisible. Hiding some faces of a model can make it easier, for example,
to select and edit inside parts of the room. Hiding some loudspeakers can be useful when working on
different variants of a sound system or parts of the sound system.

In EASE, audience areas, listener seats, loudspeakers, surfaces and section drawings can be switched
invisible. Items set invisible are not shown in the 3D views of the main program, in the Room Mapping
module nor in the Raytracing module. However, they remain accessible by all regular means, such as
through tables or selection sets.

The visibility of a room item can be switched using one of the following commands.

e The TOGGLE VISIBILITY command in the TooLs ribbon hides all currently selected items. This
also applies if some of the selected items are already invisible. However, if all selected items
are hidden already, the command makes them visible again. Note that after hiding the
selected items they are automatically deselected.

e The <@ button in the Properties window can also be used to hide and unhide an item. It affects
only the currently selected item and does not deselect the item after setting it invisible. For
more details, see chapter 5 also.

e The TOGGLE VISIBILITY command from the context menu works in the same way as the
ribbon command described above.

e The SHow ALL command from the TooLs ribbon makes all invisible items visible again. This
function considers all items of the room independent from the current selection.

The table windows can be used to check which items of the room are currently invisible. One can select
items that are currently hidden and set them visible again. A general overview of the tables is given in
section 11.8.

When working with a large number of faces or loudspeakers, it is efficient to first store these items in
a selection set (section 11.6). Selection sets make it easier to reselect the same items than manually
selecting them from a table.

Note that hovered, highlighted, and selected items are always shown in the 3D view, independent
from their visibility setting.
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Faces Table v B X |[3DView X |Acoustic Parameters L
Vis. w Q ‘
Material Area [m¥]
. g E]=
Ceiling - Roof 51938
Ceiling - Roof 519.18
Ceiling - Roof 43.66
Ceiling - Roof 11.14
Ceiling - Roof 11.14
P (205)
Generic, Floor, Tiled, Linoleum, Asphalt, Vinyl 25035
Generic, Cancrete, Smeath Finish 146.03
Generic, Cancrete, Smeath Finish 146.01
UnoccUphPewsArea 14164
UnoccUphPewsArea 14161
Generic, Cancrete, Smeath Finish 12503
Generic, Cancrete, Smeath Finish 2163
Generic, Cancrete, Smeath Finish 71280
Generic, Cancrete, Smeath Finish 7175
Generic, Floor, Tiled, Linoleum, Asphalt, Vinyl 6494
Generic, Concrete, Smooth Finish 5837
Generic, Concrete, Smooth Finish 5837
Generic, Floor, Tiled, Linoleum, Asphalt, Vinyl 5835
Generic, Concrete, Smooth Finish 5297
Perfect Absorber 38.86
Generic, Concrete, Smooth Finish 37.80 -
210)
Faces Table | Properties - Project %]

Figure 11.2 Room model with ceiling faces set invisible (right). The items of the table (left) have been grouped by the visibility
column.

11.2 Move

Room elements, such as faces, loudspeakers, audience areas, and listener seats can be displaced using
the EDIT > Move function. It can be accessed from the TooLs ribbon menu.

Before the mode can be activated, the items to be moved have to be selected first.

After the mode has been activated, the anchor point for the move has to be determined by mouse or
control bar. It can be on one of the selected items or it can be at a user-defined location. The anchor
point is the point that will be moved to the target coordinates. It is indicated by a filled, orange circle.
This circle will be overlaid by the axis cross of the reference point if the two points have the same
location.

Once the anchor point is selected, the target position for the item can be defined using the means
described in section 6.3. All 3D functions are available such as snapping, constraints or projections in
order to determine the new location.

While the move is in progress, a preview of the object at the new position is shown in yellow and the
original object is changed to gray.
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Figure 11.3 Moving a line array relative to its insert point. ~ Figure 11.4 Moving a listener seat relative to its insert point
using an x-axis constraint.

-
R

%

Figure 11.5 Moving a face. Left: selection of anchor point prior to move. Right: moving the face with reference to the anchor
point (orange), in absolute mode.

Note that the reference point for entry of relative coordinates will initially be set to the location of the
anchor point. The reference point can be changed without affecting the anchor point in order to
determine the target location relative to a point that is different from the anchor point.

Figure 11.6 Moving a face based on a selected anchor point (orange, lower left corner) using a y-axis constraint relative to a
reference point (blue, upper right corner of the original face).
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11.3 Duplicate

One or multiple room elements can be copied and inserted at a new location. For this purpose, the
TooLs > EDIT > DUPLICATE menu command is available. It works very similar to the Move function
introduced in the previous section 11.2. There is one major difference, namely that the selected items
remain unchanged at their original place. The copy is moved to the new location.

Note also that the DupPLICATE function allows creating and positioning several copies of the original in
EI 54 a linear array. To that end, select the number of copies you wish to insert in the

control bar on the very right. The direction and spacing of the array are given by
the displacement of the first copy relative to the original, i.e., by the choice of the target coordinates
relative to the selected anchor point.

After the selected have been duplicated, the copies are selected automatically so that, for example, a
new selection set based on the new items can be created easily.

3D View X | Acoustic Parameters ¥
“»
l?
New position: 5.0 | ©.0@ | .08 [m] \\
Displacement: -5.00 | 18.0@ | 8.8@ [m] %
Relative  ~ AX[m):| -500/  AY[m}:| 1000 azim:| o000 o [m 5

Figure 11.7 Creating 5 duplicates at a user-defined spacing.

11.4 Rotate

Parts of the room or the room as a whole can be turned around a user-defined axis. This function is
useful for adjusting reflector angles, aiming loudspeaker arrays, or adjusting the orientation of
imported objects.

To rotate one or multiple items of the room, select them first. After that, the rotation mode can be
activated using the TooLs > ROTATE command from the ribbon menu.

In general, rotating elements consists of three distinct steps:

1. Selecting the rotation axis by specifying two points or 3D coordinates.

2. Selecting an anchor point.

3. Selecting the target location to which the anchor point will be rotated. Alternatively, the
rotation angle can be entered explicitly, such as 90°.
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All of the points above can be determined using the tools generally available for selecting 3D
coordinates when performing other editing actions, such as snapping, manual entry, or inferring
coordinates based on constraints (section 6.3).

After the rotation axis has been defined, a dash-dotted orange line is shown that indicates the location
of the axis. The order in which the two points have been specified for the rotation axis determines the
positive angle for the rotation using the right-hand-rule.

After selecting the anchor point a preview of the rotated room items is shown in yellow as well as an
orange auxiliary circle that indicates all possible locations for the target location of the anchor point.
Should the given target location be outside of the circle it will be projected onto it.

Figure 11.8 Rotating a face counterclockwise around the axis of rotation (dash-dotted line). The positive direction is indicated
by the arrow on the circle. The circle represents the possible new locations of the anchor point.

By default, the control bar at the bottom allows entering the rotation angle relative to the anchor
point. To specify the target location explicitly in relative or absolute coordinates, switch from
ROTATIONAL to RELATIVE or ABSOLUTE mode, respectively.

When using the mouse, the rotation angle can be selected by hovering over the auxiliary circle. The
target cross will automatically snap to points on the circle. These additional snapping points are
available in 5° resolution relative to the anchor point. The currently snapped angle is shown in the
status text. Snapping to points on the circle can be switched off by pressing F3.

11.5 Mirror

Elements of the room can be duplicated and mirrored. The YZ-plane or the XZ-plane can be used as
the mirroring plane. For room models that are wholly or partly symmetrical this allows building the
room much more quickly.

To mirror one or multiple room items, they have to be selected first. Then the MIRROR > X and MIRROR
> Y commands from the TooLs ribbon menu can be used to create the duplicates. When mirroring in
the X-direction, the mirroring plane is located in the YZ-domain at x = 0. When mirroring in the Y-
direction, the mirroring plane is located in the XZ-domain at y = 0.

When mirroring loudspeakers or listener seats their horizontal and rotational angles are mirrored as
well. For faces, the sequence of vertices is inverted and accordingly their acoustic orientation relative
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to the mirroring plane is adjusted. Also, an asterisk is appended to the labels of mirrored loudspeakers,
audience areas, and listener seats.

Notice that after mirroring the mirrored items are selected automatically for any further adjustments.

Figure 11.9 Mirroring room items. Left: Face mirrored in X-direction, at the YZ-plane. Right: Loudspeaker mirrored in Y-
direction, at the XZ-plane.

11.6 Grouping by Selection Sets

Iltems of the room can be stored in selection sets. These selections of items can be recalled later in
order to view them or jointly modify them. This function allows managing large amounts of items
quickly and easily.

For example, a selection set that contains loudspeakers can be restored in order to change the speaker
models assigned to the loudspeakers quickly or to adjust the mounting height of the loudspeakers. A
selection set with faces can be used to switch the acoustic material assigned to this group of faces at
once.

Selection sets can be created using the TOOLS > GROUPING > STORE SELECTION command. If there are
no items selected, the set will be empty. This can be useful, for example, to first create and label a
number of placeholder groups and then fill them later.

Selection sets are managed using the SELECTION SETS window. It can be opened by toggling the
SELECTION SETS button in the TooLs or in the WINDOW ribbon menu.
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]

3D View X EAcoustic Parameters ¥ | Selection Sets v ax
Balcony ) "
‘ Fills (6) v‘
Left Line (5) ~
o LOUDSPEAKERS (5) a
= BL-S SR829K_2Way
e HL-51 SR829K_2Way

HL-S3 SR829K_2Way
HL-S5 SR829K_2Way
HL-S7 SR829K_2Way

! Main Areas 2 v ‘
’ Right Line 5 v ‘
Seats @ v ‘
’ Windows 3 v ‘

Configurator | Selection Sets

Figure 11.10 Managing selection sets. The selection set containing the left line of loudspeakers is currently selected.

11.6.1 Managing Selection Sets

The SELECTION SETS window shows all selection sets in the project as a list. This list is sorted
alphabetically. Renaming a set may move it to a different position in the list.

A selection set can be used in the following ways:

It can be hovered and it can be selected. When selected, a selection set can be deleted by
pressing Del.
On the very left of a row, the name of the selection set is shown. The set can be named or

renamed using the 4 pencil button next to it.
The items assigned to the selection set can be restored, i.e., they can be re-selected using the
¥ selection button on the right. This button is visible only when one hovers over the selection
set. Once can also double-click on the selection set to achieve the same.
Note, that the I selection button is also available individually for the different types of room
items, such as loudspeakers or faces.
Using the % replace button the current selection of items can be stored in the selection set.
The previous content of the selection set will be overwritten. This button is available only when
at least one room item is selected.
Using the # add button, currently selected items can be added to the selection set. This button
is available only when at least one room item is selected.
On the very right the number of items assigned to the selection set is shown. Using the small
(3] ¥ triangle button the set can be expanded to see the items included with it.

o Forloudspeakers, the speaker model is shown in parentheses.

o For faces, the surface area and the acoustics material are shown.

o For audience areas, the lowest and the highest point are shown with respect to their

coordinates.
o For listener seats, the z-coordinate is shown.
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e |tems can be removed from a selection set using the = remove button. It is visible only when
hovering over an item.

Left Side & (5] &| |Windows & 3 -
o LDUDSPEAKERS (5) & L FACES (3) &~
BEL-5 (SRE29K_2Way) Face (8.92 m® Perfect Absorber)
HL-51 (SR829K_2Way) Face (38.86 m*, Perfect Absorber)
HL-53 (SR829K_2Way) Face (891 m® Perfect Absorber)
HL-55 (SR829K_2Way)
HL-57 (SR829K_2Way)

Figure 11.11 Expanded selection sets showing the items assigned. Left: loudspeakers. Right: faces.

When interacting with selection sets, the displays in other windows may change. Vice versa, when
interacting with other windows the display in the SELECTION SETS window may change:

o When hovering over or selecting a selection set, all included items are highlighted in red in all
relevant views, e.g., the 3D views and tables.

o When hovering over an item or selecting it in any window, all selection sets that include that
item are highlighted in red.

o Hovering over an item will highlight it in blue in other windows. Similarly, selecting an item will
show it as selected (green) also in other windows and views.

o Restoring the selection from a selection set selects the items assigned to the set and shows
them in green accordingly.

Note that you can also select multiple selection sets by keeping Ctrl pressed while selecting them one
by one in the list. This will highlight the items of all selected sets.

Also, the items included in multiple selection sets can be restored together by keeping Ctrl pressed
while restoring one set after the other.

In the calculation modules of EASE, selection sets will be offered automatically for selection wherever
a group of room items can be selected or activated. For example, a selection set containing one or
several loudspeakers will be shown in the LsPk GRouP selection dialogs of the Room Mapping module.

11.7 Saving Graphics

All of the graphics displayed in the main program can be saved for further use in reports and
documents or for archiving purposes.

To do so, first activate the window of interest. This can be, for example, a 3D
view, a table, or a chart. Then use the TooLS > SEND PICTURE TO.. > CLIPBOARD

Clipboard  File ribbon button to copy the content of the selected window to the Windows
clipboard. It can be subsequently pasted as a graphics bitmap into any other
Send Picture to.. software. Alternatively, use the TooLS > SEND PICTURE To.. > FILE ribbon

button to store the content of the active window in a graphics file. A variety of different file formats is
available (see Figure 11.12).
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Portable Network Graphics (*.png)

Portable Network Graphics (*.
Windows Bitmap (*.bmp)

Graphics Interchange Format (*.gif)
JPEG (*jpg)

Tagged Image File Format (*.tif)

Figure 11.12 Target file formats available for saving a graphic as a bitmap.

11.8 General Table Functions

There is a tabular view available for each type of room element, i.e., for faces, loudspeakers, audience
areas and listener seats. There is also a table for drawings, and for the materials used in the project.
These tables can be helpful to obtain an overview over the project, to search for specific items, or to
systematically browse and edit items in the project.

All of the tables listed above can be accessed through the WINDOWS ribbon menu as well as other places.
The tables share the same base functionality which is described in the following.

A table consists of a group panel (1) at the top, followed by a row of column headers (2) and the body
of the table (3). At the bottom there is a summary panel (4). In the upper right, there is the search
panel (5).

Listener Seats Table > IX
Drag a column header here to group by that column Q
: 1 . . > 3
Vis. | Label = [X[m] | Y [m] er. [°] | Hor. [*] | Rot. []

< Balcony 1 8.05 -13.95 7.99 0.0 180.0 2 -
& Balcony2 -1.45 -1933 8.90 0.0 180.0 U0
@ Balcony3 -455 -12.99 7.40 0.0/ 180.0 0.0
< Floor 1 11.9 .15 2.85 0.0 180.0 0.0
@ Floor 2 0.3 3 3.33 1.98 0.0 180.0 0.0
@ Floor 3 -5.49 -1443 229 0.0 180.0 0.0
(6)
Faces Table Loudspeakers Table Audience Areas Table | Listener Seats Table | Drawings Tabl terials in Use

Figure 11.13 Exemplary table window and its important parts.
All tables can be adjusted with respect to how the data is displayed:

1. The rows of a table can be sorted. Left-click on any of the column headers to sort the entries
of the column in ascending or descending order. Clicking again will reverse the sort order. A
small black triangle = in the column header indicates according to which column the table is
sorted and in which order.

2. A table can be filtered. Click on the Q search button located in the upper right corner and
enter any word or number in the search field to show only those rows that include the given
search term. This functionality also allows searching for a specific item name, for example.

3. The entries of a table can be grouped. If one or multiple columns are selected for grouping, all
items with the same value in the respective column are placed in the same group (Figure
11.14). To group entries in the table, drag a column header to the group panel at the top.
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When grouped, a context menu can be opened by right-clicking on the group panel. It provides
the following controls:

e FuLL EXPAND shows all entries in the table.

e FuLL COLLAPSE reduces the table view to all groups.

e CLEAR GROUPING returns to the ungrouped view of the table.

4. By default, the number of visible items is shown in the summary panel at the bottom.
5. The size of the columns can be horizontally adjusted by dragging the left or the right line of
the column.
6. Columns can be moved relative to each other by dragging the column header to another
location in the header row.
Faces Table M
Material = Q
Area[m’]
¥ Material: Light construction as) ©
¥ Material: Seating, light upholstery (6)
b 4 Material: Soft, porous material (drapes, tiles) 3

Figure 11.

746
746
6.80

(24)

Faces Table | Loudspeakers Table Audience Areas Table Listener Seats Table  Materials in Use  Processing Blocks

14 Faces table grouped by materials. Faces are sorted according to their surface area in descending order.

There are a number of advanced functions available that allow further customization of the table:

1.

A context menu can be opened by right-clicking on the summary panel. Select the CUSTOMIZE...

command to open the summary editor. This editor can be used to adjust the quantities

displayed in the bottom row, such as the minimum, maximum or average value of all values in

the selected column.

Right-clicking on the column header opens a context menu that allows adjusting the view as

follows:

e  SORT ASCENDING sorts text entries according to alphabetic order and numerical values from
smaller values to larger values.

e SORT DESCENDING sorts text entries in reverse alphabetic order and numerical values
beginning with the largest.

e CLEAR SORTING shows the data in the original, unsorted form.

e GROUP BY THis CoLUMN enables the grouping functions as described above.

e HIDE GROUP PANEL switches the top area of the table invisible. When it is hidden, it can be
shown again using the SHOW GROUP PANEL menu command in this context menu.

e SHoW COLUMN CHOOSER allows selecting which columns are displayed in the table and in
which order.

e BEST F1IT adjusts the horizontal width of the column so that it matches the size of its
contents.

e BEST FIT (ALL COLUMNS) adjusts the horizontal widths of all columns so that each matches
the size of its contents.
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e FILTER EDITOR.. opens the FILTER EDITOR window for the table which allows applying
advanced filtering conditions to the tabular data.

e SHOW SEARCH PANEL shows the search field in the upper right corner as described above. If
it is visible already, it can be hidden again using the HIDE SEARCH PANEL menu command
in this context menu.

3. Right-clicking on a group in the group panel at the top also allows a number of user-defined
actions that are very similar to the ones described above.

4. When hovering over a column header a T filter symbol is shown as well. Left-clicking on the
filter symbol opens a window that allows configuring the filters applied to the data in greater
detail. If a filter is applied, a configuration panel is displayed below the summary panel. It
shows the currently active filters and provides access to the FILTER EDITOR window. Any filters
applied can be removed using the X button. The = button shows a history of the filters that
were recently used.

Faces Table T~ Ix
e Q
Material T ~ | Area [m7]
Soft, porous material {drapes, tiles) 7.46 -
Soft, porous material {drapes, tiles) 6.30
Soft, porous material {drapes, tiles) 7.46
3)
v| | Material = Soft, porous material (drapes, tiles) = 72 X

Faces Table | Loudspeakers Table Audience Areas Table Listener Seats Table Materials in Use  Processing Blocks

Figure 11.

15 Faces table filtered for a specific material. Currently active filters are shown at the very bottom.

In the table, items can be selected in the following ways:

Left-click on any row to select the corresponding item. Hover over any row to highlight the
corresponding item.

Press Ctrl+A to select all items.

Left-click on rows while keeping Ctrl pressed to add items to the current selection. Left-clicking
again on a selected item will remove it from the current selection.

To select a block of rows, click on the first row, then press Shift and click on the last row.

When selecting rows in the table, the row selected last is marked as active by a small » triangle. If the
active row is currently not visible due to the length of the table, press Space to jump back to the active

row.

Please note that the table layout and configuration is stored only while the program is running and
only for the current project. Loading another project or restarting the program will reset the table

views to their defaults.

11.9 Exporting DWG Drawing Files

A room

model can be exported as a standard CAD file in DWG file format. To do so, navigate to the

FILE ribbon, press SAVE As and select CAD MoDELS from the formats list. As part of the export process
the EASE model is converted to a set of geometrical elements like surfaces and lines that can be dealt

130



EASE 5 Third Edition — User’s Guide General Tools

with in a CAD software like AutoDesk AutoCAD or Trimble SketchUp. Due to the nature of the format,
acousticinformation relating to loudspeakers, audience areas, or surface materials is largely discarded.

Auditerium, Slepr) w
EASE 5 Project (*.eprj) w
EASE 3 Project (*.eprj)

EASE 4 Project (export format) (*.frd)

| CAD Models (export format) (*.dwg)

Figure 11.16 Target file formats for saving or exporting the project.

In detail the following data is stored in a DWG file:

- Faces are converted to Polyface Meshes, one for each face.

- Faces with more than 3 points are tessellated and exported as a Polyface Mesh consisting of
several triangles. Edges of triangles internal to the face are set invisible.

- Faces are assigned to layers or tags that bear the name of the acoustic material assigned to
the face.

- Loudspeakers are exported as groups of 3D Polylines. Each group of lines represents a
loudspeaker by its case drawing. The group is named after the loudspeaker and its speaker
model.

- All loudspeaker cases are organized in a layer named “Loudspeakers”.

- Audience areas and listener seats are not exported.

Figure 11.17 Expofted DWG file opened in AutoDesk AutoCAD 2024 and in Trimble SketchUp 23.

11.10Importing from and Exporting to EASE 4

In addition to loading and saving projects in the native format of EASE 5, projects can also be imported
from and exported to EASE 4. However, since both software solutions use different approaches for
how the venue is modeled and represented, the conversion between the software platforms is not
necessarily lossless. In fact, some data cannot be transferred from EASE 4 to EASE 5 and vice versa. The
following sections provide an overview of the changes that are made during this process.
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“ File % Surfaces Loudspeakers
II
.|.

New Open Add Save Save Load
As

Project Drawing

Figure 11.18 File ribbon menu providing access to importing EASE 4 projects (Open) and exporting EASE 4 projects (Save As).

11.10.1 Importing a Project from EASE 4
To load an EASE 4 project, click on FILE > PROJECT > OPEN and select the corresponding .frd file.

When opening a project that was saved in EASE 4, all of the primary room elements are imported.
Elements that have not been imported or that have been adapted will be listed in a log file that is
shown after the import was finished.

The following general restrictions apply:

e The software imports faces along with their vertices and materials, as well as loudspeakers,
audience areas and listener seats.

e Edges, lamps, and infrared emitters are not supported in EASE 5.

e When importing loudspeakers, their assigned speaker models are limited to those based on
DLL or GLL files. SPK-based speaker models are converted to the “Omnidirectional” speaker
model.

e When importing the general loudspeaker filters given in 1/3™ octave resolution, for GLL and
DLL speaker models the level and delay settings are imported accordingly. These settings are
discarded for SPK-based speaker models and invalid references. A bandpass with a 6 dB/octave
slope is applied to the bandwidth of 100 Hz to 10 kHz.

e When importing faces, the absorption curves of their assigned materials are automatically
extrapolated to the full bandwidth supported by EASE 5.

e The input signal type “Multi-tone / white spectrum” is not supported and is changed to “Pink
Noise” upon project import.

Most of the project information is imported:

e The HALL of the EASE 4 room properties is imported as the NAME of the project.
e The AUTHOR is an application setting in EASE 4 and will not be imported.
e  ToOWN, PROJECT VERSION and REMARKS from EASE 4 are imported into the NOTES field of EASE 5.

Two-fold faces and coated faces of EASE 4 are converted according to the room modeling concept of
EASE 5:

e Two-fold faces that are not coated are converted to two separate faces with opposite
orientation. They point away from each other and are spaced about 1 mm apart.
e Faces with coats are converted to faces with holes:
o A face with a two-fold coat is converted to a face with a hole and a separate face
located within the hole and facing in the same direction.
o A face with a single-fold coat is converted to a face with a hole.

For some parameters or configuration values the range of validity is different between EASE 5 and
EASE 4. In this case, adjustments are automatically made during the import process and reported in
the import log, for example:
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e Line array box gain: Values less than -60 dB are changed to -60 dB and the box is set muted.
e Room noise level: 1/3rd octave values outside of the range of -13.2 dB to 136.8 dB are adapted
to the respective lower or upper limit.

11.10.2 Exporting a Project to EASE 4

To save the current project in EASE 4 format, click on FILE > PROJECT > SAVE As, select EASE 4 as
the target format, and then choose the file location.

The exported project will include the faces along with their vertices and materials, loudspeakers along
with their speaker models, as well as audience areas and listener seats. Drawing bitmaps are not
exported. Processing blocks are not exported but they are added to the loudspeaker filters. The
following changes are made during the conversion process.

Project and Room Properties

The project author is not exported because it is an application setting in EASE 4. The content of the
NoTEs field is stored in the REMARKS field of the EASE 4 project. Any version or town information
imported from EASE 4 is kept in the NOTES field and not exported back to the corresponding fields in
EASE 4.

As rooms do not have to be strictly closed in EASE 5, the exported room will appear as OPEN in EASE 4.
The room volume and surface area are exported along with this information.

EASE 4 adapts the humidity values to the minimum or maximum of its range of validity, i.e., values less
than 30% or greater than 98% are adjusted to the respective limit.

Values of the MEASURED RT setting in EASE 5 are always exported in 1/3rd octave frequency resolution
to EASE 4. If only a broadband value is defined in EASE 5, a default curve is used to determine these
values. If the 1/1 octave frequency resolution is used, values are linearly interpolated to 1/3rd octave
resolution. Values outside of the frequency range of EASE 4 are not exported. The measured RT is
exported only if the RT switch in the ACOusTIC PARAMETERS window actually points to MEASURED RT.
Otherwise the CALCULATED RT is exported.

Faces

Upon export from EASE 5, faces with holes are converted so that EASE 4 can process them. Each hole
of a face is connected to the outer border of the face by a small cut.

Regarding the material assigned to a face, EASE 4 supports only the basic material information of the
MAT format. Additional information is not supported, e.g., search tags, references, measurement
points, original data of modified materials. Also, the frequency range is limited to the bands from 100
Hz to 10 kHz.

Loudspeakers, Processing Blocks, Global EQ

EASE 4 does not support the parametric filters of EASE 5. It also does not support processing blocks or
a global EQ. The settings of the processing blocks and the global EQ are therefore combined with the
filters of each individual loudspeaker in EASE 5 and then exported to the properties of the EASE 4
loudspeaker: gain and filter transfer function are exported to the 1/3™ octave band filter and delay to
the DELAY and ALIGNMENT fields. The GRoUP LABEL of each EASE 4 loudspeaker will be set to the name
of the corresponding processing block in EASE 5.

The settings for the gain of line array boxes are slightly different between EASE 4 an EASE 5. Box gains
are therefore converted as follows:
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e The gain for muted boxes is set to -150 dB.

e When there are positive box gains, the gains of all boxes of the array are reduced by the
greatest positive value. Gains may then have to be corrected to the nearest valid value allowed
by EASE 4. This step may slightly change the relative level between boxes and therefore the
output SPL of the array.

Audience Areas

In EASE 4, audience areas must have four points. Therefore, upon export from EASE 5 an audience area
with more than four points is split into triangular areas. These triangular areas are assigned to one area
group. The EASE 4 group name is set to the original label of the audience area in EASE 5. The labels of
the triangular areas have the original area label with a consecutive number appended to them.

EASE 4 does not support a separate ear height setting for audience areas. Accordingly, audience areas
exported to EASE 4 are created directly at ear height. The information about the base plane is lost.

Selection Sets

When exporting to EASE 4, selection sets are converted to objects. They are automatically assigned a
location at the outer boundary of the project so that they can be selected more easily.

11.11 Exporting a sound system model for noise immission forecasts

The modeling engine of EASE 5 can be used to simulate sound systems for indoor applications as well
as for outdoor applications. The latter may be interesting particularly for open-air concerts if noise
immission into the neighborhood plays an important role. Official noise immission forecasts, however,
are regulated by national and regional authorities and must comply with corresponding standards.
These types of calculations are not supported by EASE.

The IMMI software by Wolfel Engineers is one of the leading software solutions for the modelling and
assessment of environmental noise propagation. It conforms with above-mentioned standards and
provides a professional simulation tool for noise consultants and subject experts.

EASE allows transferring the sound system from the EASE project directly to IMMI. For this purpose,
the sound system is converted into a so-called Aggregate Point Source (APS) model which can then be
read by IMMI and processed further.

In the context of the APS model, it is important to understand that in EASE the sound system consists
of groups of mutually coherent sound sources, such as a flown line array formed by its elements, a
steerable column consisting of many drivers, or an array of subwoofers. EASE models both the near-
field and far-field behavior of such a coherent group accurately [1]. Noise immission calculations,
however, typically consider only incoherent point sources. Also, immission points of interest are
normally in the far field of any array or coherent group.

For these reasons, the conversion process consists of combining the coherent sources of each group
into a single, substitute point source that represents the far field behavior of the respective group and
that is called an aggregate point source.

In EASE, an aggregate point source can be created from a loudspeaker object or from a selection set.
A flown line array or a steered column will typically be an APS. Also, an array of point sources or subs
should be modeled as a single APS if they are located close to each other and are expected to interact
coherently. The array on the left of the stage and the array on the right of the stage will, however, not
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be coherent to each other and should therefore be treated as separate APS. The same is true for a set
of ceiling speakers distributed over a wide area.

The APS model can be exported using the FILE > SAVE As command and by selecting the APS file
extension. This will open a dialog window (Figure 11.19) with the following options:

- REFERENCE LOCATION: This setting is based on a listener seat in the model and defines a position
in the near field of the sound system that is used in practice to specify the reference level and
reference spectrum for the noise immission assessment. This may be a spot close to the FOH
or a dedicated location for level monitoring.

- AGGREGATE POINT SOURCES: This list allows selecting the groups of coherent sources for export
to the APS model file. These can be chosen from the loudspeakers and from the selection sets
defined in the project. Typically, flown line arrays would be selected as single loudspeakers
and a subwoofer array on the ground would be specified using a selection set that contains all
its subwoofers.

The theoretical basis for the APS model was developed and documented in several research papers [2,
3, 4].

I Save as APS Model X

Reference Location

Listener Seat: | FOH v

Aggregate Point Sources
Loudspeakers:

[] Delay C
[ ] Delay L
[ ] DelayR
Main Left
Main Right
[]sL1
[]sL2
[]sL3
[]sL4

[] SR1

[ ]sr2
[]SR3

[] SR4

Selection Sets:

[] Delay Line
[ Main PA
Subwoofer Array

Save | | Cancel

Figure 11.19 When saving the project as an APS model, the APS configuration window allows selecting the reference location
as well as the aggregate point sources.
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12 Calculations Overview

After having entered the venue's geometry, the sound system, and the room acoustic properties,
acoustic simulations can be carried out. As described in the introduction, some of these are managed
through separate calculation modules. All of the calculation tools can be accessed from the
CALCULATIONS ribbon menu of the main program.

F—
=
~—
Acoustic
Parameters

2 : — _ . TN ETY S =)
4 24 Bandwidth: | 10ctave v | | Z-Weighting +| = Sim. Config, 1 - .|||I | é [ [:_:__ B )
Show Direct Frequency. | 1 kHz ] 1 interference Sum Distribution  Frequency  Analyze Room Rey  Probe EARS

Meapping spL~ . Graph  Response Location  Mapping Tracing  Probe  Auralization

Figure 12.1 Calculations ribbon menu offering access to mapping, ray-tracing, post-processing and auralization functions.

The left section of the ribbon menu is concerned with functions that are part of the main program:

The AcCOUSTIC PARAMETERS window gives an overview over the most important room
parameters, like the volume, the surface area, and the reverberation time. Also, the
background noise level, the input signal, and the global EQ can be adjusted here. Please refer
to section 5.8 for more details.

Introduced with EASE 5 Third Edition, the new ACOUSTEER ENGINE provides access to real-time
simulations. The corresponding menu allows adjusting various related calculation parameters.
Note that initially the functionality is limited to a subset of simulations on audience areas, such
as the SPL coverage of the sound system as well as metrics based on statistical room acoustics.
Its feature set will be expanded step by step. Please see the following chapter 13 for more
details.

For further analysis, the calculation modules provide the following functionality:

The Room MAPPING (EASE Eyes) module allows viewing the room, calculating mappings on
audience areas, listener seats, and on faces, and calculating reflectograms as well as impulse
responses.

The RAY TRACING (EASE Rays) module allows performing reflection analyses. Ray tracing
calculations can be conducted in order to view and analyze reflection patterns for selected
loudspeakers. Response functions can be calculated for selected listener seats by detecting so-
called impacts at these positions.

The PROBE post-processing module is used to load response files as well as impact files in order
to analyze them in more depth. Individual reflections can be investigated as well as acoustic
parameters can be calculated.

The EARS module serves for the purpose of auralizing previously computed response files.
Binaural impulse responses can be created based on a selected HRTF and convolved with dry
sound recordings. As a result, one can listen to how it would sound in the virtual model of
sound system and room.

In the following chapters we will give a short overview over the features and tools provided by each of
the modules. Further details can be found by accessing the help function of each module using the F1
shortcut as well as on the AFMG website.
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13 Real-Time Calculations with the Acousteer Engine

13.1 Overview

The new Acousteer engine introduced with EASE 5 Third Edition is the world-first software that can
run detailed acoustic simulations in real time.

Acousteer allows you to make changes to the model and see the effect live in a high-resolution
mapping. The result of modifying the location, aiming angle, or gain setting of a loudspeaker, of
changing the absorption in the room or, e.g., adjusting environmental parameters like humidity, is
immediately visualized. This applies even to large sound systems consisting of dozens or hundreds of
loudspeakers.

Acousteer supports the full audio bandwidth, from 20 Hz to 20 kHz, thus facilitating simulation of
subwoofer arrangements, as well. Internally it uses a high spectral resolution of at least 1/24™ octave
bands which leads to exceptionally precise results. Acousteer is currently limited to a subset of
calculations, in particular metrics related to sound system coverage and statistical room acoustics. The
results can be visualized as mappings on audience areas, distribution statistics, and frequency response
plots. Subsequent updates will expand the functionality of the engine step by step.

The high calculation speed of Acousteer was achieved by reimplementing the accurate EASE
calculation engine on the new platform using a sophisticated, hybrid CPU/GPU approach that takes
advantage of modern parallelization concepts and detailed performance tuning. It is especially unique
in the context of EASE, as all of the properties of the model are connected directly with the calculation
engine. Any change to the model therefore triggers an immediate update of the calculation results.

Select the SHoW MAPPING button or press the shortcut F5 to switch the mapping on or off. If enabled,
the mapping will be updated automatically whenever a change is made to the project.

When the mapping is activated, result values are shown color-coded on all audience areas. A progress
bar will be shown in the lower right corner of the main window if the calculation takes longer than a
couple of seconds. When hovering over an audience area, the status text will show the mapping value
corresponding to the current mouse position.

Calculating Direct Sound Mapping

Figure 13.1 Progress bar shown in the lower right if the calculations take longer.

Activate the DISTRIBUTION GRAPH button to display statistical information about the currently shown
mapping (see also section 13.4). Use the FREQUENCY RESPONSE graph to investigate the spectral
properties of the results (sections 13.5, 13.6).

13.2 Adjusting Calculation Settings

To the right of the SHow MAPPING button the acoustic metric or quantity to be displayed can be selected.
At present, DIRECT SPL, ARRIVAL TIME, ToTAL SPL,D/R RATIO, Critical Distance, and S/N RATIO are
available. Essential settings related to the currently selected acoustic metric can be accessed in the
OPTIONS area of the CALCULATIONS ribbon menu. Advanced settings related to presentation options and

calculation resolution can be adjusted in the dropdown window that is opened using the = button.
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13.2.1 Elementary Settings for Frequency-Dependent Metrics
Bandwidth and Frequency

The BANDWIDTH setting allows selecting different standard bandwidths based on fractional octaves, such
as 1/3 Octavg, 1/1 OcTAVE, and 3/1 OcTAVE, and broader. The BROADBAND setting uses the full
frequency range from 25 Hz to 20 kHz. The MID-BAND setting uses the frequency range from 400 Hz to
5 kHz. For detailed investigations of the direct SPL, the 1/24 OCTAVE setting is also available, as well
(Standard and Pro feature levels).

The current display frequency can be selected from the FREQUENCY dropdown located below the
BANDWIDTH setting. It is not available for the BROADBAND and MID-BAND bandwidths as these are fixed.
For the other bandwidths, the frequency shown corresponds to the center frequency of the respective
bands. The lowest available frequency at 1/3™ octave resolution is 25 Hz and the highest is 20 kHz. For
more details, see also section 19.3.1.

Weighting

For DIRECT SPL and ToTAL SPL, the weighting control offers a choice between the Z-WEIGHTING, A-
WEIGHTING, and C-WEIGHTING settings. These weightings are applied for any bandwidth. See section
19.3.2 for more details.

Complex Summation

The INTERFERENCE SUM switch selects whether the direct-field sum SPL of several loudspeakers is
calculated as a power average assuming incoherent phase relationships or using a complex vector
assuming a constant phase relationship (see section 19.2.1). When enabled, complex summation is
used instead of power summation when the contributions of individual loudspeakers are added at
mapping points.

This feature is primarily important for the low-frequency range where cancellation and summation
effects due to relative phase play a role. It may also play a role in the mid frequencies when only short
distances are considered. Note that the sound sources that are part of a loudspeaker object, i.e. the
transducers of a single loudspeaker or the boxes of a line array are always treated coherently, that is,
the phase relationships are accounted for using complex summation.

SPL (d8) SPL (d8)

15
|||o I“O

105 105

-100 -100

-95

D

Figure 13.2 SPL mapping of 3x subwoofer stack in cardiod configuration at 80 Hz with interference off (left) and interference
on (right).

Note that mappings using the complex summation setting may show aliasing effects if the spatial
resolution is not high enough. The spacing should be smaller than half the wavelength for the
frequency of interest.
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13.2.2 Elementary Settings for Arrival Time

For the ARRIVAL TIME map, there is only a single setting named CONSIDER PRECEDENCE EFFECT. When
active, the auditory masking effect according to Haas is considered. It accounts for the fact that a later
signal that is louder than an earlier signal may mask the earlier one and is therefore perceived as the
first arrival. When the setting is inactive, the arrival time of the signal from the loudspeaker that arrives
first at the receive location is shown independent from its level.

| |
Figure 13.3 Arrival time mapping. Left: Single source on stage. Center: Source on stage and delay loudspeakers without delay
set. Right: Source on stage and adjusted loudspeakers. After adjusting the delay, the source on the stage is localized properly
because it masks the delay loudspeakers.

Masking by the precedence effect is commonly used for sound reinforcement systems. When realizing
delay loudspeakers, they may be louder than the reference source on stage, as long as they arrive
within approximately 50 ms after the reference signal. In that case, the listener will still localize the
reference source instead of the delay loudspeaker. In contrast, if the signal from a delay loudspeaker
arrives too early or is too loud, listeners will localize the loudspeaker instead of the original source.
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Figure 13.4 Precedence effect and masking curve in time response. Left: The delay loudspeaker (red) without a delay assigned
masks the stage reference (blue) because it arrives too early. Center: The delay loudspeaker with a delay assigned masks the
stage reference because it is too loud. Right: The stage reference properly masks the delay loudspeaker even though the delay
loudspeaker is louder.

13.2.3 Additional Settings

The extended options window allows adjusting presentation settings as well as the spatial resolution.
All of these settings are made specifically for each acoustic metric, such as direct SPL or arrival time.
The settings are stored along with the current simulation configuration (see 13.3).
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Options
| Color Scale
® Automatic
(O User Defined

er Limit [dB]:
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O Fixed Interval

ange [dB

Presentation
@® Patch Grid
O Iscline Plot

Step Size [dB]:
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(@ Predefined: Intermediate (0.39m) ~

() User-defined [m]:
i

Calculation

[] Map with Shadow

Figure 13.5 Dropdown window containing settings for presentation and resolution.

Color Scale

In the upper area of the dropdown window, the setting for COLOR SCALE can be selected:

If the range is set to AUTOMATIC, the color scale is adjusted dynamically according to the
minimum and maximum values of the map. This provides the optimal color resolution given a
range of result values but it makes it difficult to visually compare different maps with respect
to absolute levels.

If USER-DEFINED is selected, result values associated with the red and blue colors can be given
by the user so that the color scale is fixed. This makes it easy to compare maps to each other
with respect to absolute values as they will show the same color for the same result value.
However, if the maximum and minimum values differ across maps, one may have to adapt
these settings often or choose a very wide range properly covering all maps of interest.
Selecting the third option, FIXED INTERVAL, allows defining a constant value range associated
with the color spectrum. But unlike the USER-DEFINED setting, the value associated with the
red color is automatically adjusted to the maximum value of the current map. In this way, one
can assess and compare the spread of results across an area independently from absolute
values.

In the 3D view, the color legend is shown on the right.
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Figure 13.6 SPL mapping shown with the automatic color scale (left) from minimum (blue) to maximum (red) and with a user-
defined color scale from 50 dB (blue) to 110 dB (red).

Presentation Settings

The second option in the calculation parameters window, labelled PRESENTATION, is related to the
interpolation of the map. When using PATCH GRID, the color coding is continuous. It shows different
colors for different result values at a high color resolution. When using ISOLINE PLOT, the displayed
map is discretized in steps separated by isolines or so-called iso-contours. All result values within a
certain interval are assigned the same color.

Both options are very useful:

e The continuous display is generally faster and is most suited for qualitative analysis. It can
provide spatially detailed insights about the distribution of the result quantity and it offers a
visually smooth impression due.

e The stepped display is somewhat slower and more suited for quantitative analysis. It allows
investigating the coverage uniformity more easily as small level differences are neglected.
Also, it helps fine-tuning a sound system given practical uncertainties and tolerances. The
width of the interval is determined by the STEP S1ZzE setting. This value can be between 0.5
dB and 20 dB in 0.5 dB increments for SPL. The lower bound of the first isoline interval is
determined by the lower limit used for the color legend.

Note that for direct SPL the iso-contour maps can be imagined as the footprint of the loudspeaker
system. They replace previously used approximate displays for aiming speakers, such as coverage
cones or projection circles.

SPL[dB] | | seLgl

100 3 ;" 100
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98 \ / 58
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Figure 13.7 SPL mapping shown using the continuous patch grid (left) and the stepped isoline plot at a resolution of 1 dB
(right).

Note also that the isoline plot requires more rendering resources internally than the patch grid. If the
map has many, complex details, such as intricate interference patterns, the limits of the GPU may be
reached when using high spatial resolutions. In those cases, continuous color patches instead of
stepped isolines will be used for those areas of the room where the density of isolines is very high.

Spatial Resolution

The SHoW MAPPING button also gives access to the setting for the spatial resolution.

When using the PREDEFINED setting, the spatial resolution is determined by distributing a given number
of calculation points across the surface area of all audience areas.

High (0,19 m) T\
Low (0,77 m)
Intermediate (0,39 m)
High (0,19 m)
Maximum (0,10 m)

Figure 13.8 Settings for the spatial resolution, given a surface area of the audience area of 500 m?,
There are four presets that correspond to four different levels of detail:

e The Low setting is based on approximately 2500 data points distributed over the audience. This
coarse setting is recommended only for exceptional situations where calculations at higher
levels take too long.

e The INTERMEDIATE setting is the default. It uses approximately 10 000 data points and is fully
interactive on most computers. This setting is typically adequate for optimizing sound system
coverage.

e The HiGH setting equates to 40 000 data points. This setting is intended for detailed pictures
and report generation. On most computers, the calculation time at this level is still shorter
than or equal to one second.

e The MaxIMuM setting includes roughly 160 000 data points. Calculations at this resolution may
not be supported on all types of hardware, depending on the available memory.

Each setting corresponds to a spatial mapping resolution or point spacing that depends on the project
size. This resolution value is shown in parentheses close to the setting itself. It roughly doubles when
increasing the resolution by one step. The value represents the maximum distance between any two
adjacent mapping points. The average distance is about 30% shorter.
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D

Figure 13.9 Comparison of the low-resolution setting (0.77 m, left) with the high-resolution setting (0.19 m, right).

The USER-DEFINED setting allows specifying a custom spatial resolution. Notice that when performing
mapping calculations, the value is automatically validated and limited to the MAXIMUM value as defined
above for the PREDEFINED setting.

Calculation

This section allows considering obstacles when calculating the propagation of sound. If MAP WITH
SHADOW is enabled, a sound wave transmitted from a sound source to a mapping point is considered as
received only if there are no faces blocking the line of sight.

Note that the shadowing calculation is computationally intense and will prolong Acousteer
calculations. Also note that those parts of an audience area that are completely shaded and receive no
sound will be colored in dark gray independently from the color scale.

Direct SPL, Freq.: 1 kHz (1 Octave, Z-weighted), Interference: Off, Shadowing: Off, Resolution: 0.19 m, Lspks: 1/20, Areas: 7/7 Direct SPL, Freqs: 1 khz (1 Octave, Z-weighted), Interference: Off, Shadowing: On, Resolution: 0.19 m, Lspks: 1/20, Areas: 7/7

]

Figure 13.10 Direct field map without considering obstacles (left) and with shadow calculation (right). The sound radiated by
the source on the podium is blocked by the columns and the parapet of the balcony.

In practice, sound waves are not only shadowed by obstacles but also diffracted by the edges of
objects. Especially, low-frequency sounds will not be blocked by objects that are small compared to
the wave length. These wave-based effects are not considered when computing shadowing effects.
For the sake of simplicity, it is assumed that sound propagates along a straight line only.

Similarly, when shadowing is on, the sound wave is fully blocked by any object along its path. Partial
transmission of sound through objects, such as through curtains or light-construction walls with
according attenuation, is currently not taken into account.
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Last but not least, the boundaries of a shadowed zone are subject to the setting for the spatial
resolution defined previously. If the separating line between a zone covered by sound and a shadowed
zone looks uneven or jagged, the spatial resolution can be increased to make it smoother. However,
the shadow boundary can be determined only with the precision of the selected spatial resolution.

13.2.4 Active Loudspeakers and Audience Areas

The O deactivate and | activate buttons allow switching selected loudspeakers and audience areas
off or on for calculations. They can also be deactivated using the shortcut Ctrl+Shift+O and activated
using the shortcut Ctrl+Shift+l.

With respect to loudspeakers, please note that this switch affects only the SPL calculations and
corresponds to a virtual mute of the loudspeaker. The electric load on the system and therefore the
determined maximum input voltages into the loudspeakers are not changed. For a real mute, please
use the settings in the FILTER STAGE window for the respective object.

With respect to audience areas, deactivating them excludes them from the mapping calculations.
Given that the number of mapping points is kept constant, the spatial resolution of mapping points
will be higher for the remaining audience areas. Vice versa, when activating additional audience areas,
the spatial resolution will become coarser.

When deactivated, loudspeakers in the 3D view are indicated by the specific A symbol. The activation
status is also shown in the LOUDSPEAKERS TABLE window (section 9.6). Deactivated audience areas are
rendered without a color map. The activation status can be viewed in the AREAS TABLE window (section
10.1.4).

Note that all of the usual functions for selecting room items can be used to activate or deactivate
loudspeakers or audience areas, for example:

e Multi-select items by dragging over the 3D view with the left mouse button pressed or by
clicking on several items while keeping Ctrl pressed.

e Select the items of one or multiple selection sets using the ¥ selection button.
e Select the loudspeakers of one or multiple processing blocks using the I selection button.
e Select one or several rows in a table.

The activate and deactivate commands can be used independent from how the room items of interest
have been selected.

13.2.5 Settings Summary Display

A summary of the current calculation settings is automatically displayed in the upper right of the 3D
view if the Acousteer mapping is enabled. It can be switched off and on again using the CALCULATION
PARAMETERS button in the PRESENTATION ribbon menu.
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Freq. 1 kHz (1 Octave, Z-weighted), Interference: Off, Resolution: 0.38 m, Lspks: 1/1, Areas: 6/6
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Figure 13.11 A 3D view with mapping showing the calculation parameters in the upper right.

13.3 Storing and Recalling Calculation Settings

In the preceding section, various calculation parameters have been introduced. However, when
comparing maps or retrieving specific results it can become tedious to switch between those different
views. For this reason, so-called simulation configurations can be created, stored, and recalled.

A simulation configuration represents the full set of parameters required for running an Acousteer
calculation and displaying its results. It includes information, for example, about which loudspeakers
are active, the acoustic quantity shown, the selected frequency and bandwidth, as well as the color
scale setting. One can think of a simulation configuration as a calculation preset or as a result map.
Simulation configurations are stored along with the project and can be selected at any time to repeat
a simulation using a defined parameter set.

By default, there is always one simulation configuration. It is shown in the dropdown list in the
ACOUSTEER ENGINE section of the CALCULATIONS ribbon menu.

N Mid-band, all Lspk 1}
Sim. Config. 2% % IEI v (O 1kHz Octave, all Lspk
(®) Mid-band, all Lspk

Figure 13.12 Left: Dropdown list showing a simulation configuration where the parameters have been changed but not yet
stored. Right: Examples for simulation configurations.

The following functions are supported for simulation configurations:

e Selecting a simulation configuration from the list automatically triggers the recalculation
according to the chosen parameters. As the list stays open it is easy to switch between
different settings.

e When any parameter of the current simulation configuration is changed, the corresponding
label in the dropdown list is shown in bold face. Press the [l save button to store the changed
parameters along with the project. Press the 0 reset button to revert to the simulation
configuration before the parameter change. Not storing the changed parameters will discard
them when closing the project.

e The save-as button can be used to create a new simulation configuration based on the
currently active simulation parameters. The label is derived from the currently selected
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simulation configuration. The new simulation configuration will be selected automatically and
the original simulation configuration will be reset to its saved state if it was changed.

e The € pen button allows changing the name to represent the specific parameters or the
intended purpose of the configuration.

e The @l trash bin button can be used to delete the simulation configuration from the project.

All simulation configurations are automatically saved with the current project. However, any changes
made to a simulation configuration on the fly, indicated by the name in bold letters, will be saved only
when stored explicitly by the user.

Parameter changes are not remembered as part of the undo/redo functionality. This allows applying
model changes and undoing them without having to consider calculation parameters that may have
been changed in the meantime. Major changes such as creating, renaming, storing, and deleting
simulation configurations can be undone, though.

When adding a project to the currently loaded project, simulation configurations of the added project
are automatically transferred. This allows keeping a separated set of user-defined templates that can
be loaded and applied as needed.

Simulation configurations are optional to use. If you decide not to use them, all calculation parameters
will return to their default values upon loading a project or creating a new one.

13.4 Distribution Graph

The Acousteer calculation results can be viewed in the 3D VIEW window as a three-dimensional map.
They can be also viewed in the DISTRIBUTION GRAPH window in the form of a statistical summary. The

window can be shown using the corresponding button in the CALCULATIONS ribbon or in the WINDOWS
ribbon.

On the left-hand side of the window, a bar graph displays the percentage of occurrence for each
distribution class, i.e., for each interval of result values. On the right-hand side, the width of the interval
(CLAss WIDTH) can be selected. As an example, selecting a class width of 3 dB for DIRECT SPL will show
for the class of 63 dB the relative share of mapping points in the interval from 61.5 dB to 64.5 dB. The
color of each bar corresponds to the current color legend.

When hovering over any of the bars, the hover text will display the nominal value of the class as well
as its percentage.

Direct SPL, Freq.: 1 kHz (1 Octave, Z-weighted), Interference: Off, Resolution: 0.39 m, Lspks: 2/2, Areas: 1/1

Class Width: | 1.0dB v
§ 15 Average: 90.8 dB
g StdDev: 2.3dB
=] Avg+StdDev: 93.1dB
5 10
0 Avg-StdDev: 88.5 dB
g s Max: 95.0 dB
[a) Min: 83.6 dB

0 Data Points: 10401
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Direct SPL [dB]

Figure 13.13 Distribution statistics provided by an Acousteer mapping calculation.

The statistical information displayed on the right is defined as follows:
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- AVERAGE shows the mean value across all calculated mapping points. When looking at levels,
the average is calculated as the level average not as the power average. The mapping points
are weighted equally, assuming that they represent approximately the same surface area.

- STDDEV shows the standard deviation across the same set of mapping points that is used to
calculate the average. It represents a measure of uncertainty when considering the average
level over the audience area. It also represents a measure of uniformity when optimizing SPL
coverage and other parameters.

- The AvG+STDDEV and AvG-STDDEV values correspond to the upper and lower bound of the
result distribution assuming a range of variation of one standard deviation.

- Maxand MiIN denote the maximum and minimum result values, respectively.

- DATA POINTS counts the number of mapping points calculated. Outliers may not be included
in the bar graph. The number of outliers is indicated in the hover text of the © symbol.

Note that just like the 3D view, also the distribution graph and the statistical information are updated
in real time whenever project parameters or calculation settings are changed. Also, like in the 3D view
a summary line in the upper right shows all important parameters.

With respect to the calculation of the distribution statistics, please note that the presentation settings
do not affect the calculation of the distribution. The calculation is always using the underlying raw
data. For example, it makes no difference whether you have selected patches or isolines, the results
are the same.

Note that when MAP WITH SHADOW is enabled, the distribution graph may show a separate class for
shadowed mapping points (Figure 13.14). This is also indicated by a small warning symbol below the
CLAss WIDTH dropdown. Shadowed data points are not included in the calculation of the average value
and the standard deviation.

Direct SPL, Freq.: 1 kHz (1 Octave, Z-weighted), Interference: Off, Shadowing: On, Resolution: 0.19 m, Lspks: 1/20, Areas: 7/7

Class Width: | 3.0dB ~

T
w0 Average: 78.1dB
o 35 StdDev: 6.0dB
[=)
? 30 Avg+StdDew: 84.1dB
ko] Avg-StdDev: 721dB
..g = Max: 114.0dB
5 2 Min: 69.7 dB
E 15 Data Points: 43783

-0 69 72 75 78 81 84 a7 90 93 9 99
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Figure 13.14 Distribution graph for direct SPL when parts of the audience are shadowed. Fully shaded data points are indicated

by a level of negative infinity. They are excluded from the calculation of statistical parameters like average and standard
deviation.

It should also be noted that the distribution statistics are calculated based on the triangles of the
tessellated audience areas. It is assumed that the corresponding data points are dense and distributed
approximately homogeneously over the area. For audience areas with highly irregular shapes, it is
recommended to insert listener seats in a grid pattern of the required resolution. Then the exact
distribution data can be calculated in the Room Mapping module using listener seats only.
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13.5 Frequency Response

Acousteer mappings and distribution statistics can be calculated for all frequency bands across the
audio range from 20 Hz to 20 kHz. Direct SPL results are available in a frequency resolution as high as
1/24%" octave (Standard and Pro feature levels) whereas the highest resolution for other metrics is 1/3™
octave. While mappings and distribution statistics are available only for one frequency band at a time,
the frequency dependence of each metric can be viewed in the FREQUENCY RESPONSE graph. The
corresponding window can be accessed using the FREQUENCY RESPONSE button in the CALCULATIONS
ribbon or in the WINDOWS ribbon.

By default, the graph depicts the average frequency response. Each point of the curve corresponds to
the average value across all current mapping points. For a selected frequency, this average value can
also be viewed in the distribution graph. The frequency response at a user-defined location can be
displayed using the ANALYZE LocATION function discussed in section 13.6.

The graph shows the level or magnitude of the currently selected metric as a function of frequency
(Figure 13.15). For direct SPL, the bandwidth can be selected on the right. Note that extreme outliers,
such as results from shadowed areas, are automatically excluded from the average. If so, this is
indicated by a warning symbol.

In the diagram, exact result values can be viewed by hovering over the curve. The region below the
Schroeder frequency is indicated by a shaded background.

Direct SPL, 1/3 Octave, Interference: Off, Shadowing: Off, Resolution: 0.39 m, Lspks: 2/2, Areas: 1/1

100 Bandwidth: | 1/3 Octave -
90 Average

80
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60

Direct SPL [dB]

40
315 63 125 250 500 1k 2k 4k 8k 16k

Frequency [Hz]

Figure 13.15 Frequency response graph showing the average curve for direct SPL at a resolution of 1/3 octave.

13.6 Analyze Location

The properties of the sound field typically depend on the position in 3D space. The ANALYZE LOCATION
mode can be used to investigate simulation results at user-defined coordinates. The mode can be
activated in the CALCULATIONS ribbon and requires an Acousteer mapping to be active.

In this mode, the analysis location can be specified either by mouse or by control bar. All regular
functions for determining a coordinate in 3D space apply, such as snapping or constraints (see 6.3).
Notice, however, that the analysis location must be on an active audience area. Listener seats located
in the plane of the audience area can be snapped to.

When this mode is active, the FREQUENCY RESPONSE window (section 13.5) shows the curve at the
currently hovered mouse location in light blue (labelled Hoverep). By left-clicking or by entering
coordinates via the control bar the location can be fixed. The frequency response for this location,
labelled SELECTED, is shown in green (Figure 13.16).

Note that both locations are discarded when leaving the mouse mode. For recurring use, please place
listener seats in the model and snap to them.
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Figure 13.16 Frequency response graph showing the direct SPL curves for the average, a selected point
(1) as well as the point currently hovered by the mouse (2).

13.7 Technical Remarks

SPL Calculation and Comparability

Even though the results in the main program are calculated using a newly-implemented simulation
engine, they are generally equal to the results in the calculation modules. The two implementations
differ with respect to speed and memory usage as well the spatial resolution that is offered. They also
differ with respect to bandwidth. The Acousteer engine in the main program makes use of the full
audio bandwidth from 20 Hz to 20 kHz whereas the calculation modules are limited to 100 Hz to 10
kHz.

The difference in bandwidth leads to the one and only difference in calculation results. Depending on
the input signal chosen and the bandwidth of the sound system, the absolute SPL quantities between
the two types of results can differ up to 1 to 1.5 dB when looking at 1/3rd octave bands. That is because
for a wider bandwidth, the input signal is distributed across more bands and therefore the level of a
single band is lower. If it is necessary to compare absolute levels, the bandwidth of Acousteer can be
limited to the bandwidth of the calculation modules. See section 5.8.5 for more details.

It should also be noted that the Acousteer results are subject to the same mechanism of dealing with
maximum SPL as the calculation modules (see section 9.4.1). Similar to an auto-gain, this mechanism
automatically limits the sound system to its maximum capability. The effect is particularly obvious
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when the sum gain applied to a loudspeaker exceeds 0 dB and the output SPL does not increase further
when the gain is increased. If there are multiple loudspeakers, the other loudspeakers are actually
decreased in output level in order to maintain the relative relationship (Figure 13.17). The resulting
gain reduction is called headroom in EASE and displayed in the loudspeakers table (section 9.6).

| Y ]S |

Figure 13.17 Gain limitation at maximum input voltage. Two identical loudspeakers driven at maximum SPL (left picture), right
loudspeaker at -6 dB gain (center picture), right loudspeaker at +6 dB gain (right picture). Both loudspeakers are reduced
equally in level so that the right loudspeaker does not exceed its maximum.

For further details about the SPL calculation methods in use please see section 19.2.1.

Trouble Shooting

There are several factors that can make the calculations not work properly when enabling the MAPPING
switch:

e [fthere are no sound sources or no audience areas in the project, a warning message is shown
indicating that no calculations can be made.

e If loudspeakers based on proprietary speaker models (DLLs) are part of the project, these will
not be included in the calculations. A warning message is shown in this case. It is recommended
to switch these loudspeakers off.

e If all sound sources in the project are muted or deactivated, the audience areas will show an
error texture.

e Desktop PCs and laptops typically have a graphics chip, either integrated with the main CPU or
as a separate graphics card. If there is no graphic accelerator available a warning will be shown.
As a result, the calculations may be slow. When using virtual machines, a graphic accelerator
can be configured if both the host and the guest system support one.

e If nocalculation results are shown or there are artifacts in the display, make sure that you have
the latest graphics drivers installed and that you have the latest version of EASE installed, as
well.

e In case of severe errors during the computation, an error window will be shown and the
software will try to end the calculation automatically. In these cases, please make sure that
you have installed the latest graphics drivers as well as the latest version of EASE.

Should you experience any problems and the above measures do not resolve them, please have a look
at our FAQ or contact the AFMG technical support team on the AFMG website.
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Figure 13.18 Texture on audience areas indicating that no calculations can be made. There are no loudspeakers or all
loudspeakers are muted or deactivated.

14 Room Mapping (EASE Eyes)

The room mapping module is used to visualize the room model in 3D. It is also used to perform
calculations for a set of points in the room, i.e., on audience areas, listener seats, and faces, and display
them in the form of a color mapping. Additionally, reflectograms or response functions of different
degrees of detail can be calculated for selected locations in the room, such as at user-defined listener
seats or freely placed recording positions (so-called Walker location).

This module has its own copy of the room model. If the project in the main program is changed by the
user, this is indicated by a yellow frame around the 3D view of the room mapping window. Use the
FILE > ACQUIRE PROJECT DATA command or the corresponding button from the tool bar to update the
Room Mapping copy of the room model.

14.1 View Settings and Functions

Several menus can be used to control the current view and to access additional information. These
menus are described in the following. For auxiliary functions located in the FILE and WINDOW menus,
please refer to section 14.5.

14.1.1 Views

The ITEM menu includes the following commands and settings relating to how elements of the room
are displayed:

e The display of room items can be toggled using the VERTICES, EDGES, FACES, LOUDSPEAKERS,
AUDIENCE AREAS and LISTENER SEATS menu entries.

e When looking from the location of a loudspeaker, the setting WITHOUT ME allows hiding the
case drawing of the respective loudspeaker.

e When OUTLINE ALL FACES is enabled, the border of every face is drawn in addition to its filling.
The option COLORED OUTLINES will use a neutral color for the border of the face instead of the
color of the face. This color can be adjusted in the OPTIONS window.

o The loudspeakers and audience areas that are currently active, i.e., used for calculations, can
be set using the SELECT ACTIVE ITEMS menu.
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The menu DIsSPLAY ACTIVE ONLY allows hiding loudspeakers and audience areas if they are not
active, that is, if they are not enabled for calculations.

The VIEW menu provides access to functions that control how the model is displayed:

The first group of commands consisting of 3D PERSPECTIVE, SIDE VIEW (X), END VIEW (Y),
PLAaN VIEW (z) allows switching the view angle to specific, preferred directions.

The REDRAW menu command can be used to refresh the view in case it has to be updated.

A click on FuLL VIEW resetsthe zoom factor and the screen location of the model so that it fits
the current window.

The Zoom IN and ZooM OUT commands can be used to enlarge or shrink the displayed size of
the model in the window.

When evaluating calculation results the FREQUENCY BAND menu item allows selecting the
current frequency. It can be used also to change the frequency band if the absorption spectrum
of the materials is used to determine the color of the faces.

Through the PERSPECTIVE VIEW menu, a loudspeaker or a listener seat can be selected as the
location for the viewer. This will switch the current view to central perspective mode. The
EXTERNAL VIEW command will switch it back to an orthographic (parallel) perspective with a
viewing location that is outside of the model.

The WALKER menu command will also switch to a central perspective view. It shows the Walker
window which provides controls to enter a user-defined location or move around in the model.
By means of this window, response calculations and auralizations can be started, also. The
actual position of the Walker is indicated by a small axis cross.

When looking at faces, they are by default shown only if their acoustically active side is aimed
at the user. When looking at the back side of a face, it is not rendered. This allows looking into
the room model from an external position like into a doll house. The INVERT FACES setting
reverses this mode so that only the back sides of faces are rendered and one can see the
outside boundaries of the room from an external viewing position.

If the SOLID RENDERING setting is switched off, then the model is shown in a wireframe style.

The DYE menu allows selecting the rendering color of the faces.

When WHITE FACES is on, all surface elements are rendered in white color.

The MATERIAL COLOR setting applies the color of the material assigned to the respective surface
element when rendering the room.

When MATERIAL ALPHA is activated, the absorption coefficient of the material assigned to the
face is used to determine the color of the face. The view depends on the current frequency.
The setting ALPHA SPECTRUM is based on the average absorption coefficient of each face. Darker
colors mean that more sound is absorbed by the surface, brighter colors mean less absorption.
The settings RANDOM GREY and RANDOM COLORS assign randomized arbitrary colors to the faces.
For mapping displays, several rendering options are available:

o The PATCH GRID option shows the result values in a continuous color map. Pixels
between calculation points are interpolated automatically.

o The ISOLINE PLOT options shows the results in a stepped color map with a user-
defined resolution for the step width of the isolines. The resolution can be customized
individually for each type of map using the STEP setting in the LEGEND COLORS window
accessible through the FILE menu.

o When using ISOLINE PLOT WITH OUTLINES setting, the iso-contours of the map are
emphasized by black lines.

o These settings apply to both, audience areas as well as faces.
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Figure 14.1 Color mapping using the Patch Grid option. Figure 14.2 Color mapping using the Isoline Plot option and

a resolution of 1 dB.

14.1.2 Navigating the View

Using the Mouse

The mouse can be used to interact with the model in different ways. For this purpose, several mouse
modes can be activated using the Mouse menu or modifier keys.

By default, the CENTER mouse mode is active. In the CENTER mode, a left-click will move the
location that was clicked on to the center of the window.

In the DRAG mouse mode, the left mouse button can be used to drag and drop the model in the
view area.

The TURN mouse mode can be used to rotate the model to a desired angle. The rotation is
performed at fixed zoom factor about a previously selected active point (PICk mouse mode);
If no such point is active; the zoom switches to full view.

The Zoom INand ZooM OUT mouse modes allow defining a rectangular portion of the view that
is enlarged or that the current view is shrunk to, respectively.

The P1ck mouse mode allows selecting room elements by left-click. It places the walker at the
selected location and opens the walker window for further actions.

More information about a specific location can be acquired using the PEEK mouse mode. When
active, a left-click on any room item displays the name of the room item, the 3D position and
the mapping value (if available). Keep the left mouse button pressed to display the information
for a longer time.

The PRINT VALUE mode can be used to insert the result values of the currently active mapping
into the 3D view. When active, a left-click on a room item with mapping data will print the
result value for the mapping point closest to the mouse coordinates.

In the PEEK and PRINT VALUE modes, the status bar also shows the result value for the point
closest to the mouse coordinates.

In all modes, the RMB can be used to rotate the model like in the main program of EASE 5. The MMB
can be used to pan the model and the mouse wheel can be used to zoom in and out.

Using the Walker Window

The so-called walker window (Figure 14.3) can be used to move the current view position when in
central perspective mode. In both central perspective and in parallel perspective mode, the window
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provides control over the location at which in-depth investigations can be carried out or an auralization
can be performed.

Open the walker window either using the VIEW > WALKER menu if you wish to switch to central
perspective, as well, or select the TooLs > MovE VIEW POINT menu command to only show the window.

In the window itself, the X, Y and z text fields allow entering the target coordinates if known. After
inserting them, press the button with the pointing finger to confirm. Alternatively, click on the arrow
buttons to move the view point in the direction of the respective axis. The distance for each such move
is controlled by the value entered in the STEP field.

Additional functions are available as follows:

o The walker button activates automatic movement in the view direction.

e The recording button enables the automatic walking function and allows saving the sequence
of renderings to a movie file.

e The microphone button opens the Probe module for analyzing the sound field and the time
arrivals at this location. This command is the same as ToOLS > INVOKE PROBE.

e The ear button starts the EARS module for auralizing the direct sound at this location. This
command is the same as TooLS > AURALIZE DIRECT SOUND.

e The eye button switches the view between parallel perspective from an external location and
central perspective from the view point.

e The lightning button can be used to run a quick ray tracing calculation in order to compute a
reflectogram for the first reflection orders at this point. The result can be viewed in the Probe,
in EARS or just saved to a file for later use. This command is the same as TooLS > LocAL RaAy
TRACING.

e The AURA button opens the setup dialog window for AURA Response calculations. This
command is the same as TooLS > CALCULATE AURA RESPONSE.

= 8= g
- o
- g B

-l

Figure 14.3 Walker window.

14.2 Calculating Mappings

Mapping results on audience areas, at listener seats, and on faces can be calculated using the MAPPING
menu. Before a mapping is calculated, the CALCULATION PARAMETERS setup window is shown in order
to configure important settings for the simulation. After the calculation, the MAPPING EVALUATION
window provides numerous functions to select different views and analyze result data sets. The LEGEND
window can be used to view and adjust the color scale for the mapping view. Mapping files that have
been computed previously can be loaded using the FILE > LoAD EASE MAPPING FILE menucommand.
The RECALCULATE MAP command restarts the most recently computed mapping.
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14.2.1 Standard Mapping

The most commonly used type of mapping can be started using the FILE > STANDARD MAPPING menu
item. The results are calculated based on the direct sound field and the statistical room acoustics using
the given reverberation time (see also 19.2). This type of mapping is usually fast but it is not very
accurate for rooms that do not satisfy statistical conditions, i.e., which have no uniform diffuse sound
field.

The CALCULATION PARAMETERS dialog has to be configured before the simulation can be started. It
consists of four tabs that have the following functions.

On the SETTINGS tab, it can be defined whether just a single result parameter, such as DIRECT SPL, or
all results should be computed. A LABEL can be entered for the mapping, as well. Also on this tab, the
loudspeakers for the simulation run can be selected or deselected and the patch size that defines the
spatial resolution for the mapping can be chosen.

Calculation Parameters X E]ICaIcuIation Parameters X
Settings T Iterns T Moise T Calculation Settings T T Moize T Calculation
Calculate M apping Faces in Use
¢ All Mappings " Single Mapping e Face | Face Group
Show First : |Direct SPL j ﬂ 1000 Hz j I OnSests Haone-
Label: |Ealculati0n #1 [ OnFaces
Loudspeakers in Use Feszolution
B Ll B Patch Size : [1oo Audience Areas in Use Listener Seats in Use
Left, Riight, L Aud. Area Area Group List. Seat Seat Group
Main Area, Haone-
| Nest 5 | Ok | Cancel | << Back | Hext > | Ok | Cancel |

Figure 14.4 Calculations parameters for standard mapping (1t and 2" tab).

On the ITEMS tab, one can adjust for which faces, audience areas, and listener seats the mapping is
calculated. They can be selected by individual items or by groups.

On the Noi1sE tab, the ambient noise level can be defined either by entering it or by loading it from a
file.

The CALCULATION tab controls a number of important calculation parameters:

e By switching on MAP WITH SHADOW, the shadowing effects that are caused by faces located on
the direct propagation path between sound source and receiver position are accounted for.

e The SPLIT TIME setting is used for determining the level and the clarity results for a user-
defined cut-off time in addition to the standard values of 7 ms, 50 ms, and 80 ms.

e For the direct sound, the contributions of loudspeakers in the room can be summed using the
power-sum method, if the loudspeakers are relatively far apart and rather incoherent, or using
complex summation, when cancellations have to be expected because loudspeakers are close
to each other and relatively coherent. If INTERFERENCE SUM is on, the complex summation
method will be applied.

o The PoT. ENERGY switch will include the potential energy based on the pressure and
thus compute the complex sound pressure sum. When KIN. ENERGY is enabled, the
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kinetic energy is considered by calculating the vector sum over the velocity vector
components of the incident sound waves, i.e., their directions. When none of both is
active, the complex summation will be calculation in the conventional way, that is, by
taking two times the pressure, assuming that the pressure part equals the velocity
part.

o The 1/3RD OCTAVE setting can be chosen to calculate the average over the respective
1/3™ octave band. The SINUSOIDAL ONLY setting will instead only consider the center
frequency of the band. In the latter case, cancellation effects will be more pronounced.
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4000 Hz N
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Figure 14.5 Calculation parameters for standard mapping (3™ and 4t tab).

14.2.2 Standard Mapping with Reflections (Standard and Pro Licenses only)

The STANDARD MAPPING WITH REFLECTIONS calculation method works very similar to STANDARD MAPPING.
However, it additionally includes early reflections based on a ray-tracing model. In rooms where the
reverberant field can be considered still as diffuse and statistical but where some first- and second-
order specular reflections are expected to be strong and should be included, this calculation may be
useful.

The initial CALCULATION PARAMETERS setup window is the same as for STANDARD MAPPING. After
confirming these settings, another window (Figure 14.6) allows determining the ray-tracing
parameters:

e The number of RAYS PER LOUDSPEAKER can be entered. Higher values mean more accurate
results but also longer calculation times.

e The ray-tracing process has two cut-off parameters that can be used, the reflection order
(ORDER) as well as the propagation delay (DELAY).

e The ray-tracing method is limited to RAY TRACING IMPACTS.

The ray-tracing simulation is stochastic. That means that results may change from run to run. If the
differences are significant, it is typically an indicator that the number of rays is too low or that the cut-
off parameters are too high. The density of rays must be high enough compared to the covered
propagation time in order to sample the room’s geometry sufficiently, in a stable manner.
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Notice that in contrast to STANDARD MAPPING this simulation makes direct use of the acoustic materials
assigned to the faces of the room. Merely available measured or predetermined reverberation time is
insufficient to use this method.

Reflection Mapping bt
tethod
i
Rays per Loudspeaker: [1000 & Ray Tracing Impacts
Control by
v Order: 3
[ Delay [ms]: | 100
0K | Cancel |

Figure 14.6 Calculation settings for mapping with reflections.

14.2.3 AURA (Pro License only)

Mappings calculated using the AURA module are the most complete simulations with respect to the
accurate modeling of the sound field. They use a ray-tracing approach over the full length of the
expected response time and include scattering effects by the surface elements. Accordingly, the
reverberation time can be calculated along with other acoustic results defined by ISO 3382. The AURA
mapping method makes no use of a measured or predefined RT. Like the STANDARD MAPPING WITH
REFLECTIONS and the LocAL DEcCAY TIME it requires acoustic materials to be defined for all faces.

The parameters for the AURA ray-tracing process are adjusted on the last tab of the CALCULATION
PARAMETERS setup window (Figure 14.7):

The number of particles (PARTICLES) controls the accuracy of the end result. It also affects the
overall calculation time. The given presets are based on mean-free-path approximations
where the HIGH setting should usually provide results that are sufficiently reliable in practice
and the Low setting gives a good first overview.

The LENGTH parameter corresponds to the cut-off time for the ray-tracing process. It should be
at least 2/3rds of the assumed reverberation time. The given presets are based on mean-free-
path approximations as well. For challenging spaces, the LONG setting is recommended.

The third value determines the scattering factor that is assumed for surfaces that have
materials without scattering data assigned. The recommended default is the so-called S-Curve
which is based on 10% scattering below frequencies of 1000 Hz and 40% scattering for
frequencies above that.

The last setting relates to the number of threads that will be used for the simulation. To use a
PC’s full computational power, the number should be chosen close to its number of cores.
Using all cores, however, is not recommended as it may lead to a non-responsive Windows
user interface.
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Figure 14.7 Parameter settings for AURA mapping.

14.2.4 Local Decay Time (Standard and Pro Licenses only)

The LocAL DECAY TIME mapping allows calculating the decay rate of the sound field at a receiver point.
It is based on a reverse omni-directional ray-tracing process that sends rays from each receiver point
and monitors their energy decay as they travel through air and are reflected by the boundaries. The
average decay rate for several rays can then be used to extrapolate a local decay time, i.e., after which
time the assumed sound field at the receiver has decayed by 60 dB after switching it off.

This approach does not require any sound sources. It is not only useful to estimate the RT at a given
point but also to analyze and better understand the spread of decay times across the room. If the
reverberant field is approximately statistical then the local decay times will be more similar. Note that
the local decay time cannot be compared directly with RT figures that are based on calculations with
highly directional sound sources.

The calculation settings are very similar to the settings for STANDARD MAPPING. However, on the last tab
(Figure 14.8) the parameters for the ray-tracing process need to be specified:

e The TIME setting determines the cut-off time, i.e., the propagation time up to which rays are
traced through the room.

e The ORDER setting is also a cut-off criterion. A ray is not traced anymore if the number of
reflections given by this setting has been reached.

e The NUMBER OF RAYS setting can be adjusted to higher values for more accuracy and to lower
values for shorter calculation times.

As with all other ray-tracing approaches, the stochastic nature of the simulation will lead to varying
results when several runs are made for the same settings. If the spread between runs is high, the
number of rays is typically too low or the cut-off criteria are too high.
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Figure 14.8 Calculation parameters for local decay mapping.

14.2.5 Viewing Mappings

After the calculation of a mapping has been completed or when a mapping file has been loaded, the
MAPPING EVALUATION window will be shown. A calculated mapping or a loaded mapping file typically
contains several or many mappings, such as for different frequencies or for different result figures.
These can be accessed by means of the window.

The window has a toolbar as well as five distinct tabs that display result details. The toolbar itself has
two rows. The top row contains a number of buttons that provide the following functions:

Minimizes the window or restores it to its normal size.

Loads mapping files.

Saves mapping files.

Exports a text file based on the current mapping file.

Removes the current mapping file from the list of loaded mappings.

Draws or redraws the currently selected mapping in the main window.

Redraws a number of different, preselected mappings automatically. Use the RENDER ALL
submenu to display the mappings at defined time intervals. Use the SEND ALL To FILE
submenu to render and save mappings and distribution graphs as picture bitmaps in a user-
defined folder.

8. Steps through all data points of the current mapping.
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Figure 14.9 Top row of toolbar.

The bottom row of the toolbar allows selecting the mapping file as well as the actual mapping from
that file:

o The first drop-down shows all loaded mapping files. Note that some may have been computed
but they may not have been saved yet.
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The second drop-down provides access to all types of results included in the mapping file, such
as DIRECT SPL or ToTAL SPL.

The remaining three drop-down lists allow selecting the frequency, the bandwidth as well as
the frequency weighting.

The tabs below the toolbar provide different views on the data in the mapping file and current

mapping.
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Figure 14.10 Mapping evaluation window showing the direct sound frequency response at a given location.

The FREQUENCY tab offers a range of different options that all relate to how the frequency response of
the chosen type of result is displayed:

The VIEW area at the lower left allows switching between the graphical display and the tabular
display of the data.

The SEND PICTURE To and SEND VALUES To buttons centered below the graph area facilitate
saving the graph as a picture or as a data set that can be processed further.

The CURSOR area shows the current mouse coordinates when moving over the frequency
response plot.

The SCALE controls allow defining a user-defined range for the y-axis.

On the right, different result curves can be switched on and off, including the AVERAGE as well
as the MAXIMUM and MINIMUM as computed over all data points.

The ECHOGRAM tab provides data only when an AURA mapping is selected. If that is the case, it displays
the energy-time curve (ECHOGRAM) by default.

Using the VIEW controls, the graph can be switched to show the HISTOGRAM. It displays the
number of detected particles over time. One can also switch to the echo criteria for speech
(EcHo SpPeEcH) and for music (EcHo Music). These quantities indicate the probability for hearing
an echo depending on the signal content.

On the right-hand side, additional energy overlays can be activated, namely the forward sum
(Sum), the backward integral (SCHROEDER) and a short-time integral (INTENSITY).
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e At the bottom, the TIME area allows selecting the displayed time range as well as the time
interval used for averaging (STEP).
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Figure 14.11 Echogram tab for AURA mapping results.

The third tab labeled FILE INFO displays a text log containing information about the calculation
settings and important room parameters as well as loudspeaker settings used for this mapping.

The DISTRIBUTION tab (Figure 14.12) provides statistical analysis results for the selected mapping. The
following options are available for detailed investigations:

e The VIEW area at the lower left allows switching between the graphical display and the tabular
display of the data.

e The CUMULATIVE DISTRIBUTION switch calculates the cumulated values for the distribution
function. For mappings where higher result values are generally better, such as SPL and STI,
the summation is conducted from higher values towards lower values. This allows
determining, for example, which minimum level or mean value can be guaranteed for the top
90% of the audience. For mappings where lower result values are better the summation is
performed from lower values towards higher values. For some kinds of mappings, the
cumulative distribution is not available, such as the arrival time.

e The SEND PICTURE To and SEND VALUES To buttons centered below the graph area facilitate
saving the graph as a picture or as a data set that can be processed further. Note that it is also
possible to create picture files for a set of distribution graphs automatically. For this purpose,
use the RENDER ALL ﬂ button in the main toolbar of the window.

e The CURSOR area shows the current mouse coordinates when moving over the frequency
response plot.

e The OPTIONS controls allow defining a user-defined maximum for the y-axis as well as the
interval width used for integrating the distribution classes.
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e The DISTRIBUTION settings allow adjusting range and resolution of the x-axis. Note that the
setting for the density of data points (SPACING) is distinct from the integration width (VAR.
WIDTH). These are usually the same but they do not have to be equal. The ALIGN setting
determines whether the integration interval is centered about each x-coordinate (CENTER),
left-aligned (LOWER) or right-aligned (UPPER) to it.

The settings for OPTIONS and DISTRIBUTION are specific for each type of map, i.e., DIRECT SPL or
ARRIVAL TIME. That means, user-defined intervals entered for one type are stored and recalled for this
type when switching between different types of mappings. However, these settings are remembered
only as long as the program is running; they are not stored permanently.
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Figure 14.12 Distribution statistics for a mapping.

Please note that the distribution statistics are calculated based on the triangles of the tessellated
audience areas and faces. It is assumed that the corresponding data points are dense and distributed
approximately homogeneously over the area. For audience areas and faces with highly irregular
shapes, it is recommended to insert listener seats in a grid pattern of the required resolution. Then the
exact distribution data can be calculated using listener seats only.

Finally, the OPTIONS tab (Figure 14.13) is concerned with the calculation of STl values as well as some
settings for other parameters.

On this page, the version of the STI standard can be selected in the EDITION section, the type of STI
(WEIGHTING) and which masking effects should be accounted for.

The STI OPTIMIZATION (Standard and Pro licenses only) section offers a number of functions that allow
determining the optimal signal level for a given noise level. This can happen in post-processing, i.e.,
after the mapping has been calculated. This is particularly useful for AURA raytracing calculations that
can take some time.

e The noise level can be reduced or increased by up to 60 dB relative to the initial calculation
settings for the mapping. If CONSIDER NOISE LEVELS is enabled, the effect of the adjusted noise
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level will be applied immediately to all STl results of the current map. Higher noise values will
degrade the STl and lower noise values will improve it.

e Similarly, the signal level can be reduced by up to 60 dB relative to the level that was set for
the mapping calculation. If CONSIDER SIGNAL MASKING is on, reducing the signal level will
typically improve the STl unless the S/N becomes too low or the hearing threshold is reached.
The optimum value for the signal level relative to the assumed ambient noise and the signal
masking effects can be determined automatically using the OpTIMIZE function.

e The SHow AVERAGE STI option allows displaying the average value of the STl across all data
points based on the current STl calculation options. For larger maps this calculation may take
a bit of time which is why it can be enabled and disabled. The calculated value equals the
average value shown on the DISTRIBUTION tab.

The RANGE FOR LOUDSPEAKER DENSITY setting allows adjusting the level range considered for the
loudspeaker density mapping. The 3 dB and 6 dB settings are most useful for determining how many
loudspeakers are heard at a similar level at the listening location. This result can be used to evaluate,
for example, if the loudspeakers used for source panning in spatial audio applications provide enough
coverage across the listening area. The 10 dB setting can be used to evaluate how many loudspeakers
are approximately audible at all. This result can be useful to validate whether the number and
distribution of loudspeakers used for establishing the reverberant sound field in immersive acoustics
applications is adequate. See also section 19.2.15.

E]I View Calculation #1 (Temporary)

BTN Wit ot |

s |Ealculati0n #1 [T emparany) j |DirectSPL j < | 1000 Hz j |Thirchtaveﬂ |N0 Z]Weighj

Frequency T Echaogram T File Info T Diistribution T
Edition of IEC B02E8-16 [STI) STI'weighting
(« Edition 5.0 (2020] * hale " STIPa Male™
" Edition 4.0 (2011, outdated) " Female™ " STIPa Female™
" Edition 3.0 (2003, outdated) " Unweighted™ " RaSTI™
* Dutdated
STI Table STI Calculation
¢ Show 5TV alue |v Consider Moize Levels v Consider Signal Mazking
" Show MTI Yalues 5T| Optimization
Fange for Loudspeaker Density adielioecbe R by L j
i« 3dB ™ 10dB Adjust Signal Level [dB] by: - |.1 an + Optimize
~
B8 [v Show fverage STI: 0.566

Figure 14.13 Options for the STl calculation. The example shows an average STl value of 0.566 for an assumed 12 dB increase
of the noise level and a reduction of -18 dB of the signal level after performing the optimization.

14.3 Calculating Response Functions

The TooLS menu provides access to a number of different features that allow calculating response
functions at selected positions, that is, detailed time response and frequency response information
that can also be used for auralization. These data sets carry more details about the simulated sound
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field at the receiver location than mappings. In consequence, they consume significantly more space
and are therefore calculated typically for only a few, representative points.

Generally speaking, there are two kinds of data files, the so-called response (RSP) files as well as the
binaural impulse response (BIR) files:

e RSP files contain the 4D (spatial and temporal) response function at a given position. They
include detailed information for each detected sound arrival, such as its arrival time, reflection
order, frequency spectrum, direction, source of origin, etc. The time-domain part of the
response function is also called a reflectogram in EASE. RSP files can be loaded in the Probe
module for analysis and can be converted to BIR files in the EARS module in order to listen to
them.

o BIR files are binaural files that are usually calculated by convolving an RSP file with an HRTF.
They are two-channel audio files sampled at a normal rate, such as 44.1 kHz or 48 kHz, that
can be used to listen to the simulated room.

In the TooLs menu, the Move VIEW POINT menu command opens the WALKER window. It provides access
to most of the commands that are available from the TooLs menu directly in the context of a user-
defined position in the room.

14.3.1 Direct Sound Response

The following four menu items in the TooLs menu all relate to the direct sound response at the current
walker or viewing location:

e The INVOKE PROBE command opens the Probe module. It shows the direct sound response at
the given position. If a PROBE window is already open, it will be updated whenever the INVOKE
PROBE command is executed again.

e The SAVE DIRECT SOUND RESPONSE command allows saving the response to a RSP file.

e C(Calling INVOKE EARS will save the direct sound response and open it in the EARS module for
further processing or for auralization.

e AURALIZE DIRECT SounD will directly open the auralization window of the EARS module.

14.3.2 Local Ray Tracing (Standard and Pro Licenses only)

The LocAL RAY TRACING menu command starts a ray-tracing simulation for the purpose of computing
early reflections at the selected location. The output result of the calculation is a reflectogram that can
be saved as a response file or viewed in the Probe or EARS module after completion.

Reflectogram at Walker x
Ll B | Method
i
Rays per Loudspeaker: | 1000 & Ray Tracing Impacts
Impact Chance :
Send Result To
Control by & Probe ® Bee
] et 3 " Onlp Save To File
[~ Delay[msg]: | 100
0K | Cancel

Figure 14.14 Calculation parameters for local ray tracing.

The following adjustments can be made for the calculation:
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e Select the loudspeakers that are used for the simulation using the LOUDSPEAKER and LSPK GROUP
buttons.

e Enter the number of rays that will be generated (RAYS PER LOUDSPEAKER). The more rays are
used the more accurate will be the result. However, the calculation time will also increase
accordingly.

o The IMPACT CHANCE will be calculated if a cut-off propagation time is given under CONTROL BY
> DELAVY. It is a percentage that indicates the probability for the receiver to detect rays.

e The cut-off criterion CONTROL BY > ORDER allows limiting the ray-tracing simulation by
reflection order. It can often be useful to limit the calculation by propagation delay (DELAY) as
well.

e Regarding the ray-tracing method, only the RAY TRACING IMPACTS option is available in this
case.

e The simulation result can be saved to a response file. It can also be opened automatically in
the Probe or EARS module for further analysis.

Notice that this method is typically used to determine early reflections in addition to the direct sound
response. Using the Probe module, the time response can be completed in length and density by
adding a tail. The tail can be predicted on the basis of the early response.

Finally, note that due to the stochastic nature of the ray-tracing process, results may differ between
simulation runs even when using the same parameters. If the differences are significant, it typically
indicates that the number of rays is too low relative to the cut-off criteria.

14.3.3 Calculate AURA Response (Pro License only)

In contrast to the limitations of the LocAL RAY TRACING method, full-length room responses can be
calculated using the AURA module. Use the TooLs > CALCULATE AURA RESPONSE menu command to
setup the simulation. This will open the AURA RESPONSE CALCULATION window that allows defining all
relevant parameters before starting the calculation run.

On the RESPONSE tab, the loudspeakers and the receiver locations used for the simulation can be
selected:

e Loudspeakers can be selected individually (LsPK) or by group (LSPK GROUP).

e The room response can be calculated for a user-defined position by entering the
corresponding values or for the current walker location by clicking on the walker button.
Activate the WALKER checkbox to use this setting.

e Response calculations can be carried out also for any of the listener seats in the model. Select
listener seats individually (LIST. SEAT) or by group (SEAT GRoOUP) and activate the LISTENER
SEATS switch.

On the CALCULATION tab, the settings for the ray-tracing simulation are determined. These are very
similar to those for AURA mapping calculations.

e The number of rays or particles (PARTICLES) controls the accuracy of the end result. It also
affects the overall calculation time. The given presets are based on mean-free-path
approximations where the HIGH setting should usually provide results that are sufficiently
reliable in practice and the Low setting gives a good first overview.

e The LENGTH parameter corresponds to the cut-off time for the ray-tracing process. It should be
at least 2/3rds of the assumed reverberation time. The given presets are based on mean-free-
path approximations as well. For challenging spaces, the LONG setting is recommended.

165



EASE 5 Third Edition — User’s Guide

Room Mapping (EASE Eyes)

The third value determines the scattering factor that is assumed for surfaces that have
materials without scattering data assigned. The recommended default is the so-called S-Curve
which is based on 10% scattering below frequencies of 1000 Hz and 40% scattering for
frequencies above that.

The last setting relates to the number of threads that will be used for the simulation. To use a
PC’s full computational power, the number should be chosen close to its number of cores.
Using all cores, however, is not recommended as it may lead to a non-responsive Windows

user interface.
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Figure 14.15 Calculation settings for AURA response.

Finally, the RESULTS tab allows defining the target file formats and where result files are stored.

The result file format selected in OUTPUT FILES can be a reflectogram (RSP response file with
spatial and temporal information), a binaural impulse response (BIR file), and a set of B-format
files (WAV format).

If selected for calculation, RSP files can be opened in the Probe module for further analysis or
loaded into the EARS module for processing and auralization. This choice can be made using
the SEND RESPONSE FILE TO settings.

The table at the bottom shows the target folder for all files. For each receiver location, user-
defined or listener seat, the file name can be given by clicking on the corresponding row. One
can also change the target folder in this way. Note that the table contains a column for each
type of output format (RSP, BIR, WAV).

Below the table, a PREFIX can be defined for the names of all result files. It allows distinguishing
them more easily from results of previous calculation runs.

The settings are confirmed and the simulation is started using the START SIMULATION button.

166



EASE 5 Third Edition — User’s Guide Room Mapping (EASE Eyes)

I Aura Response Calculation X

Room Acoustic Calculation by AURA Module (wd),
(Analysis Lility for Room Acoustics)
AURA Mapping based on CAESAR algorithms
derveloped by Aachen University (RWTH)

Fesponzse T Calculation T
Output Files Send Responze File to
[V Response File [RSP) (¢ Probe
™ Binaural Fil= [BIR] " Earz
[ B-Format Files [wial] i Only Save to File

| Respores Fil
blichDocurients' AFMGLEASESE vample Projectz\Auditoriurm’,
' alker ALIRA) 3

Fesult Files Prefix : |AU RA0004 g

I [ Readv for Simulation

<¢ Back | | Start Simulation | Lt |

Figure 14.16 Options for result output of AURA response: Response/reflectogram, binaural filters, B-format.

14.4 Utilities

The UTILITIES menu provides a number of auxiliary functions.

The SPIN function can be switched on and off. If it is on, the room model is rotated horizontally in time
and angle intervals defined in the OPTIONS window.

RECORD SPINNING also activates the automatic rotation of the model but it allows saving the sequence
of pictures to a file so that potentially an animation can be created based on them.

SHOW LEGEND displays the LEGEND window, if a mapping is loaded. The LEGEND window is shown
automatically if the corresponding setting in the OPTIONS window is enabled.

INSERT LEGEND adds the color legend of the current mapping to the main window. The legend is
inserted automatically if the corresponding setting in the OPTIONS window is enabled.

INSERT PARAMETERS displays the current view and calculation parameters in the upper left of the main
window. These parameters are shown automatically if the corresponding setting in the OPTIONS
window is enabled.

The AVERAGE AND R.M.S. command displays a small window reporting the average value and the
standard deviation for the currently displayed mapping. These values correspond to the data shown
on the DISTRIBUTION tab of the MAPPING EVALUATION window.

The LIGHTS ON switch controls how the 3D rendering is performed. If on, the main light source is placed
behind the viewer instead of at a fixed position relative to the room geometry. This lets faces change
their brightness when the view angle is changed, depending on their orientation.

14.5 Auxiliary Functions

The FILE menu of the RooM MAPPING module provides a number of functions that can be helpful for
analyzing or documenting calculation results as well as other functions related to the project and the
software environment:
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Use the ACQUIRE PROJECT DATA menu command to update the Room Mapping module with
the latest project data from the main program. This is necessary only if the RooMm MAPPING
window shows a yellow frame.

The LOAD VIEWER POSITION and SAVE VIEWER POSITION commands allow storing and recalling
the current location and view angle in a local file with the extension *.eye. This is useful for
reproducing user-defined views easily.

SAVE OPENGL FILE stores the current rendering of the room model in a single file which can
then be opened and viewed by third parties using the free EASE EGL viewer.

LoAD EASE MAPPING FILE loads a mapping file from the hard disk and displays it for further
evaluation.

Use SEND PICTURE To > CLIPBOARD to copy the current view to the clipboard. It can then be
pasted into another software application, such as Microsoft Word. Use the SEND PICTURE TO
> FILE command to save the current view to a file, for example, in PNG format. The PRINT
command will send the content of the window directly to the Windows printer.

The OPTIONS menu item opens the settings window described in section 14.6.

LEGEND COLORS provides access to the color legends used for the various acoustic mappings. In
the LEGEND COLORS window colors and associated values can be viewed and customized.

The TEMPORARY DATA FOLDERS menu item gives access to administrative functions. If temporary
data files have not been cleaned up automatically, they can be reviewed and deleted in this
window. This function can be particularly helpful if an extensive calculation run could not be
finished successfully and temporary data was left on the hard disk. The window is shown
automatically when the Room Mapping module detects orphaned folders on start-up.

The EXIT command closes the RooM MAPPING module including all of its windows. Any results
that have not been saved will be discarded.

The WINDOW menu can be used to control the size and location of the main window of the module:

The SCREEN QUARTER submenu allows moving the window to any of the quarters of the screen
or to the center. It will be resized to a quarter of the screen size as well.

The CascabE WINDows command will arrange all open windows in the upper left of the screen
in an overlapping format.

14.6 General Settings

The FILE > OPTIONS menu command opens the OPTIONS window of the Room Mapping module. On
four tabs various adjustments can be made that determine how the room is displayed and how the
program updates the view.

On the GENERAL tab, the following adjustments can be made:

The SHADING setting defines how much light is used when rendering the room. Higher
percentages will make those faces darker that the viewer is not directly looking at. Lower
percentages will make faces more similarly bright.

The Zoom ScoOPE can be used to determine the upper and lower limits for zooming in and out
in central perspective view (ANGLE) and parallel perspective view (FACTOR).

The SPINNING parameters define at which rate and at which angular intervals the view is
updated when the UTILITIES > SPIN function is on.
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e The COLORS area allows providing a user-defined color for the background of the view, for the
outlines of the faces as well as for inserted text.

On the ITEMs tab, the display of loudspeakers and listener seats can be adjusted:

e Loudspeakers can be rendered either using a wireframe symbol (RENDER SYMBOL) or their case
drawing (RENDER CASE).

e The symbols of listener seats can be drawn ignoring their orientation angles or including the
horizontal and vertical angle of the seat.

On the VIEW tab, a number of options define how the main view is updated when changes are made.
One can also define how the axes and the walker symbol are drawn.

The REDRAW adjustments are used to define at which point the room is redrawn or re-rendered while
changing the view parameters. For large rooms with many faces immediate updates may not be
practical.

e TheWHILE SCROLLING setting controls whether the room drawing will be updated while moving
a scrollbar or only after the scrolling is finished.

e The WHILE DRAGGING setting allows visually dragging the room with the mouse. If the setting is
off, the room rendering will be updated only after the mouse move is finished.

e The RE-RENDER ON TURN setting forces the complete redraw when changing the horizontal or
vertical view angle.

e The IF WITHOUT ME setting forces the re-rendering of the room when switching the view
location to the position of a loudspeaker and the ITEM > WITHOUT ME option is on. If the IF
WITHOUT ME setting is off, the view may be blocked by the faces of a case drawing until the re-
rendering is triggered in a different way.

The AUTO-REFIT settings determine when the rendered model is rescaled to fit the view area.
The SHow AFTER DRAW options are used as follows:

e AUTO INSERT PARAMETERS will automatically add the most important display and calculation
settings to the upper left area of the view area.

e AUTO INSERT LEGEND will automatically add the color legend to the view area, on the very right
of the main window.

e AUTO SHOW LEGEND WIinpow will automatically display the color legend window whenever the
room is redrawn for some reason.

Finally, the AXEs settings allow determining the size of the axis cross for the coordinate system itself
as well as for the WALKER location.

On the fourth tab labelled PANELS, the visibility of each information field in the status bar of the main
window can be toggled on and off.

15 Ray Tracing

The Ray Tracing module of EASE 5 provides functions for analyzing reflections and echoes in the room
as well as for computing the early part of the room response. However, these functions consider only
specular reflection paths. Scattering effects can be included using the AURA mapping and AURA
response functions accessed via the Room Mapping module. Alternatively, the early part of the
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computed room response can be complemented by a predicted tail using the functions of the Probe
module. The latter is a viable approach if the room of interest has a statistical reverberant field.

The results of the ray-tracing simulation can be subdivided into two types:

1. Traces are rays that have been emitted by a loudspeaker. These rays propagate through the
room and are reflected by boundaries until a cut-off criterion is met. They can be used to
understand, e.g., how a sound source excites the room.

2. Impacts are traces that have been detected at one or several selected listener seats.
Accordingly, all impacts received at a given location form a reflectogram and can be saved as
a response file.

Both types of results can be saved to files, called trace files or impact files, respectively. Impact files
can contain reflectograms for several listener seats.

The calculation functions of the module are accessed via the RAYS menu. Response results can be
visualized in the Probe module. Additionally, the View Project window is available to show trace and
impact results in a 3D wireframe view of the room model. It is opened automatically when starting the
Ray Tracing module and it can be opened manually using the VIEW > VIEW PROJECT command.

The Ray Tracing module keeps a copy of the room model. If the project in the main program is changed
by the user, this is indicated by a yellow frame around the main window of the ray tracing module. Use
the FILE > ACQUIRE PROJECT DATA command to update the room model kept by the module.

15.1 Calculating Traces

Use the RAY TRACING command from the RAYS menu to start the calculation of reflection patterns and
propagation paths.

E] Ray Tracing .
. Loudspeker || Lspk Group | Rays per Loudspeaker: [10g
Trace Cantral by Tracing Options

v Order: | 0 [ Draw Trace Hays
[ Time [mz] : | 1000 [ Show Evern Ray

[v Brief Bay Info
[ Make Trace Eile

0k, Cancel

Figure 15.1 Parameters for determining ray propagation paths in the room.

The RAY TRACING setup window is shown before the simulation is started. It can be used to adjust the
settings as follows:

e Loudspeakers used for the calculation can be selected individually (LOUDSPEAKER) or by group
(LsPk GRoOUP).

e The number of rays generated is determined by the RAYS PER LOUDSPEAKER setting. The more
rays are computed the longer is the time that the process requires to complete.
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e TRACE CONTROL BY: The ray-tracing process has to be limited by a cut-off order (ORDER).
Additionally, a time limit for the propagation delay can be specified as well (TIME).
e TRACING OPTIONS:

o The generated rays can be shown in the 3D room model by enabling the DRAW TRACE
RAYS switch.

o By enabling the SHow EVERY RAY switch, a data table will be shown for every ray. The
data displayed can be configured in the OPTIONS window. This analysis mode is
recommended only for very small amounts of rays.

o BRIEF RAY INFO shows an informational line in the main window indicating that a ray
has been processed.

o The MAKE TRACE FILE switch is used to store the trace results in a file that can be
opened and analyzed later. Note that trace files can become very large.

If a trace file was saved, the VIEW TRACE FILE window is opened automatically to inspect the file.

A previously stored trace file can be opened and viewed using the RAYS > VIEW TRACE FILE MENU
command.

Notice that the generation of traces can be limited to a number of faces in the room. This is possible
by selecting the faces of interest using the ITEM > FACES ON menu item and activating the ITEM >
USE ONLY SELECTED FACE switch.

15.2 Finding Impacts

Based on the generation of traces in the room, the response at selected receiver positions can be
determined by detecting any traces that hit a receiver. The process of finding impacts means checking
each trace if it has passed through the vicinity (detection sphere) of any selected listener seat. That is
why finding impacts involves two parts that must be configured, the generation of traces as well as the
detection of hits at the receiver.

Select RAY TRACING IMPACTS from the RAYS menu to setup the parameters for the simulation. In the
FIND IMPACTS window, the detection parameters are configured as follows:

e Loudspeakers that should be considered can be selected using the LOUDSPEAKER and LSPK GROUP
buttons.

e Listener seats for which a reflectogram should be determined can be selected using the
LISTENER SEAT and SEAT GROUP buttons.

e If the impacts found should be limited to a propagation delay shorter than the cut-off time for
the traces, this time can be specified using the IMPACT CONTROL BY > TIME setting. If switched
off, traces will be included at their full time length.

e Similar to how traces are managed, any impacts found can be drawn in the 3D model using
DRAW IMPACT RAY or displayed as a table using SHoWw EVERY IMPACT. A short notice can be
displayed in the main window whenever an impact was found using the BRIEF IMPACT INFO
switch.

e Traces can be generated automatically or read from a previously saved trace file by enabling
READ TRACE FILE.

e By activating the MAKE IMPACT FILE setting the impacts found are saved in a file along with the
full geometrical and level information. This allows viewing and analyzing the data at any later
point of time.
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I Find Impacts

Lzpk Group |
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[ Read Trace File
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Figure 15.2 Default parameters for finding impacts.

After the configuration of the impact parameters the setup window for generating traces is shown as
described in the preceding section 15.1. The only difference is that in this case, also the IMPACT CHANCE
is calculated and displayed if a cut-off time is specified. The impact chance corresponds to the
probability that hits are found and increases with the number of rays.

I Ray Tracing

Lzpk Group |

Trace Cantral by

v Order: |3
v Time[ms]: | 1000

Impact Chance | 2096 =

Ravs per Loudspeaker: | 10000

Tracing Options
[ Draw Trace Bays
[ Show Evern Ray
[ Brief Ray Info
[ Make Trace Eile

ak. Cancel

X

Figure 15.3 Trace generation when finding impacts.

If an impact file was saved, a prompt will be shown after the calculation is complete that allows viewing
the results in the VIEW IMPACT FILE window.

A previously stored impact file can be opened and viewed using the RAYS > VIEW IMPACT FILE MENU

command.

15.3 Viewing Trace and Impact Files

The VIEW TRACE FILE window and the VIEW IMPACT FILE window are very similar. They only differ
with respect to the fact that impact files always refer to reflectograms at listener seats. That is why for
impact files the listener seats of interest can be selected and the Probe module can be called for further
response analysis. These options are not available for trace files.

172



EASE 5 Third Edition — User’s Guide Ray Tracing

On the FILE tab of the window a number of general functions are provided in the TooLS area:

INSPECT HEADER shows an information log about the calculation parameters and project
settings.

DRAW ALL RAYs iterates through all rays and renders them in the 3D wireframe view.

DRAW BOUNCES iterates through all rays and renders the reflection points as small squares. The
POINT WIDTH setting can be adjusted if the rendered points are too small.

WIPE RooM clears the 3D wireframe view from any rays and bounces.

INVOKE PROBE opens the Probe module for a selected listener seat. This does not only allow
further viewing and analyzing the reflectogram. The Probe can be used also to select rays that
are then highlighted in the Ray Tracing module.

In the SELECT area, the active loudspeakers and listener seats can be determined. The POINT WIDTH
setting controls the sizes of the squares indicating bounces and particles in the 3D wireframe view.
Since some of the information displayed is frequency-dependent, the frequency can be chosen here

as well.
E] Wiew lmpact File project2.mpc — >
F||e T Bay T Movie T Color ]
Tools Select

Inspect Header | Loudspeak.er

LeneliRers | Listerer Seat

Draw Bounces | Pt it |3_

"Wipe Boom |

Invoke Probe | | 1000 Hz j
Figure 15.4 File tab of the view impact file window.
On the RAY tab of the window, controls are provided that allow selecting and viewing each ray
individually:

In the DRAWING area, DRAW RAY determines whether the currently selected ray is rendered in
the 3D wireframe view. The WIPE OLD setting removes the previously rendered ray from the
drawing when a new ray is selected. Clicking on the KEEP RAY button will remember the
currently selected ray and not remove it if WIPE OLD is on. The CLEAR ALL button will remove
all rays including the remembered ones from the drawing.

The RAY area allows stepping through the rays stored in the file and selecting them using
various controls.

The CURRENT area displays further information about the currently selected ray, such as its
source of origin, the sequence of reflections, the propagation time and the level.

Notice that when the Probe module is open at the same time, a ray selected in the Ray Tracing module
is highlighted in the Probe and vice versa. This allows, for example, to select a reflection with a high
level in the Probe and investigate its propagation path in the 3D wireframe view.
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Figure 15.5 The ray tab allows stepping through all traces or impacts.

The MoviE tab allows visualizing the propagation of simulated sound rays as a function of time. Since
the directional sound wave represented by a ray is traveling through the room as time moves forward,
its position can be indicated by a point or line in the room at each point of time. The entirety of sound
waves can therefore be also represented as a cloud of particles that expands with time.

The following commands and settings control the display of the cloud:

e Select the time frame of interest and the update interval using the TIMER area.
e |n the CoLOR area the color of the rays can be adjusted according to their properties such as
reflection order or level.

o By default, previous locations of the particles are removed from the rendering at each
step. When BEAM is on, these locations are kept and therefore create the impression
of an expanding beam or line instead of a moving particle or point.

o When NIGHT is on, the background color is set to a dark blue for better contrast.

e The PLAYER controls provide functions for starting and stopping the animation as well as
moving forward and backward in time step by step.

I Yiew lmpact File project2.mpc — 3
e | -
Tirner
Time [ms] ] O From |n To [toon Step [ 1
Colar

{o Fiwed o Order ¢ SPL  Loss [ Beam [ Might

Player

= || = [ = |g e | wee |

Figure 15.6 The movie tab displays the calculated rays as a cloud of particles expanding with time.

The COLOR tab is directly associated with the MovIE tab. It is used to define the colors used by the movie
functions.
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Figure 15.7 The color tab can be used to set the colors for the movie animation.

15.4 Local Ray Tracing

The LocAL RAY TRACING command provides a shortcut to directly creating a response (RSP) file instead
of dealing with trace or impact files first. It works in the same way as the command in Room Mapping,
see section 14.3.2 about local ray tracing.

15.5 Auxiliary Functions

There are a number of additional functions in the RAYS menu that can be useful for the following
purposes:

e SPLIT IMPACT FILE saves the contents of a given impact file in several impact files, one for
each listener seat included in the original.

e SAVE ASs RESPONSE FILE saves a given impact file as a response (RSP) file. Response files still
include the precise information about the sound arrivals but they do not include the
geometrical information about the reflection path.

e UPDATE TRACE FILE updates a given impact or trace file with respect to level, absorption, and
delays if the project was changed. Geometrical changes cannot be accommodated, such as
when the position of faces has changed or the coordinates of listener seats.

e INSPECT TRACE FILE shows the log for a given impact or trace file providing information about
its calculation parameters and project settings.

15.6 Options

The OPTIONS window of the Ray Tracing module can be accessed using the FILE > OPTIONS menu item.

The first tab labelled RAYS allows setting the colors used for traces and for impacts. On the second tab
the data can be selected that is displayed when traces or impacts are shown as a table (SHow EVERY
TRACE, SHOW EVERY IMPACT options).
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Figure 15.8 General settings of the ray tracing module.
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16 Probe Post-Processing

The Probe module of EASE works similar to a measurement tool and is used to analyze response
functions or so-called reflectograms. These are datasets that contain information about discrete sound
arrivals, so-called pulses, at a definition position in the room. Each pulse has an arrival time, a level and
a frequency response, as well as a direction of incidence. A pulse possibly carries further information
like the reflection order. In addition to the pulses, the response file may also include information about
the room’s general properties, such as its name, as well as its acoustic parameters that allow estimating
the reverberant field, such as volume and surface area.

A reflectogram typically consists of many pulses and can be displayed in the time domain, in the
frequency domain and in various other ways. Acoustic quantities can be derived from it such as
reverberation time, clarity or speech intelligibility. Furthermore, a reflectogram can be convolved with
an HRTF to generate a binaural filter file or it can be simply saved as a monaural impulse response or
wave file.

Response (RSP) files or reflectograms can be generated in different ways in EASE. They can be
computed directly using ray-tracing methods or extracted from impact (MPC) files.

Generally speaking, there are two ways how one can open the Probe module:

e The Probe can be opened in standalone mode from the main program. In this case, the Probe
can be used independently from the currently loaded project and any settings. It can be used,
for example, just for viewing result files that already exist.

e The Probe can be opened also from the Room Mapping or Ray Tracing module. In this case, it
is bound to the respective parent module and will be updated according to data managed
there. One cannot open response files independently, instead the response data is received
automatically from the parent module.

The Probe module consists of a main window that provides access to all of the data. There is also an
OPTIONS window that deals with user settings as well as some auxiliary windows. Most importantly,
the EARS module can be called from within the Probe in order to further process the response data.

16.1 Views and Graphs

All diagrams and graphs can be accessed through the GRAPHS menu. Some of these graphs are
frequency-dependent. In those cases, the frequency can be chosen using the VIEW > FREQUENCY BAND
menu command. In some graphs, such as the reflectogram, items can be selected using the mouse if
the Mouse > PIck mode is enabled. For more details about view settings and controls, please see
sections 16.1.6 and 16.1.7. A number of context functions are additionally available using the RMB
menu.

16.1.1 Time Response
The TIME RESPONSE submenu provides access to the following graphs:

e REFLECTOGRAM shows the response data in its primary form, namely as discrete pulses that are
characterized by a level and an arrival time. The level displayed for each pulse depends on the
current frequency. Red pulses indicate direct sound arrivals; blue pulses represent direct
sound arrivals from below and green pulses stand for reflections. Deactivated pulses are
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shown in grey. When selecting a pulse with the mouse, more details are shown in the status
bar.

e SHORT TIME PERIOD shows the early part of the response in ps instead of ms. Other than that,
the graph is identical to the REFLECTOGRAM view. While the REFLECTOGRAM graph is used to
analyze the room response, the short reflectogram is provided for analyzing direct sound
arrivals and signal alignment.

e WATERFALL shows the level over time and over frequency. Each pulse is represented by a slice
that has an arrival time and a frequency response. The waterfall is a 3D view that can be
rotated. The waterfall display can be used, for example, to obtain an impression of how the
frequency response changes over time as sound propagates through the room.

o  PHASE ANGLES displays the reflectogram data in a polar diagram where the radius corresponds
to the level and the angle corresponds to the phase value of the pulse at the selected
frequency.

e IMPULSE RESPONSE shows the broadband impulse response computed from the reflectogram.
It is calculated by first converting the frequency response of each pulse into an impulse
response (IR) and then summing all of these single impulse responses in the time domain.

e ENERGY TIME CURVE corresponds to the log-squared impulse response and shows level as a
function of time.

The settings for these diagrams and renderings can be modified on the PULSES tab and the LEVELS tab
of the FILE > OPTIONS window.

16.1.2 Frequency Response

The FREQUENCY RESPONSE submenu allows analyzing the spectral behavior of the selected pulse or of
the entire set of pulses in the frequency domain.

e SINGLE PULSE shows the frequency response for the current pulse.
e PULSE SuMshows the summed frequency response of all pulses considering their arrival times.
Both the level of each frequency sample as well as the 1/3" octave average are displayed.

The settings for these graphs can be adjusted on the frequency response (FRQ. RsP.) tab of the FILE
> OPTIONS window.

16.1.3 Pulse Directionality

The PULSE DIRECTIONALITY submenu provides views that characterize the direction of incidence. These
views depend on the currently selected frequency.

e HORIZONTAL shows a polar diagram where each pulse is shown as level over horizontal angle.

e VERTICAL shows a polar diagram where each pulse is shown as level over vertical angle.

e 3D HEDGEHOG is a 3D view that displays a spherical coordinate system where the level of the
pulse corresponds to the radius from the origin and the direction of incidence corresponds to
the respective horizontal and vertical angles. The settings for the graph can be changed on the
PULSES tab of the OPTIONS window.

16.1.4 Reverberation and Level

The REVERBERATION submenu includes a number of graphs that are related to the modeled reverberant
field of the room.
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REVERBERATION TIME shows the currently defined RT curves. These may include the
reverberation time defined in the project (PROVIDED), the RT curve based on the SCHROEDER
backward integral over the reflectogram, the EYRING RT and the SABINE RT for the current
project, as well as the LocaL RT. Onthe REv. TIME tab of the OPTIONS window the data of any
of these curves can be viewed and made current.

TOLERANCE RANGE is the same graph as REVERBERATION TIME but it additionally includes the
upper and lower bounds of a tolerance range based on the acoustical standard selected on the
TOLERANCE tab of the OPTIONS window.

PRESSURE LEVELS displays a graph of level over frequency with curves using different criteria
for the time cut-off. These are calculated based on the pulses of the reflectogram and the
reverberant energy estimate. The settings for this graph can be adjusted on the LEVELS tab of
the OPTIONS window.

16.1.5 Clarity, Definition and Speech Intelligibility

The EXPECTATION VALUES submenu displays acoustic quantities that can be derived from the response

data.

CLARITY MEASURES shows a diagram of the C7, C50, and C80 clarity ratios in dB. Details of the
graph can be adjusted on the LEVELS tab of the OPTIONS window.

MTF / STI displays the modulation transfer functions (MTF) as well as the speech
transmission index (STI). The calculation parameters and colors for this graph can be accessed
on the MTF/STI tab as well as on the NOISE tab of the OPTIONS window.

16.1.6 Adjusting the View

The following mouse modes can be activated using the MOUSE menu:

Activate the P1ck mode to select items in the diagram. This mode is available only for some
graphs, such as REFLECTOGRAM or WATERFALL. If an item is selected, additional information is
displayed in the status bar.

Use the LOCATION mode to show the diagram values at the location of the mouse, temporarily
using a left-click and permanently using a right-click. This mode is available only for some
graphs, such as REFLECTOGRAM or FREQUENCY RESPONSE. Select VIEW > REDRAW to refresh the
graph and remove any inserted text.

The CENTER and DRAG mouse modes can be used to change the view limits and move the curves
within the diagram area.

Use the ZooM IN mode to enlarge the selected part of the diagram and the Zoom OuT mode to
shrink the diagram area to the selected rectangle.

At any time, standard view limits can be reinstated using the VIEW > FULL VIEW menu command. The
ZooM IN and ZooM OUT commands in the VIEW menu can be used to quickly adjust the zoom level of
the diagram without using the mouse.

For 3D views, such as WATERFALL and 3D HEDGEHOG, standard view directions can be selected from the
VIEW menu: 3D PERSPECTIVE, SIDE VIEW, END VIEW, PLAN VIEW.

Double-clicking on the title of a graph opens the OPTIONS window and shows the configuration page
for the current graph.
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Double clicking on the x- or y-axis of any 2D graph opens the LEGEND tab of the OPTIONS window where
the view limits and axis settings can be adjusted. The CHANGE GRID command of the VIEW menu has the
same function.

16.1.7 Additional Functions

The VIEW > FREQUENCY BAND command allows changing the current frequency. The setting applies to
graphs that show data for only one frequency band, such as the REFLECTOGRAM.

The VIEW > PREVIOUS and VIEW > NEXT menu commands can be used to move back and forth between
recently selected graphs.

The REFLECTION ORDER menu in the VIEW menu can be used to highlight pulses of a user-defined
reflection order.

The FILE > SEND PICTURE To menu commands allow copying the current graph as a bitmap to the
clipboard or saving it to an image file.

16.1.8 Additional Information

The VIEW > INSPECT DETAILS menu command shows the INSPECT DETAILS window. It gives an
overview over important points of time such as the reverberation onset as well as over the energy
distribution with respect to direct sound, reflections, and reverberation.

Inspect Details (1000 Hz) *
Times [mz] Energiez [dB]
First Speaker 0.0 Tirne [nkereal: Direct Reflact. Rewerb.
Lazt Speaker: 245

Dir. Mean Time: 51 Befare Split: 728 BE.2 E0.1

Feverh, Onsst 271 Split Till Diffuze: - B0 B35

Splt Tie: 320 After Diffuze; - E&.1 .7

Diffuge Time; 800 Total SPL: 725 0.7 738

Figure 16.1 The Inspect Details window provides information about the energy distribution of the response.

Use the VIEW > RESPONSE INFO menu command to show an information log about the calculation
parameters and project settings.

In the UTILITIES menu, the SPIN function can be activated for the WATERFALL and 3D HEDGEHOG views.
When enabled, the displayed object rotates continually in the horizontal plane.

16.2 Further Processing and Editing

Besides various graphs that provide information about the time response and frequency response of
the room at a given location, the Probe also offers a range of functions that allow modifying and
processing the response data.

In the TooLs menu, the INVOKE EARS command can be used to open the EARS module. Here, the
response file can be converted to a binaural impulse response (BIR). Subsequently it can be viewed in
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different ways and also auralized. Also, the TooLS > AURALIZE REFLECTOGRAM menu item of the Probe
can be used to convolve the reflectogram directly and listen to it.

If AFMG’s measurement suite EASERA is installed on the computer, the TooLs > INVOKE EASERA
submenu allows opening the response file in EASERA by saving it as a WAV or BIR file.

Inthe UTILITIES menu, the RANDOM PULSES command will generate a set of arbitrary pulses that replace
the current reflectogram. This function is available only in the standalone mode of the Probe module.

The EDIT > TURN DumMmy HEAD function can be used to change the orientation of the measurement
probe relative to the original angles. The menu command opens the HRTF tab of the OPTIONS window
to make these adjustments.

Use the EDIT > GAIN AND SAMPLE RATE command to adjust the sampling rate as well as the FFT order.
These are parameters used for generating the frequency response, the impulse response as well as
other audio output files.

The reflectogram can be modified with respect to the pulses it includes. Individual pulses can be
switched on or off, reflection orders as well as the direct sound of defined loudspeakers or all of their
pulses. Such modifications can be helpful to analyze the response file in more detail and understand
the effect of certain components of it on the end result. The aforementioned modifications can be
made using the EDIT > ACTIVATE and EDIT > DEACTIVATE menu items.

16.3 Adding a Tail

If a response file was calculated using specular ray-tracing methods, for example using local ray tracing
or find impacts functions, and does therefore not include late reflections or diffuse pulses from
scattering effects, it can be useful to add a tail that consists of pulses. The tail can be predicted based
on the information about the room and the early reflections. It is typically more accurate than the
reverberation estimate provided by statistical acoustics according to Eyring but it will be less accurate
than full-length calculations.

The Probe module offers two tail generation methods:

e EDIT > ADD RANDOM TAIL creates a set of pulses that are matched to the level of the response
at reverberation onset and to the reverberation time of the room.

e EDIT > ADD PREDICTED IMPACTS extrapolates the existing set of impacts towards greater times
by evaluating the properties of this set statistically.

Note that depending on the quality of the reflectogram, in particular the pulse density at early times,
the tail creation may not be able to deliver practical results. In those cases, it is recommended to rerun
the ray-tracing process with a higher number of rays or lower cut-off values.

After adding a tail, all results calculations will consider the artificially generated pulses. In order to
remove the tail again, use the EDIT > CuT RANDOM TAIL menu command.

16.4 File Management

In standalone mode, one can open response (RSP) as well as impact (MPC) files and load them into the
Probe module for further analysis and processing. EASE Post files are text files that can be imported as
well. These functions are available through the FILE menu.
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Current data can be saved to a file using the FILE > SAVE As menu. The currently loaded reflectogram
can be saved as a response (RSP) file (RESPONSE FILE) or as a post file in text format (POST FILE). It can
also be saved as a monaural impulse response in BIR or WAV format. Additionally, the modulation
transfer functions (MTF TABLE) corresponding to the STI calculation for the current reflectogram can
be stored in a text file.

Post files and MTF files can also be opened for viewing in a text viewer using the VIEW FILE submenu.

16.5 Options

The OpTIONS window of the Probe module allows modifying the settings for all graphs and displays. It
also provides access to calculation parameters and other important controls. It can be opened using
the FILE > OPTIONS menu item or by double-clicking on the caption of a graph.

On the GENERAL tab of the window (Figure 16.2) the following settings can be changed:

e For displays where distances or dimensions are used, the LENGTH UNIT can be switched
between METERS and FEET.

e The DEFAULT GRAPH setting determines whether the Probe always launches with the
REFLECTOGRAM diagram or with the graph used last.

e The SELECT FONT button in the DIAGRAM area allows choosing the type font that is used for the
windows and graphs.

e In the CoLOR area the background color for all diagrams (BACKGROUND) can be selected as well
as the color of the displayed text (TEXT COLOR).

e The SPINNING area provides controls to adjust the time interval and the differential angle used
for the SPIN function. The function can be activated via the UTILITIES menu.

3

[ BevTime | Tolerance | HRTF | MTF/STI | Levels | Panels

General T Pulzes T ﬁchmederT Frq.Rsp. T Legend T Hoize ]

Length Unit Diagram
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Select Font ‘
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Drefault Graph Coolor

+ Reflectogram l:l B ackground

" Previous Graph - Text Color
Spinming
Time Step [ms] ﬂ J ﬂ 1000
Angle Step [deq] ﬂ J ﬂ 2

QK | Cancel ‘ Apply ‘

Figure 16.2 The General tab allows adjusting various parameters.
On the PULSES tab (Figure 16.3), adjustments for the REFLECTOGRAM and WATERFALL views can be made.

e DIsPLAY PRECEDENCE shows the precedence curves of the first sound arrivals. These curves
determine which of the early pulses is perceived as the main source of sound, both with
respect to time as well as with respect to direction.
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D1IsPLAY SCHROEDER adds the curve of the Schroeder backward integral to the reflectogram.
The Schroeder integral can be enabled on the SCHROEDER tab where also related settings are
available.

WITH REFLECTIONS determines whether pulses representing reflections are shown or just the
direct sound.

The ToTAL DELAY TIMES setting allows viewing the diagram on an absolute time scale, that is,
without reference or normalization to the first arrival.

By enabling the EcHoGRAM display, the reflectogram will be switched to a display that does not
show individual pulses anymore but sum energies integrated over intervals of the specified
time length.

SoLID RENDERING lets the WATERFALL display the frequency response of each pulse as an opaque
slice. If the setting is off, the slice is shown as a wireframe.

For the WATERFALL display the scales of the time axis and the level axis are relative to the
frequency axis. Use the LoCcKk SCALING PER OCTAVE setting for this purpose. They allow
stretching or compressing the respective axis relative to the frequency axis.

Options >

[ BevTime | Tolerance | HRTF | MTFASTI | Level: | Panel

General Pulzes TﬁchroederT Frg.Rzp. T Legend T Moise

L

Reflectogram el aterfall
[~ Display Precedence [~ Solid Rendering
B [ Lock Scaling per Octave to:

v with Reflections
[ .07 ms | 12 dB

[ Taotal Delay Times
[~ Echoagram, Bin[ms]: |1

QK. | Cancel ‘ Apply

Figure 16.3 Settings for the reflectogram graph and the 3D waterfall are made on the Pulses tab.

On the SCHROEDER tab (Figure 16.4), a number of settings relating to the Schroeder backward integral

are available:

The REGRESSION INTERVAL determines the section of the time axis that will be used to calculate
the decay rate. It does not have to be the full length of the response.

ADD ENERGY DUE TO IMPACT CHANCE will calculate and compensate for the energy of missing
impacts based on the impact chance calculation of ray tracing runs. This option is available
only for impact files that were calculated with a time cut-off.

ADD ESTIMATED EXPONENTIAL TAIL ENERGY includes energy estimated based on the statistically
calculated or given reverberation time to the energy of the pulses contained in the
reflectogram.

INCLUDE PULSES OUTSIDE START/STOP TIMES will consider all pulses over the entire length of
the response instead of just the regression interval.

DRAW SCHROEDER CURVE INTO REFLECTOGRAM shows the curve of the backward integral as well
as the regression line in the REFLECTOGRAM diagram.
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After making changes to the calculation settings, use the COMPUTE button to refresh the results.

I Options >

[ BevTime | Tolerance | HRTF | MTFASTI | Level: | Panel
General T Pulzes TﬁchmederT Frg.Rzp. T Legend T Moise ]

Schroeder B ackward Integral

Regrezsion Interval [mz]:

Start: [ Stop: [go0

I Add Energy Due to Impact Chance
I Add Estimated Exponential Tail Energy
¥ Include Pulzes Outside Start/Stop Times

v Draw Schroeder Curve into Reflectogram

Caormpute

ak. Cancel ‘

Figure 16.4 The Schroeder tab serves for defining the integration parameters.

On the frequency response tab (FRQ. RsP.), Figure 16.5, adjustments for the GRAPHS > FREQUENCY
RESPONSE displays can be made. The summation of the frequency responses of the pulses of a
reflectogram can happen in different ways. Subsequent pulses are added coherently using energy and
phase information, namely using standard complex summation considering two times the pressure
part (INTERFERENCE SuM), considering only the pressure part (POT. ENERGY), considering only the
velocity vector (KIN. ENERGY), and including both pressure and velocity (KIN. + POT. ENERGY). The
curves for all four methods can be shown and adjusted individually. Separate settings are available for
the unsmoothed results as well as for the band-averaged result. The color of each curve can be set as
well. The DEFAULT COLORS button resets the colors.

The SAMPLING RATE and the FFT ORDER settings control the resolution of the frequency response. The
curve can be shown using Z-weighting or A-weighting, depending on the LEVELS IN DB (A) switch.

I Options >
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oK | Cancel ‘ Apply ‘

Figure 16.5 Calculation and display parameters for the frequency response on the corresponding Options tab.
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The LEGEND tab (Figure 16.6) is used to control the view limits and axis settings for each diagram. Select
the type of graph (DIAGRAM) and the X-AXIS or Y-AXIS on the left. Then adjust the caption of the axis,
the range displayed, the spacing of the ticks as well as the number of subticks on the right.

Use the DEFAULT LEGEND button to reset the settings to the original. CALC MIN/MaX can be used to
determine the RANGE based on the currently loaded response. In that case DEFAULT TiIcks allows
deriving the range and the number of ticks accordingly. Lock AXIS has to be activated to override the
auto-scaling and keep the axis settings permanently whereas the CAPTION and GRID settings are always
applied immediately and permanently.

I Options >
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Figure 16.6 The Legend tab controls the settings for the axes of the Probe diagrams.

On the NoISE tab (Figure 16.7), the ambient noise level can be defined either by entering the spectrum
in 1/3" octave resolution or by loading it from a file.

[ Options d
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Figure 16.7 The ambient noise level affects the STI and ALCons calculations.

The settings on the REv. TIME tab (Figure 16.8) control which RT curves are displayed when the
REVERBERATION TIMES graph is selected. On the left, the table of 1/3™ octave-band RT values for the
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CURRENT curve is shown. These can be based on the PRoOVIDED RT as defined in the project, the RT
calculated using the SCHROEDER backward integral, the EYRING and SABINE RTs for the current project
or the LocAL RT for ray-tracing results. The color of each RT curve can be defined, as well, by clicking
on the corresponding rectangle.

[ Options d
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Figure 16.8 The reverberation time tab allows selecting and adjusting the curves displayed in the corresponding diagram.

On the TOLERANCE tab (Figure 16.9) the RT target range can be defined that is displayed in the TOLERANCE
RANGE graph. The DoLBY and THX tolerances are fixed curves that do not need to be configured. The
STANDARD tolerance depends on the value for the desired RT. By clicking on one of the RooM PURPOSE
buttons, the desired RT value at 1 kHz is inserted in the field labelled REVERB. TIME [S] AT 1 KHz.
Alternatively, this value can be entered manually.

[ Options d
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Figure 16.9 On the Tolerance tab the RT target range can be defined.

The settings on the HRTF tab (Figure 16.10) are used to determine how a monaural or binaural impulse
response is calculated from the reflectogram.

186



EASE 5 Third Edition — User’s Guide Probe Post-Processing

- SAMPLING RATE and FFT ORDER define the time length and frequency resolution of the result
data. These settings are used also for the FREQUENCY RESPONSE calculation.

- The Dummy HEAD settings for HOR. ANGLE and VER. ANGLE allow adjusting the direction of the
measurement probe or listener. Changes here will affect also the PULSE DIRECTIONALITY
graphs such as the 3D HEDGEHOG.

- The PHASE options determine how the phase response is computed for each pulse when they
are summed to form a broadband response function.

[ Options d
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Figure 16.10 Calculation parameters for the impulse response can be defined on the HRTF tab as well as the reference
direction.

On the MTF/STI tab (Figure 16.11), settings relating to the calculation of the modulation transfer
functions and the speech transmission index can be adjusted. On the left hand, the color for each 1/1
octave modulation frequency can be chosen. On the right hand, the edition of the IEC 60268-16
standard for STI can be selected. Corrections for the MTF and STI based on background noise level as
well as signal level masking can be switched on or off when their influence is of importance.

[ Options d

|/ Gerneral T Pulzes TﬁchmederT Fro.R=p. T Legend T Hoize

Rev.Time | Tolerance | HRTF | MTFE/STH|  Levek | Pargls |
Octaves Edition of IEC BO2E3-16
1H: [ & Edition 5.0 (2020)
200 Hz
- (" Edition 4.0 (20711, outdated)
sooH: [
1000 Hz I:I " Edition 3.0 (2003, outdated]
2000 Hz - Caleulation
4000 H
: - [ Consider Noige Levels
8000 H
: I:I [~ Conszider Signal Mazking
Default Colars

|

QK Cancel Apply

Figure 16.11 Calculation and display settings for the MTF/STI graph.
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The LEVELS tab (Figure 16.12) can be used to make adjustment to the PRESSURE LEVELS and CLARITY
MEASURES graphs with respect to which curves are shown and which colors are used. The colors of the
IMPULSE RESPONSE and ENERGY TIME CURVE can be chosen as well. Regarding the CuT-OFF TIMES, the
SPLIT TIME for the SPLIT LEVEL can be entered as well as the DIFFUSE TIME. The diffuse time
determines the point of time from which on an estimate of the diffuse sound field is used instead of
simulated reflections. If there are no reflections, the reverberation onset time will be used instead.

m
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Default Colors

QK. | Cancel ‘ Apply ‘

Figure 16.12 The Levels tab allows adjusting various display parameters as well as the split time and diffuse time settings.

On the last tab labelled PANELS (Figure 16.13), the visibility of each field in the status bar can be toggled
on and off.
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Figure 16.13 On the Panels tab the status bar display can be configured.
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17 EARS Auralization

The EARS module of EASE 5 is used primarily for auralization. Auralization is the process of simulating
and making audible the effects of playing a known reference sound, such as program material, through
a defined loudspeaker system in a particular space. It allows listening to the room before it is even
built and therefore allows adding subjective impressions to the design process.

As a starting point, response files provided by other modules of EASE are loaded into EARS. In EARS
they are converted into binaural impulse response (BIR) by convolving them with a defined head-
related transfer function (HRTF). A BIR file can then be used as a filter file for auralization with a dry
input signal, may it be from a file or from a live source.

In addition to the auralization of a mono input signal using a binaural filter file there are more functions
in EARS. They include conversion between different file formats, additional convolution possibilities as
well as mixing functions.

17.1 Auralization with a Single Input

Response files can be opened using the FILE > OPEN RESPONSE FILE menu item. This is the starting
point for running an auralization for a simulation result.

17.1.1 Creating a BIR Filter File

To perform an auralization based on a response file, a BIR file has to be computed using the EDIT >
MAKE BINAURAL RESPONSE command. This will open the BINAURAL IMPULSE RESPONSE window for
creating BIR files. In this window, the input and output file can be defined, in RSP and BIR format,
respectively. With respect to calculation options the following parameters can be adjusted:

e The sample rate (SAMPLING RATE [Hz]), FFT ORDER and frequency resolution (RESOLUTION
[Hz]) can be defined in the FILTER SAMPLING area. Note that the resolution or the FFT order,
respectively, will be updated when the other parameter is changed.

e The PHASE COMPUTATION options determine how the phase response is computed when the
pulses of the response are summed to form a broadband response function.

e Inthe HRTF area, settings related to the simulated listener can be adjusted, i.e., the gain (SPL
GAIN), the view direction (DuMmy HoR, DuMMy VER) as well as the HRTF to be used.
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Figure 17.1 Creating a binaural impulse response (BIR) from a response file (RSP).

17.1.2 BIR Filter Info

After the computation of the BIR is complete, the filter transfer function can be viewed. Either confirm
the corresponding question after the calculation or select GRAPHS > BIR FILTER INFO. This will display
a window showing the left-ear and right-ear impulse response at the top as well as an information log
with calculation parameters and project settings at the bottom. Double-click on the graph to switch to
the frequency response. Double-click again to switch back to the impulse response. Right-click on the
graph for more display options.
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Figure 17.2 BIR Filter Info window showing the left- and the right-ear channel as well as the calculation log.

17.1.3 EARS Convolver

Finally, open the EARS CONVOLVER window using the TooLS > AURALIZATION menu command. The
window consists of two distinct parts. The area on the left-hand side acts as a player that allows
selecting input and output as well as the currently active FIR filter. The configuration panel on the right-
hand side allows adding and removing FIR filters and adjusting their gain. In the CONVOLVER area the
convolution engine can be chosen. The LAKE CONVOLVER allows real-time convolution using live
program material from any Windows source. The EARS CONVOLVER works on a file basis, only. The
INSTALL FIR button confirms the selected choices and hides the panel. Alternatively, the FILE >
INSTALL FILTERS menu item can be used to switch from configuration mode to play mode.

More FIR filters can be added by pressing the Abb FIR button on the right-hand panel or by pressing
the TooLs > Abb FIR FILTER FILE menu. FIR filters can be loaded in BIR format, WAV or TIM format.

More options relating to the management of FIR filters and the auralization process are available in
the menu of the window.

When in play mode, the configuration panel can be opened again by pressing the EJECT button or
selecting the SPECIFY FILTER menu item from the FILE menu.
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Figure 17.3 EARS Convolver window in configuration mode.

17.1.4 Additional Tools

After a BIR filter file was loaded or created, the AURALIZE WAVE FILE command from the TooLS menu
can be used to directly play the convolution result for a given input wave file.

The TooLs > PLAY WAV FILE menu command opens the EARS player window in order to select and
play a wave file.

17.2 Auralization with Multiple Inputs

17.2.1 Stereo Convolver

The stereo convolver of EARS can be started using the TooLs > STEREO CONVOLVER menu item. It allows
auralization of a stereo system, that is, a system with two signal channels. For this purpose, two BIR
filter files are required, as well, one for the left part and one for the right part of the loudspeaker
system.

Other than that, the stereo convolver works very similar to the EARS Convolver introduced in section
17.1.3. In configuration mode, the right-hand panel is open and can be used to specify the two BIR filer
files as well as the relevant parameters like GAIN, DELAY sampling rate (RATE) and FFT size (FRAME SIZE).
Clicking on INSTALL BIRs will close the configuration panel and switch to play mode. In the left-hand
part of the window the input signal as well as the output channel can be defined. The gain can be
adjusted as well. Pressing EJECT will switch back to configuration mode.
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Figure 17.4 Stereo convolver in configuration mode.
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17.2.2 Multi-Channel Auralization and Mixing

The wave file mixer of EARS can be opened using the TooLs > WAV FILE MIXER menu command. It
allows specifying a number of wave files as well as an output wave file. For each input file, DELAY and
LEVEL can be defined. These parameters are used for combining all input files to a single output file.

In EARS, one can also create mix of more than two convolution channels. This function can be accessed
through the TooLs > CONVOLVE AND MIX menu item. For each channel, the input signal can be defined
in WAV format as well as the filter file in BIR format. The resulting WAV file can be specified and played
after the calculation is complete.

M convahve & Mix — O >
E;“ Input Channel #1
Input W F add |
Addway Waste WY | G | MALEVOICE Wity ~]
" Lewvel [dB]: Time [ms]: Waste ‘
Input ek File[s) % | 5 | 0
| MALEWOICE Wiy |
Delay [ms]: Level [dB]: Input Filter File
| 0 | 0 |prniect3.bir ﬂ
Gain [dB] Delay [ms] 8
i 10 92.88
Dutput Wiy File o | | "
|$Dutput$.wav @
[ Moo [ Play J sum
Dutput \AaY v Flay
M ‘ Esit ‘ G |$0utputy. wav T

Figure 17.5 Wave file mixer (left) and Convolve & Mix function (right).

17.3 Conversion Tools

Creating Lake SIM files works very similar to creating BIR files. Use the EDIT > CoMPUTE SIM FILE
menu command to open the corresponding window. Please refer to section 17.1.1 for more details
about the settings.
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Using the EDIT > CONVERT FILE FORMAT menu, filter files can be converted between different formats.
The CONVERT FILE FORMAT window allows selecting the input file that should be converted and the
output file that will be created.

The EDIT > MoDIFY BIR FILE menu command opens the MoDIFY BIR FILE window. It can be used
to change the primary properties of a BIR file. The SAMPLING RATE can be modified, the PEAK LEVEL,
and the DELAY TIME.

Most filters based on room impulse responses have an initial delay that corresponds to the arrival time
of the signal. EASE stores this delay in the header of the wave file. For applications unaware of this
header, the delay can be added as a number of zeros to the samples of a wave file. Use the EDIT >
WAVE FILE DELAY PADDING menu commands for that purpose.

The EDIT > BATCH PROCESSING function can be used to conduct several calculations in an automated
sequence. The details are configured using the batch processing window:

e BIRfilter files can be computed from RSP response files using the same set of settings that can
be defined for the manual computation (section 17.1.1).
e WAV files for auralization can be computed based on an input WAV file and an input BIR.

The resulting sequence of steps can be executed right away (RUN) or stored for later use in EARS
command file format (ECF) by pressing SAVE.

To run an existing batch processing file that was previously configured use the EDIT > EXECUTE COMMAND
FILE menu item.

17.4 Further Tools

Several functions in EARS allow selecting an HRTF in order to create a binaural impulse response from
a reflectogram or response file. These HRTFs can be viewed using the GRAPHS > HRTF submenu. For
each available HRTF the DRAW BALLOON window can be opened. It visualizes the HRTF data in 3D.

EARS also includes a compact signal generator that can produce different kinds of audio signals and
store them in a wave file. This function can be started using the TooLS > GENERATE SIGNAL menu.
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18 Material Editor

The material editor of EASE 5 can be used to view material files in MAT format, to modify them or to
create new files. The material editor is started from the main program using the SURFACES > MATERIAL
EDITOR ribbon menu.

The main window of the editor is subdivided into two parts. On the left, the data of the currently
loaded material can be viewed and modified. On the right, a diagram shows the absorption coefficient
or the scattering coefficient as a function of frequency.

Use the FILE > NEW WALL MATERIAL command to create a blank material with default information.
Using the OPEN WALL MATERIAL command, a material (MAT) file can be loaded into the editor. The SAVE
WALL MATERIAL and SAVE WALL MATERIAL As menu commands allow saving the current material to a
file. The FILE > SEND PICTURE To submenu is used to copy the current graph to the clipboard or save
it to an image file.

The WALL MATERIAL tab on the left allows defining a LABEL and a DESCRIPTION for the material as well
as a CoLOR. The COEFFICIENTS tab contains a table that can be edited. The ABSORPTION coefficient as
well as the SCATTERING coefficients can be entered in a resolution of 1/3™ octave bands.

If only 1/1 octave band values are known, these data points can be interpolated using the EDIT >
INTERPOLATE ABSORPTION and EDIT > INTERPOLATE SCATTERING menu items.

The FILE > CALCULATE SCATTERING menu can be used to compute the scattering coefficient based on
typical surface structures.

The diagram on the right can be switched between absorption data and scattering data by activating
the VIEW > ABSORPTION or VIEW > SCATTERING menu items, respectively.

[Tl special Carpet - Material Editor — O X
File Edit View Window Help
Wall Material Coefficients . )
Al Hatena Absaorption Values of Special Carpet
Label : 1
|Special Carpet
09
Degcription ;
Tuned carpet abzorption data for testing. 0s
07
0E
05
Info;
04
Specular Beflection
| zotropic 03
Diffusive Reflection 0.z
Lambert Law 01
. I
Color: [N _Chenge | 125Hz  250Hz 500Hz 1000Hz 2000Hz 4000Hz 8000 He
Freguency | 10000Hz Walue 047

Figure 18.1 Material editor showing the absorption curve for a test data set.
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Note that materials that are part of the EASE 5 database can be saved to a MAT file and loaded into
the material editor for modification or adaptation (see also section 8.1).

Like for the calculation modules this document provides only an overview about the functionality of
the material editor. Further details can be found by accessing the help function of the module using
the F1 shortcut as well as on the AFMG website.
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19 Appendix A — Calculation Background

19.1 Acoustic Parameters Window

The following definitions apply to the calculations in the main program, primarily related to the
ACOUSTIC PARAMETERS window.

Average Absorption Coefficient

The absorption coefficient a for an acoustic material is a function of frequency f. It is typically given in
a frequency resolution of 1/1 or 1/3™ octave bands for a part or all of the audible spectrum between
25 Hz and 20 kHz [5]. In the following, the frequency f« represents the center frequency of frequency
band k.

The average absorption coefficient is calculated as the arithmetic mean absorption coefficient across
all surfaces i of the room based on their respective surface areas S; and assigned wall materials with

absorption coefficients ai(k). The average value @ can then be computed for each frequency band k as

follows:
_ 1 k
g0 = S E as;

where S is the total surface area of the room:
S = Z Si

Equivalent Absorption Area [m?] of a Material

The absorption area A](.k) of a material j is the product of the surface area S; covered by this material

and the absorption coefficient aj(k):

) _ ()
A] = (Xj Sj

The broadband equivalent absorption area A; is calculated as the frequency average over the
absorption area:

Ny

1 k
A =— (k)
J Nfz ;

k=1
where Nfis the number of frequency bands.
The total equivalent absorption area of the room is given by

Nmat

A0 = A%
j
-

j
Where Ny,¢ is the number of materials.
Surface Area [%] of a Material

The percentage surface area rs;of a material jis calculated as the surface area S; covered by the material
relative to the total surface area S of the room:
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T —imow

Reverberation Time

The reverberation time T of a room based on the Eyring model [6] is given by:

%4
Tevrine = K
Eyring = T 4my — SIn(1 — @)
Where k; = 24]: 10~ 0.161 s/m, c is the speed of sound in m/s, V is the room volume in m3, S the

total surface area in m?, & the average absorption coefficient, m the coefficient for sound attenuation
by airin m?* withm = Q,ir Where a,;, is the sound attenuation coefficient in dB/m as defined

by 1SO 9613-1 [7].

10loge

The Sabine equation is an approximation of the Eyring equation for reverberant environments where
the average absorption coefficient is small (& «< 1).

|74
Tsabine = krm

Notice that due to this mathematical approximation, the Sabine equation will typically yield greater
reverberation times than the Eyring-based RT. In spaces, where the diffuse-field condition is not met,
for example due to the room geometry or unevenly distributed absorption, the reverberation time is
also usually higher than the Eyring-based RT. In those cases, the Sabine equation may provide results
closer to practically measured reverberation times even though the conditions for applying it are not
fulfilled.

In EASE, a warning message is shown when the Sabine equation is applied for average absorption
coefficients greater than 0.15. If in doubt, it is strongly recommended to use the AURA ray-tracing
module of EASE and not to rely on models of reverberation that are based on assumptions of a
statistical diffuse field.

Schroeder Frequency

The Schroeder frequency of a room determines the transition frequency above which at least three
modes overlap in the modal spectrum [8]. This means that below the Schroeder frequency the acoustic
characteristics of the room are dominated by a few discrete modes whereas above the Schroeder
frequency the frequency response of the room is governed primarily by stochastic processes.

T/s

V/m?3 Hz

fschroeder = 2000

Note that T is a function of frequency because it depends on the average absorption coefficient & and
on the coefficient a,;- of sound attenuation by air. Both are frequency-dependent quantities. For
calculating the Schroeder frequency in EASE, the largest value across all frequency bands is
determined.

Note also that the initial definition of the transition frequency by Schroeder related to ten overlapping
modes leading to a factor of 4000 instead of 2000 in the equation above. The latter was determined in
an update to this research.

The Schroeder frequency is often used as a rough approximation of the lower limit of validity for the
assumptions of statistical and geometrical acoustics. Accordingly, below this frequency the acoustics
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of a room is dominated by discrete standing waves and above this frequency by a statistical diffuse
field.

19.2 Types of Maps

The following section provides an overview over the various types of mappings available in EASE. Many
of these acoustic quantities are frequency-dependent. If so, the frequency and the bandwidth can be
selected in the software. For SPL figures the weighting (Z or A) can be selected, as well.

For additional background information on the calculation modules, please refer to the respective help
files that can be opened by pressing F1 or using the HELP > HELP TOPICS menu entry. In particular,
have a look at the help appendix referenced there as well as the literature given in chapter 21.

The following mappings can be calculated using the STANDARD MAPPING function. When using this
function, the reverberant energy and all derived measures are calculated based on the statistical
Eyring/Sabine reverberation model. The Direct SPL mapping can also be calculated using the Acousteer
real-time engine.

19.2.1 Direct SPL

The direct sound pressure level measures the sound energy arriving from the loudspeakers on a direct
(line of sight) path at the receiver. For each loudspeaker, the received level is determined based on the
distance of the loudspeaker, its direction, the electrical power supplied to the loudspeaker and the
properties of air. The contributions of all loudspeakers are summed at the receiver location.

Single Source

The direct sound pressure level can be expressed as:

|pdir|2
2

Lgir = 10log o

Where pg = 20 pPa is the reference sound pressure and pg;, is the complex-valued sound pressure of
the direct field. For a single sound source, it is given by:

1 . _m,
Paie = e A, p)Ue 2

where 7 is the distance between source and receiver, and A(9, @) represents the complex-valued
directional far-field transfer function of the loudspeaker [1]. It depends on the horizontal angle ¢ and
the vertical angle 9 of the receiver relative to the loudspeaker. The input voltage applied to the

loudspeaker is defined by U and the air attenuation is given by m as defined above. The phase change

. . . —i 2 2nf .
over the propagation distance is represented by e ~*" where k = 7” = %f is the wave number, A the

wavelength, f the frequency in Hz and c the speed of sound.

The directional transfer function A(¥9, @) can be expressed as the product of the on-axis sensitivity
I, = A(0,0) in Pa m/V and the relative angular directivity ratio I'(9, ¢):

A(‘ﬁ, <P) = 1—‘0 F(‘L9, (P)
This allows writing the direct sound pressure level in the form [9]:

Lgir = Lx + 10log Po; — 20logr + 201log|T (¥, ¢)| — a7
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Tol?Zres . e . z .
where L = 10 log%ﬁrEf is the on-axis sensitivity levelindBat 1 m, 1 Wand Pg = ZU— is the electric
0 ref

input power in W given a reference impedance of Z..¢ = 8 Ohm.

In this general model, the sound source produces a spherical wave that has an approximately planar
wave front at the location of the receiver.

Multiple Sources

Different assumptions can be made about how the signals of several loudspeakers sum up at the
receiver. For coherent sources typically the complex summation method is applied and for incoherent
sources the power summation method.

In EASE, a loudspeaker object often consists of several sources, for example, when considering the
drivers or channels of a multi-way loudspeaker, a line array or a column loudspeaker. Such sources are
always treated coherently.

For the summation of loudspeakers, the program allows choosing between power summation and
complex summation upon the start of the calculation. In reality, coherence is usually given for low
frequencies or relatively small distances. Incoherence can typically be assumed for high frequencies or
large distances [1].

Note that the Standard Mapping calculations (section 14.2.1) exclude late loudspeakers from the
Direct SPL summation. If the signal arrives later than 80 ms relative to the perceived arrival time, the
contribution of the loudspeaker is ignored. In contrast, Acousteer (section 13) and AURA (section
14.2.3) direct field calculations always consider all sound sources independent of their arrival time.

Power Summation

In the case of power summation, the square of the total pressure equals the sum of the individual
pressures squared:

|psum|2 = |p1|2 + |p2|2 +...

This assumes that the phase relationship between sources is random and can therefore be neglected.
This type of result will not show the effect of wave-based cancelations or additions such as caused by
run time phase differences.

Interference Sum (Default)

When using the INTERFERENCE SUM option, the complex-valued pressure amplitudes are summed first,

then squared.
|psum|2 = |P1 +po+... |2

This is the standard method of calculating the effect of interference between sources when considering
a stable phase relationship. The computation uses the potential energy part which is doubled in order
to account for the kinetic energy part. This method is exact for a planar wave, but only an
approximation for the superposition of waves with different propagation directions.

INTERFERENCE SUM is active if neither POTENTIAL nor KINETIC ENERGY are checked.

Potential Energy

The pressure part of the energy density is calculated as follows:

1
— 2
Wpot = —2p0c2 lpy + ot ...
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where p is the equilibrium density of air.
Kinetic Energy

The velocity part of the energy density is calculated as follows:

1
Wkin = m |kypy + koot ... |2

Where k is the normalized wave vector. This formula is valid only for the superposition of plane sine
waves. If all vectors k are parallel, wy;, equals wpot.

Potential Energy + Kinetic Energy

The sum energy density is calculated as the sum of potential and kinetic energy density:
Wsum = Wpot + Wkin

Note: In practical acoustical calculations waves are assumed to be planar at the receiver, not spherical.
If, in the real world, the system produces planar waves then one will obtain results that are very similar
to the interference sum calculations. Also, in the real world, measurements can only be done in the
pressure domain using microphones. Kinetic energy is the velocity component of the total energy. Its
effect is not in use in sound reinforcement but it does affect interference at very specific angles, e.g.,
orthogonal (90° apart), where the pressure values can cancel each other but the velocity vectors
cannot.

19.2.2 Total SPL

The total sound pressure level represents the sum of the direct sound energy and the reverberant
energy. For standard mapping, the reverberant energy is calculated based on the Eyring or Sabine
reverberation time and the overall power radiated by the active loudspeakers.

Lyot = Lgir + Lrev
The energy density of the reverberant field is given by

4P,
cA

Wrey = 1-a

Where P, is the total acoustic power the sound sources feed into the room [6], [9].

19.2.3 S/N Ratio

The signal-to-noise ratio in terms of level is equal to the difference of Total SPL and the background
noise level.

LS/N = Lot — Lnoise

If the SNR is 0 dB, the signal is as loud as the noise. For good speech intelligibility, signal levels should
typically be 10 to 15 dB above the noise floor.

19.2.4 Lspk Overlap

The loudspeaker overlap quantity is given by the ratio of the direct sound energy of the sum of all
loudspeakers relative to the loudest loudspeaker.
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This parameter can be helpful when analyzing the coverage of sound systems if any part of the
audience should be covered by only one source, approximately. In that case, the quantity should be
between 1 and 1.5 which means that the direct sound received originates largely from a single sound
source. A value of 2 or more indicates that there are two or more similarly loud loudspeakers.

19.2.5 Critical Distance

The critical distance (or reverberation radius) is defined as the distance 1y from a sound source where
the direct energy equals the reverberant energy [6], [9].

Lgir (T'H) = Lrey

For an omnidirectional source and based on the Eyring/Sabine statistical model, 1y can be computed
from the total absorption area A of the room:

A

"™MZ Ten

In EASE, the mapping at receiver points is shown in multiples of the critical distance. That means, for
example, a value of 2 indicates a distance twice the critical distance. Generally speaking, values larger
than 1indicate that the reverberant energy is greater than the direct energy. Values less than 1 indicate
that the direct field is dominant at the receiver location.

19.2.6 D/R Ratio

The direct-reverberant ratio in terms of level equals the difference of the direct SPL and the level of
the reverberant field.

LD/R = Lgir — Lrev
Looking at the distance from a given sound source, the parameter is 0 dB at the point where the direct

energy equals the reverberant energy, i.e., at critical distance ry.

Being an early-to-late energy ratio, the D/R ratio is often considered a good indicator for speech
intelligibility and clarity.

19.2.7 First Arrival

The first arrival corresponds to the propagation delay from the loudspeaker to the receiver.

r
tarr = E + tpelay

It is formed by the sum of the time that the sound wave needs to travel through air to the receiver and
the delay that is applied to the loudspeaker by any filters, tpelay- When there are multiple active
loudspeakers the arrival time is given for the loudspeaker that is localized based on the Haas
precedence effect [9].

202



EASE 5 Third Edition — User’s Guide Appendix A — Calculation Background

19.2.8 ITD Gap

The initial time delay gap equals the time difference between the arrival time t,.. of the first
loudspeaker and the loudspeaker arriving next in time.

19.2.9 Clarity Measures

The clarity measures represent the ratio of early energy to late energy expressed in dB. The cut-off
time separating early from late energy can be 7 ms, 50 ms, 80 ms or a user-defined split time,
respectively.

C7

This is the ratio of energy before and after 7 milliseconds in decibels. This parameter is used to predict
the strength of the perceived direct sound of sources.

™ () 12dt
;o Ip@®)|2dt

Any value greater than —15 dB allows a good localization of the sound source. The closer the value is
to 0 dB the better the localization.

C; =10log

C50

The definition C5q measures the intelligibility of speech and singing [10], [11]. Generally, it is calculated
for the bandwidth of 4 octaves between 500 Hz and 4 000 Hz. It corresponds to the ratio of the energy
received during the first 50 ms and the energy received later.

L™ p(o)2dt

*® 2
Jso mslP @12 dt
A value greater than 0 dB in a standard room allows good speech intelligibility of the sound source. A

value greater than -5 dB in a more reverberant than normal room allows good speech intelligibility of
the sound source.

Cso = 101log

When looking at Cs( as a frequency-depending parameter, it should increase by about 5 dB per octave.

See also the definition measure D in [10].

Cc8o0

The clarity Cgg describes the temporal transparency of musical performances [10], [12]. It corresponds
to the ratio of energy before and after a cut-off time of 80 ms.

L™ p@)2dt
Joa melP(OI2dt

This parameter is used to predict the articulation of different modes of music. This articulation is
dependent upon the speed of the music, the type of instrument and the reverberation of the room.

CSO = 10 lOg

There are four types of instruments:

1. Blown instruments (e.g., organ, tuba, clarinet, etc.) These instruments have a slow attack and
slow decay.
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Bowed instruments (e.g., violin, viola, cello, bass etc.) These instruments have slightly quicker
attack and slow decay.

Plucked instrument (e.g., guitar, string bass, harpsichord, etc.) These instruments have quick
attack and medium-slow decay.

Percussive instruments (e.g., piano, drums, electronic instruments, xylophone etc.) These
instruments have a quick attack and a quick decay.

The scale of C80 is as follows:

0 +/- 2 dB is ideal for Organ or blown instruments played at slow rate of speed. This is perfect
for organ recital halls.

2 +/-2 dB is ideal for bowed instruments and is best shown by a room made for classical or
symphonic instrumental music. The speed of the music is quicker. The music of live choirs is
also good at this level. This would be good for traditional churches.

4 +/-2 dB is ideal for plucked instruments. The speed of the music is quicker as well as more
modern. This would be described as folk music or in churches as Light Contemporary. This
would also cover light popular music such as Light Jazz.

6 +/-2 dB is ideal for percussive instruments. This can be described best as Rock and Roll. In
churches this will be known as Full Contemporary.

The value for a good clarity measure Cgy depends strongly on the musical genre. For romantic music,
a range of approximately -3 dB < Cgq < +4 dB is regarded as being good, whereas classic and modern
music will allow values up to + 6 to 8 dB.

At no point should the number exceed +8 dB, if music is to be performed in this venue.

Csplit

This quantity is defined as the ratio of energy before and after the user-defined split time tg;q.

Jy " Ip(0)de
2 Ip(®)]7dt

split

Cspiit = 10 log

The parameter can be used to investigate early/late energy ratios for different cut-off times, such as

35 ms.

19.2.10 Pressure Levels

The early level quantities correspond to the energy received early in time. The cut-off time can be 7
ms, 50 ms, 80 ms or a user-defined split time, respectively.

L7

This level represents the energy arriving very early within 7 ms.

L50

7T Ip)I?
2

L, = 1010g_[ dt

0 Po

This level represents the energy arriving within the first 50 ms.

50 ms |p(t)|2
2

LSO =10 logf dt

0 Po
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L80

This level represents the energy arriving within the first 80 ms.

80 ms |p(t)|2
2

L80 = 10 logf dt

0 bo
Lsplit

This level represents the energy arriving within the user-defined cut-off time tgp;.

fspiie [p (8|
2

Lsplit =10 lng dt

0 Po

19.2.11 STI

The speech transmission index STl is a measure for speech intelligibility and is computed according to
IEC 60268-16 [13]. For full standard compliance the input signal should be set to the speech spectrum
as defined by the standard. Signal and noise masking should be switched on, as well.

STl values can be roughly qualified as follows:

e >0.75 excellent
e 0.60t00.75 good

e 0.45t00.60 fair

e 0.30t00.45 poor

e <0.30 bad

Additional settings for the STl calculation can be made on the OPTIONS page of the MAPPING EVALUATION
window (section 14.2.5).

19.2.12 Articulation Loss

The articulation loss of consonants (ALCons) is also a measure for speech intelligibility [14], [15]. In
EASE, it is derived from the STl using the Farrel-Becker equation:

AL — 542(0.9482-5T1)
cons

For AL_qps the following ratings apply:

e 0% to 3% equals Excellent
e  3%to 7% equals Very Good
e 7% to 12% equals Good

e 12% to 15% equals Fair

e 15% to 18% equals Poor

e above 18% is Unacceptable

19.2.13 Articulation Index

The articulation index is used to determine the intelligibility of speech in the presence of background
noise [16], [17]. It is calculated based on a broadband weighted average of the signal-to-noise ratio
between 200 Hz and 5 kHz.
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Al = Z WkLSN,k
k

Where Lgy x = Lsplit(fik) — Lnoise (f) + 12 dBiis limited to the interval of 0 dB to 30 dB, fj is the 1/3™
octave frequency band, and wy, are the band-based weighting factors.

Note that the parameter is considered outdated. It has been often used to detect and quantify hearing
loss.

19.2.14 Privacy Index

The privacy index is calculated from the articulation index. It describes how much speech is masked by
background noise.

PI = (1—AD)-100%

The qualification is given as follows:

Level of Privacy Al Pl
Confidential 0.00-0.05 100% - 95% ¢ hear only "muffled" sound
¢ may be audible, but not
intelligible
e expected privacy level for private
offices

hear and understand words and
some sentences

e not distracting

e expected privacy level for most

open plan spaces

Marginal/Poor 0.02-0.40 80% - 60% e hear most sentences clearly

e distraction is common

e worker stress is evident

e affects concentration

Normal (Non-Intrusive) 0.05-0.20 95% - 80%

No Privacy >0.04 < 60%

19.2.15 Loudspeaker Density (Lspk Density)

The mapping shows the number of loudspeakers for which the direct SPL is within a range of 3 dB, 6
dB, or 10 dB of the loudest loudspeaker received. This range setting can be switched on the OPTIONS
page of the MAPPING EVALUATION window (section 14.2.5).

The 3 dB and 6 dB settings may be used to validate sound system designs where for spatial audio
applications smooth panning between sources is of interest. The number of loudspeakers shown for
the target area should then equal the number of loudspeakers intended to cover the listening area.

The 10 dB setting may be used to investigate the suitability of a set of surrounding loudspeakers to
create the impression of an approximate isotropic and homogeneous diffuse field. This assumes that
the generation of a plausible reverberant field relies on perceiving the sound as coming from many
different sources and directions.

19.2.16 S/N Ratio

This mapping shows the difference of the total SPL and the user-defined noise level.
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Lsnr = Ltot — Lnoise

19.2.17 Hor. Angle (Standard and Pro licenses only)

This mapping shows the horizontal direction of the loudspeaker that is localized as the main sound
source relative to the positive y-axis. The quantity is given in the range of -180° to +180°.

Which source is localized is determined according to the precedence effect.

19.3 Calculation Parameters

19.3.1 Bandwidth

In EASE, most calculations are carried out at a resolution of 1/24™ octave bands or higher. When
considering greater bandwidths such as 1/1 octave, the elementary bands included in the bandwidth
of interest are combined accordingly. For absolute values like SPL figures this corresponds to a power
summation. For relative figures like transfer functions, sensitivities or clarities this corresponds to an
average.

For Acousteer mappings (section 13) as well as impulse responses and auralizations (section 17) the
full audio bandwidth is used. Calculations in the Room Mapping and Raytracing modules (section 14
and following) are conducted for the limited bandwidth of the 1/3™ octave bands between 100 Hz and
10 kHz.

19.3.2 SPL Weighting

The A and C level weighting functions are implemented in EASE according to the IEC 61672-1 standard
[18]. Results are within the class 1 tolerance specification of the standard.

However, depending on signal type and frequency there may be small deviations when comparing with
the standard. These deviations, for example for the octave bandwidth, are due to the fact that in EASE
the weighting factors are calculated and applied at a high frequency resolution, e.g. 1/24 octave, and
then the corresponding SPL values are summed across the considered bandwidth, each band with its
own weighting factor applied. The octave-band weighting factors according to the standard instead
correspond to the center values of the respective octave band. In other words, the differences are due
to different sampling resolutions for the weighting function.

The deviations are illustrated in Table 1.

Frequency | A-Weighting | A-Weighting | Difference | C-Weighting | C-Weighting | Difference

/Hz /dB /dB /dB /dB /dB /dB
IEC61672-1 | EASE IEC61672-1 | EASE

315 -39.4 -37.2 2.2 -3.0 -2.9 0.1

63 -26.2 -24.7 15 -0.8 -0.8 0.0

125 -16.1 -15.1 1.0 -0.2 -0.2 0.0

250 -8.6 -8.0 0.6 0.0 0.0 0.0

500 -3.2 -2.9 0.3 0.0 0.0 0.0

1000 0.0 0.1 0.1 0.0 0.0 0.0

2000 1.2 1.2 0.0 -0.2 -0.2 0.0

4000 1.0 0.8 -0.2 -0.8 -0.9 -0.1

8000 -1.1 -1.4 -0.3 -3.0 -3.3 -0.3
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16000 -6.6 | 6.8 | -0.2 | -8.5 | -8.7 | -0.2
Table 1 Octave-band weightings according to the IEC 61672-1 standard and as shown in EASE. Differences are due to the
higher sampling resolution of EASE and within the class 1 specification of the standard.
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20 Appendix B — Short Cut Overview

The following list contains all short cut keys defined in EASE for quick access to specific commands and menu items. In most cases, the short cut is displayed when

hovering over the corresponding button or menu.

Notice that in addition to the short cuts below the standard short cuts provided by Microsoft Windows can be used as well. These can be activated by pressing

the Alt key or F10. The short cuts are then shown as overlays on the ribbon menu.

Global Short Cuts

F1 Opens the user’s guide document (USER’ S GUIDE).

F5 Enables and disables the display of mappings on audience areas (CALCULATIONS > SHOW MAPPING).

F7 Activates and deactivates the measurement mouse mode (TOOLS > MEASURE).

F9 Shows the settings area of the software (OPTIONS).

F10 Shows the Windows standard shortcuts for all ribbon functions.

F12 Allows saving projects under a different file name (FILE > SAVE As).

Alt Shows the Windows standard shortcuts for all ribbon functions.

Alt + left-click Deselects an item and keeps the rest of the selected items.

Ctrl + left-click Selects an unselected item when there are selected items already. Deselects a selected item and keeps the rest of the selected items.

Delete Deletes all selected items.

Escape Deselects all selected items.

Page Down Hovers the item in front of the currently hovered item based on the mouse location.

Page Up Hovers the item behind the currently hovered item based on the mouse location.

Shift + mouse wheel | Hovers the next item behind or in front of the currently hovered item by scrolling the mouse wheel.

Space Adjusts the zoom window of the current 3D view to fit the bounds of the selected items (PRESENTATION > SCALE TO SELECTION).

Ctrl+0 Adjusts the zoom window of the current 3D view so that it fits the entire model (PRESENTATION > SCALE TO FIT).

Ctrl +1 Switches the 3D view to the side view (PRESENTATION > SIDE (X)). Rotates the view by 180° around the z-axis if triggered again.

Ctrl +2 Switches the 3D view to the end view (PRESENTATION > END (Y)). Rotates the view by 180° around the z-axis if triggered again.

Ctrl + 3 Switches the 3D view to the top view (PRESENTATION > PLAN (Z)). Rotates the view by 90° around the z-axis if triggered again.

Ctrl+4 Switches the 3D view to the perspective view (PRESENTATION > 3D PERSPECTIVE). Rotates the view by 90° around the z-axis if triggered
again.

Ctrl+5 Deactivates the cutting planes for the current 3D view (PRESENTATION > SHOW EVERYTHING).
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Ctrl + A Selects all rows of a table in a table window, such as the FACES TABLE.

Ctrl+B Toggles the position of the status text. It can be attached to the mouse cursor or pinned to the bottom-left corner of the 3D view.

Ctrl+D Allows loading a drawing bitmap (FILE > LOAD DRAWING).

Ctrl+ E Activates and deactivates the extrude mouse mode (SURFACES > EXTRUDE > FACE). This requires a face to be selected already.

Ctrl+ G Copies the image of the currently active window to the clipboard (TooLs > SEND PICTURE TO.. CLIPBOARD).

Ctrl+H Sets the selected items invisible if there is at least one visible item in the selection. Otherwise, they are set visible (TooLS > TOGGLE
VISIBILITY).

Ctrl +1 Imports speaker models into the program database (LOUDSPEAKERS > SPEAKER MODELS > IMPORT).

Ctrl+ L Activates and deactivates the mouse mode for inserting listener seats (RECEIVERS > INSERT > LISTENER SEAT).

Ctrl+ M Opens the Room Mapping module, also called EASE Eyes (CALCULATIONS > SIMULATION > ROOM MAPPING).

Ctrl+ N Create a new project (FILE > PROJECT > NEW).

Ctrl+0O Opens an existing project file (FILE > PROJECT > OPEN). This includes EASE v5, EASE v4, DWG and XLD formats.

Ctrl+P Activates and deactivates the mouse mode for inserting faces of arbitrary shape (SURFACES > INSERT > POLYGON).

Ctrl +R Makes all invisible items visible (TooLS > SHoW ALL).

Ctrl+S Saves the currently loaded project under the same file name (FILE > PROJECT > SAVE).

Ctrl+T Opens the EASE Ray Tracing module (CALCULATIONS > SIMULATION > RAY TRACING).

Ctrl+ U Activates and deactivates the mouse mode for inserting audience areas of arbitrary shape (RECEIVERS > INSERT > AUDIENCE AREA).

Ctrl+ W Allows opening an existing project and adding its content to the currently loaded project (FILE > PROJECT > ADD).

Ctrl+Y Re-does the last project change that was previously undone.

Ctrl+2 Undoes the last project change.

Ctrl+ Alt+ B Allows a back-side face to a face. If at least one face is already selected, the back-side face is added immediately. If there is no face
selected, the mouse mode for adding back-side faces is activated (SURFACES > INSERT > ADD BACK SIDE).

Ctrl+ Alt+D Activates and deactivates the mouse mode for duplicating items (TooLs > EDIT > DUPLICATE). This requires at least one item to be
selected already.

Ctrl + Alt + | Allows inverting the face orientation. If at least one face is already selected, its orientation is inverted immediately. If there is no face
selected, the mouse mode for inverting the face orientation is activated (SURFACES > ORIENTATION > INVERT FACE).

Ctrl + Alt + L Activates and deactivates the mouse mode for selecting the 3D location for detailed acoustic assessment (CALCULATIONS > ANALYSIS
> ANALYZE LOCATION). The location must be in the plane of an audience area.

Ctrl + Alt + M Activates and deactivates the mouse mode for moving items (TooLs > EDIT > Move). This requires at least one item to be selected
already.

Ctrl + Alt + P Switches the view angle for current 3D view, from a wide angle, to a small angle, to parallel perspective (PRESENTATION > PERSPECTIVE).

210

Appendix B — Short Cut Overview




EASE 5 Third Edition — User’s Guide

Appendix B — Short Cut Overview

Ctrl + Alt + R Activates and deactivates the mouse mode for rotating items (TooLS > EDIT > ROTATE). This requires at least one item to be selected
already.

Ctrl+ Alt+S Creates a new selection set based on the currently selected items (TOOLS > GROUPING > STORE SELECTION).

Ctrl + Alt + W Activates and deactivates the mouse mode for inserting faces in faces with arbitrary shape (Surfaces > INSERT > POLYGON IN FACE).

Ctrl + Shift + A

Shows or hides the acoustic parameters window (CALCULATIONS > ACOUSTIC PARAMETERS, WINDOWS > ACOUSTIC PARAMETERS).

Ctrl + Shift + B

Opens the EASE Probe module for reflection analysis and subsequent auralization (CALCULATIONS > POST-PROCESSING > PROBE
ANALYSIS).

Ctrl + Shift+ C

Shows or hides the table window for audience areas (RECEIVERS > AREAS TABLE, WINDOWS > AREAS TABLE).

Ctrl + Shift+ D

Shows or hides the table window for drawings (WINDOWS > DRAWINGS TABLE, SELECTED DRAWING > DRAWINGS TABLE).

Ctrl + Shift+ E

Opens the EASE EARS module for auralization (CALCULATIONS > POST-PROCESSING > EARS AURALIZATION).

Ctrl + Shift+ F

Shows or hides the filter stage window (LOUDSPEAKERS > SIGNAL PROCESSING > FILTER STAGE, WINDOWS > FILTER STAGE). It provides
access to the filter configuration of the global EQ, processing blocks, loudspeakers, and loudspeaker inputs depending on the selected
item.

Ctrl + Shift+ H

Shows or hides the frequency response window (CALCULATIONS > FREQUENCY RESPONSE, WINDOWS > FREQUENCY RESPONSE).

Ctrl + Shift + 1

Activates the selected loudspeakers for calculations using the Acousteer real-time engine (CALCULATIONS > I).

Ctrl + Shift + K

Shows or hides the window for processing blocks (LOUDSPEAKERS > SIGNAL PROCESSING > PROCESSING BLOCKS, WINDOWS > PROCESSING
BLOCKS).

Ctrl + Shift + L

Shows or hides the table window for loudspeakers (LOUDSPEAKERS > LOUDSPEAKERS TABLE, WINDOWS > LOUDSPEAKERS TABLE).

Ctrl + Shift + M

Shows or hides the window for materials used in the projects (SURFACES > MATERIALS IN USE, WINDOWS > MATERIALS IN USE).

Ctrl + Shift + N

Opens a new 3D view window (WINDOWS > NEW 3D VIEW).

Ctrl + Shift + O

Deactivates the selected loudspeakers for calculations using the Acousteer real-time engine (CALCULATIONS > O).

Ctrl + Shift + P

Shows or hides the properties window for items (WINDOWS > PROPERTIES).

Ctrl + Shift + R

Switch the presentation of faces in the current 3D view to the standard X-ray style (PRESENTATION > SURFACE STYLE > X-RaAy >
DEFAULT).

Ctrl + Shift+ S

Shows or hides the window for selection sets (ToOLS > SELECTION SETS, WINDOWS > SELECTION SETS).

Ctrl + Shift+ T

Shows or hides the distribution graph window (CALCULATIONS > DISTRIBUTION GRAPH, WINDOWS > DISTRIBUTION GRAPH).

Ctrl + Shift + U

Allows adding an audience area above a face. If at least one face is already selected, for each selected face an audience area is added
that has the same shape. If there is no face selected, the mouse mode for adding audience areas to faces is activated (RECEIVERS >
INSERT > AREA ABOVE FACE).

Ctrl + Shift + V

Shows or hides the table window for listener seats (RECEIVERS > SEATS TABLE, WINDOWS > SEATS TABLE).

Ctrl + Shift + W

Switches the presentation of faces in the current 3D view to the wireframe style (PRESENTATION > SURFACE STYLE > WIREFRAME).
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Ctrl + Shift + X

Switches the presentation of faces in the current 3D view to the X-ray style that does not show the face outlines (PRESENTATION >
SURFACE STYLE > X-RAY > WITHOUT WIREFRAME).

Ctrl + Shift+Y

Shows or hides the configurator window (LOUDSPEAKERS > CONFIGURATOR, WINDOWS > CONFIGURATOR).

Ctrl + Shift + Z

Shows or hides the table window for faces (SURFACES > FACES TABLE, WINDOWS > FACES TABLE).

Short Cuts in Dedicated Mouse Modes

The following short cuts apply to mouse modes except for the standard selection mouse mode. This includes mouse modes for inserting, editing, or measuring
items. Some short cuts are available only in some mouse modes depending on applicability.

F2 Switches hovering of faces and audience areas and snapping to faces and audience areas on and off.
F3 Deactivates snapping to vertices, loudspeakers, and other objects while pressed.

Return Confirms the current input, e.g. sets the vertex at the insert position.

Escape Leaves the current mouse mode and switches to the default mouse mode (SELECTION).

Ctrl+Q Leaves the current mouse mode and switches to the default mouse mode (SELECTION).

A Activates and deactivates the input sequence for a circular arc.

C Closes a polygon by connecting to the point inserted first.

R Sets the reference point for coordinate entry.

S Copies the current insert coordinates derived from the mouse location to the control bar of the current 3D view.
u Reverts the last action within the current mouse mode, e.g. deleting a vertex or resolving a constraint.
X Activates and deactivates the x-axis constraint relative to the current position.

Y Activates and deactivates the y-axis constraint relative to the current position.

VA Activates and deactivates the z-axis constraint relative to the current position.

Shift + Z Fixes the z-coordinate to that of the vertex inserted last.
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